
The “HOW-TO” Conferences
for CreativePros



We’re so pleased you have joined us  
for CreativePro Week 2018!  

We have brought together 40+ world-class speakers to  
present over 70 amazing sessions. Prepare to fill your brain, 

have your questions answered, and get connected!

Speaking of getting connected… 
some of the best tips and tricks 
you’ll learn at this conference will 
come from your fellow attendees. 
Don’t be shy! During sessions, 
introduce yourself to your seat-
mates. At lunch, look for table 
signs so you can sit with people 
who have similar interests.

Find our schedule and live discussions  
online here: connect.creativepro.com  
If you add this web page to your home screen it 
will act like an app!

Facebook Find us on here:  
fb.com/creativeproweek

Twitter Follow us on Twitter here:  
twitter.com/creativeproweek

Join the conversation with the hash tag:  
#creativeproweek

Instagram: Share your photos on Instagram! Be 
sure to tag your photos #creativeproweek. Plus, 
don’t be shy about asking your favorite speaker 
if you can take a picture with her or him!

Ask the Expert Table One of the benefits of this 
conference is the availability of world-class experts. 
The speakers have signed up for slots to take your 
questions. Each day’s schedule will be posted at 
the table.

Session Notes To find the speaker session notes, 
visit: cpn.co/g/nola-notes. Note that this URL us 
for conference attendees only, so please do not 
blog about it or distribute it to other people.

Feedback Please! After each session, visit:  
cpn.co/g/nola-survey (You may win a free  
subscription to Adobe Creative Cloud!)

Thank you for attending.  
Enjoy the show!    

—David Blatner &  
Anne-Marie Concepción 

CreativePro Network 
www.CPN.co
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Monday
June 4

TIME NAPOLEON B NAPOLEON C NAPOLEON D BORGNE

9:00 am – 10:00 am
Effective Images for Social Media: 
How to Make Good Photos Great
Russell Brown

9:00 am – 12:00 pm
Power Production 
with GREP and 
Find/Change
Erica Gamet

10:15 am – 10:45 am
Camera Raw for 
Designers
Julieanne Kost

Making it Move 
in Photoshop
Colin Smith

11:00 am – 11:45 am
Power Tips for 
Illustrator
Dave Cross

3D is for Everyone 
(yes, even you)
Steve Caplin

11:45 am – 1:00 pm LUNCH — ARMSTRONG ROOM, 8TH FLOOR

1:00 pm – 2:00 pm
Photorealistic 
Imaging
Bert Monroy

Creating Web 
Graphics in 
Photoshop
Jesús Ramirez

Five Delicious 
Photoshop 
Recipes
Colin Smith

1:00 pm  – 4:00 pm
Accessibility: 
Future-Proofing 
Your Documents
Chad Chelius

2:15 pm – 3:00 pm
Creating Product 
Mockups
Khara Plicanic

Speed Up Your 
Work in Photoshop
Steve Caplin

Simple Techniques 
for Building 
Complex Shapes in 
Illustrator
Laurie Ruhlin

3:30 pm – 4:30 pm
Vector Art with 
Organic Flair
Von Glitschka

Selections, 
Channels, and 
Masks (Oh my!)
Dave Cross

I Wish I’d Known 
That! Photoshop 
Power Tips 
and Tricks for 
Designers
Jesús Ramirez

4:45 pm – 5:30 pm Three Minutes Max
Mark Heaps, et al

5:30 pm – 6:30 pm Welcome Reception
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Tuesday
June 5

TIME NAPOLEON B NAPOLEON C NAPOLEON D BORGNE

9:00 am – 10:00 am Become an InDesign Superhero!
Erica Gamet

9:00 – 12:00 pm
Compositing 
for Creative and 
Commercial 
Design
Julieanne Kost

10:15 am – 10:45 am 20 Essential Image Techniques
Mike Rankin

11:00 am – 11:45 am
Feeding InDesign with Photoshop and 
Illustrator
Mark Heaps

11:45 am – 1:00 pm LUNCH — ARMSTRONG ROOM, 8TH FLOOR

1:00 pm – 2:00 pm

Super Styling: 
Automatic 
Format ting with 
Nested, Line, and 
GREP Styles
Chad Chelius

Building Albums 
and Photo Books
Khara Pilcanic

The Magic of 
Anchored Objects
Laurie Ruhlin

1:00 – 4:00 pm
Vector  
Master Class
Von Glitschka

2:15 pm – 3:00 pm

A Modest 
Proposal: 
Choosing RGB 
Over CMYK
David Blatner

Using InDesign for 
Presentations
Mark Heaps

Using InDesign the 
“Right” Way
Nigel French

3:30 pm – 4:30 pm

Engaging 
Interactive 
Documents
Diane Burns

Hacking InDesign 
Templates
Sandee Cohen

Designing Forms 
in InDesign and 
Acrobat
Chad Chelius

4:45 pm – 5:30 pm

Must-Have 
InDesign Scripts 
That Won’t Break 
the Bank
Erica Gamet

Making the 
Most of the 
Long Document 
Features
Mike Rankin

From InDesign 
to Motion Media
Jessica Bellamy

8:00 pm – 9:30 pm Ignite CreativePro
Anne-Marie Concepción & Friends
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Wednesday
June 6

TIME NAPOLEON B NAPOLEON C NAPOLEON D BORGNE

8:15 am – 8:45 am

Breakfast Sponsor Session 
MAG+ Designd: Mobile Apps  
Made Easy For Creatives
Andrew Wong

9:00 am – 10:00 am

Unexplored InDesign:  
Unearthing Hidden and  
Forgotten Features
David Blatner and Anne-Marie Concepción

9:00 am – 12:00 pm
CSS/HTML for 
Designers
Nellie McKesson

10:15 am – 10:45 am InDesign and the Creative Cloud
Bart Van de Wiele

11:00 am – 11:45 am
Professional Typography:  
Top Techniques
Nigel French

Deep GREP
Erica Gamet and  
David Blatner

12:00 pm – 12:45 pm Special Lunch: Ask Adobe Anything! 
Lunch served in Napoleon A (3rd floor), Session in Napoleon B/C

1:00 pm – 2:00 pm InDesign to HTML
Keith Gilbert

InDesign Tables 
Unbound
Nigel French

Infographics 
with InDesign
Jessica Bellamy

1:00 pm – 4:00 pm
The Whole 
Creative Cloud 
Publishing Toolbox
Bart Van de Wiele

2:15 pm – 3:00 pm

One Click 
to Web with 
Publish Online
Diane Burns

Excel Tricks for 
InDesign Users
Bill Jelen

Trends and 
Techniques for 
Print in 2018
Trish Witkowski

3:30 pm – 4:30 pm

Learn How to 
Learn: Mastering 
InDesign (and all 
your other apps)
Jeff Witchel

DIY Solutions 
for Designers
Mark Heaps

Better Ways to 
Work with Editors 
and Writers
Anne-Marie Concepción

4:45 pm – 5:30 pm Three Minutes Max + Conclusion
David Blatner, et al.
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Thursday
June 7

TIME NAPOLEON B NAPOLEON C NAPOLEON D BORGNE

9:00 am – 10:00 am
Don’t Bleed on the Pasteups  
and Other Life Lessons Learned
Gene Gable 9:00 am – 12:00 pm

Hub and Spokes: 
Leveraging 
InDesign, 
Photoshop, 
Illustrator, 
and Bridge
Bart Van de Wiele

10:15 am – 10:45 am
Current Choices for  
Digital Publishing in 2018
Keith Gilbert

PDF Beyond 
Printing & Viewing: 
PDF for Archiving
Dov Isaacs

11:00 am – 11:45 am PWP: The Future of Digital Books
Leonard Rosenthol

11:45 am – 1:00 pm LUNCH — ARMSTRONG ROOM, 8TH FLOOR

1:00 pm – 2:00 pm The Power of Print
Trish Witkowski

Secrets of the 
Acrobat Masters
Jeff Witchel

Ebook Design Is 
Not an Oxymoron
Laura Brady 1:00 pm – 4:00 pm

From 0 to 60  
with the  
InCopy/InDesign
Workflow
Anne-Marie Concepción

2:15 pm – 3:00 pm
Lies Your Printer 
Has Told You
Dov Isaacs

HTML Beyond  
Web Sites:  
Digital Magazines, 
Presentations, and 
Mobile Apps
Justin Putney

Essential EPUB 
Cleanup Steps
Ron Bilodeau

3:30 pm – 4:30 pm What’s New in PDF
Leonard Rosenthol

3 Forward-Looking 
Publishing Processes
Bilodeau, Coppieters, 
McKesson

Publishing EPUBs 
to your Website 
with Readium
Ken Jones

4:45 pm – 5:30 pm
The Future of Publishing:  
What You Need to Know Today
David Blatner and Anne-Marie Concepción

7:30 pm – 9:00 pm
CreativeWow!  
Sneak Peeks by Creative Developers
Chuck Weger, emcee
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Friday
June 8

TIME NAPOLEON B NAPOLEON D BORGNE

9:00 am – 12:00 pm
Design Deep Dive 
Tutorial: Before & After 
John McWade

Make a Mobile App 
with InDesign
Keith Gilbert

Creative  
Developers Summit

12:00 pm – 1:00 pm LUNCH — NAPOLEON A, 3RD FLOOR

1:00 pm – 4:00 pm
Design Deep Dive 
Tutorial: Before & After 
John McWade

New Orleans Photo Walk 
Mike Rankin and Nigel French

Creative  
Developers Summit

TIME NAPOLEON C

9:00 am – 9:45 am My Life in Presentations: From Ginormous to Intimate
Joe Buchwald

9:45 am – 10:15 am Just Say No: Ten Alternatives to Bullets
Kristina Heaps

10:30 am – 11:15 am Secrets of Silicon Valley Presentations
Jole Simmons

11:15 am – 12:00 pm Beautiful Typography for Presentations
Mark Heaps

12:15 pm – 1:15 pm Lunch Panel: Presentation Design, E-Learning, and the Future of Communication
David Blatner (moderator), Rick Altman, Mike Taylor, Joe Buchwald, Richard Goring

1:30 pm – 2:15 pm Graphiti: Data, Design, Deliver
Dan Gard

2:30 pm – 3:15 pm Simple PowerPoint Tricks for Effective Presentations 
Richard Goring

3:30 pm – 4:15 pm The Power of a Great Template
Dan Gard

4:15 pm – 4:30 pm Closing Remarks
Mark Heaps
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Ask the Experts
ANNE-MARIE CONCEPCIÓN is co-host of
CreativePro Week and the owner of Seneca Design 
& Training in Chicago. She’s also a certified Adobe 
instructor and consultant specializing in InDesign 
and InCopy workflows. She has authored over 
25 titles on Lynda.com and is the co-publisher of 
 InDesignSecrets.com and CreativePro.com.

BART VAN DE WIELE is a Senior Solution
Consultant at Adobe, where he shares his passion 
for design and technology on stages all around the 
world. He’s a design specialist with 15+ years of 
experience as a designer and trainer. He has written 
and spoken extensively and was awarded as an 
Adobe MAX 2017 Master.

BERT MONROY is a pioneer of digital art and
a hyper-realistic digital painter. He is a veteran of 
the advertising industry and spent 40 years as a 
commercial illustrator. He coauthored the first book 
on Photoshop and has authored several books since. 
He has been a regular on Tech TV and until recently 
hosted the podcast Pixel Perfect with Bert Monroy.

BILL JELEN is the host of MrExcel.com and the
author of 54 books about Microsoft Excel including 
Excel Gurus Gone Wild. He has made over 80 guest 
appearances on TV’s Call for Help with Leo Laporte 
and was voted guest of the year on the Computer 
America radio show. Bill will entertain you while 
showing you the powerful tricks in Excel.

CHAD CHELIUS is an Adobe Certified
Instructor who teaches classes throughout the 
United States. Chad helps major publishing clients 
implement Adobe software into their business 
processes and assists them in streamlining their 
workflows. In addition to being a Lynda.com author, 
he is also the Editor of incopysecrets.com.

COLIN SMITH is a best-selling author, trainer,
and award-winning digital artist. Colin is also known 
as a pioneer of HDR and drone photography. Colin is 
an Adobe ACP (Adobe Community Professional), He 
is founder of one the world’s most popular Photo-
shop resource sites, PhotoshopCAFE.com, which 
boasts over 30 million visitors.

DAN GARD is the Senior Production Designer at
the world’s largest presentation design and commu-
nications agency, Duarte Inc. Dan has produced 
work for the boardrooms, conferences, and pitches 
of Silicon Valley’s elite. He makes Presentation 
Design a blend of graphic design, UI, UX, and engi-
neering all composed with Microsoft PowerPoint.

DAVE CROSS has been helping photographers
and creative pros get the most out of Photoshop, 
Illustrator, and InDesign for over 25 years. He is an 
Adobe Certified Instructor, and a Certified Technical 
Trainer. Dave has written dozens of articles, multiple 
books, and videos for Kelby Training, CreativeLive, 
and Photoshop Cafe.

DAVID BLATNER is the co-host of CreativePro
Week and InDesignSecrets.com, the founder of 
InDesign Magazine, and the author or co-author of 
15 books, including Real World InDesign and Spec-
trums: Our Mind-Boggling Universe From Infinites-
imal to Infinity. He is also the author of a dozen titles 
at Lynda.com/LinkedIn Learning.

DIANE BURNS is an author, trainer, consultant,
and founder of San Francisco-based TransPacific 
Digital, a leading print and digital localization 
company. She’s also an author of several courses for 
Lynda.com, a regular contributor to InDesign Maga-
zine, and the co-author of the Adobe Press book, 
Digital Publishing with Adobe InDesign CC. 

DOV ISAACS is a Principal Scientist at Adobe,
with responsibility for end-to-end PDF publishing 
workflow and product interoperability issues. Dov 
also serves as Adobe’s representative to the Ghent 
Workgroup and several ISO TC130 committees, 
including PDF/X and PDF/VT for which he serves as 
the chairperson and co-chairperson, respectively.

ERICA GAMET is a speaker, writer, and trainer,
focusing on Adobe InDesign and Illustrator, Apple 
Keynote and iBooks Author, and other print- and 
production-related topics. She is a regular presence 
at CreativePro Week, has spoken at ebookcraft in 
Canada and Making Design in Norway, and is the 
author of several CreativeLive courses.
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GENE GABLE is formerly President of Publish 
magazine, President of Seybold Seminars and Publi-
cations, and Publisher of Sporting Times magazine. 
He currently works in the field of venture capital. 
For ten years he wrote the columns “Heavy Metal 
Madness” and “Scanning Around With Gene” for 
Creativepro.com.

JEFF WITCHEL is an Adobe Certified Instructor 
for InDesign and Illustrator, with over 30 years of 
experience, and trains clients across the USA. He’s 
best known for his tips and tricks video tutorials, 
which you can view on at JeffWitchel.net. Jeff wrote 
“Layers Magazine Tip of the Day” for five years, 
which were later compiled into a book.

JESSICA BELLAMY tells visual stories using 
data and personal narratives. Jessica was recently 
an Adobe Creative Resident, and has traveled 
around the country teaching creatives how to make 
information graphics in partnership with nonprofits. 
In 2017, she created a hands-on workshop called 
Infographics for Social Change.

JESÚS RAMIREZ is a San Francisco-based 
Adobe Community Professional and online digital 
graphics educator specializing in Adobe Photoshop. 
His YouTube channel, Photoshop Training Channel, 
has over 250,000 subscribers and over 9,000,000 
views. Jesus also has over eight years of profes-
sional experience in web development.

JOE BUCHWALD is the Creative Director for 
the Adobe Events Team where he oversees earth 
shattering, mind bending, incredible presentations 
on the world’s largest screens… and small screens 
too. He is the Creative Director for Adobe MAX and 
SUMMIT. His favorite part of the job is collaborating 
with other creatives and making inspiring visuals.

JOHN MCWADE is a senior staff author at 
Lynda.com/LinkedIn Learning, where he creates 
educational video courses in the field of graphic 
design. A designer, teacher, and author, John 
created the world’s first desktop publishing studio in 
1985, and founded Before & After magazine in 1990 
to teach graphic design to desktop publishers.

JOLE SIMMONS is an experienced presenta-
tion designer with a strong background in graphic 
design, marketing, and advertising. He has devel-
oped Keynote and PowerPoint decks for Facebook, 
Google, Microsoft, Cisco, YouTube, Salesforce, 
Airbnb, and many other companies in Silicon Valley. 
Jole recently become a Lynda.com author.

JULIEANNE KOST is a Principal Evangelist 
at Adobe Systems, and was named one of Fast 
Company’s “100 Most Creative People in Business.” 
She is also the author of Window Seat — The Art 
of Digital Photography and Creative Thinking, and 
creator and host of the popular “Photoshop CC 
Essential Training” for LinkedIn Learning/Lynda.com.

JUSTIN PUTNEY runs Ajar Productions, a soft-
ware company that helps designers and publishers 
reach a larger audience. Through his company, 
Justin brings developer tools and know-how to 
visual thinkers—helping his customers publish inter-
active HTML sites and apps using Adobe InDesign. 
Justin is also a Lynda.com and Adobe Press author.

KEITH GILBERT is a digital publishing consul-
tant and educator, Adobe Certified Instructor, 
Lynda.com author, and contributing writer for 
various publications. During his 30 years as a 
consultant, his clients have included Adobe, Apple, 
Target, the United Nations, Best Buy, General Mills, 
and Lands’ End.

KEN JONES is a publishing software expert with 
over ten years experience as Technical Production 
Manager, software trainer, and developer at Penguin 
Group UK. Ken’s company, Circular Software, 
provides software tools and services for a range 
of illustrated book publishing customers including 
Hachette, Pan Macmillan, and Thames & Hudson.

KHARA PLICANIC is a professional photog-
rapher turned celebrated instructor, and taught 
more than 30 courses on Creativelive, Udemy, and 
Brit+Co. She’s the author of several books including 
Album Moxie: The Savvy Photographer’s Guide to 
Album Design and More with InDesign, and is a 
veteran speaker at many industry conferences.
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Ask the Experts
KRIS COPPIETERS is an accomplished soft-
ware coach and engineer based in New Zealand. His 
forte: simple, stable, maintainable, flexible solu-
tions for complex problems. His clients range from 
Fortune 100 companies to independent designers. 
Kris also excels at coaching and stimulating other 
developers. He is also the founder of Rorohiko.

KRISTINA HEAPS is a presentation designer 
with a background in marketing and graphic design. 
She received two Addy’s and a Webby for her work. 
As the CEO of Heaps LLC, a small communications 
design production group in Austin, TX, Kristina loves 
mixing the world of corporate communications, 
rapid return production, and client collaboration.

LAURA BRADY is an ebook developer, the prin-
cipal of Brady Type, and the Cross Media Manager 
at House of Anansi Press. She consults on workflow, 
tools, specifications, and production best practices 
with a special focus on accessibility. In her spare 
time she helps plan the ebookcraft conference and 
edits EPUBsecrets.com.

LAURIE RUHLIN is an Adobe Certified 
Instructor in InDesign and Illustrator, as well as a 
graphic designer, developing brochures, catalogs, 
logos and interactive documents for a wide variety 
of clients. She is an author of several courses for 
Pluralsight, including “InDesign CC Editorial Tools,” 
and “Drawing with Illustrator’s Perspective Tool.”

LEONARD ROSENTHOL is a Senior Principal 
Scientist with Adobe Systems and serves as their 
PDF Architect. He represents Adobe on various 
international standards bodies including the ISO, 
ICC, and the W3C. In the 1990s Leonard was a 
director at Aladdin Systems, where he was respon-
sible for the development of StuffIt.

MARK HEAPS is the Executive Director for 
Heaps LLC in Austin, a digital communications 
studio. Mark has worked with Google, Apple, HP, 
Dell and many other clients. Mark was previously the 
Director of Development for Duarte. He’s an Adobe 
Community Professional and an Adobe MAX Masters 
Award Recipient.

MIKE RANKIN is the Editor in Chief of InDesign 
Magazine, InDesignSecrets.com, and CreativePro. 
He’s also the author of several Lynda.com video 
training series, including “Font Management Essen-
tial Training,” “InDesign FX,” and “InDesign CC: 
Interactive Documents Fundamentals.”

NELLIE MCKESSON likes solving problems. 
She is the founder of Hederis, where she’s building 
a Web- and AI-based platform for book publishing. 
Previously she worked at O’Reilly Media (where she 
pioneered an HMTL/CSS-centric workflow), and 
Macmillan. She enjoys finding technological and 
workflow solutions for the publishing industry.

NIGEL FRENCH is a graphic designer, author, 
artist, and trainer based in Lewes, UK. He’s author of 
InDesign Type: Professional Typography with Adobe 
InDesign, published in its third edition by Adobe 
Press, and more than fifty titles in the Lynda.com 
library, including “Photoshop for Designers.” He also 
writes for InDesign Magazine. 

RICHARD GORING is a Director at Bright-
Carbon, the specialist presentation and eLearning 
agency. He’s passionate about improving the way 
that people present and believes that anyone can 
deliver a great presentation if given the right tech-
niques and a bit of practice.

RICK ALTMAN is a Director at the Presentation 
Guild and the host of the Presentation Summit. He 
has been hired by hundreds of companies, listened 
to by tens of thousands of professionals, and read 
by millions of people, all of whom seek better results 
with their presentation content and delivery.

RON BILODEAU is the Production & Design 
Specialist for O’Reilly Media, where he develops 
workflows for exporting print- and web-ready 
PDFs, and ePub/Mobi files. Ron also works with the 
O’Reilly Atlas team where he is developing custom 
stylesheets for this new and exciting (fully auto-
mated) digital publishing platform.
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RUSSELL BROWN is the Senior Creative
Director at Adobe Systems, and an Emmy 
Award-winning instructor. He shares his delight 
in testing the creative limits of his tools, and his 
in-depth design knowledge and zany presentation 
style has won him a regular following among begin-
ning, intermediate, and advanced users alike.

SANDEE COHEN is the author of the InDesign
Visual Quickstart Guide and Creating Animations 
with Adobe InDesign CC, and is the co-author, with 
Diane Burns, of Digital Publishing with InDesign CC. 
She has also created a course for Lynda.com on the 
three Adobe Spark programs.

STEVE CAPLIN is a freelance photomontage
artist based in London whose work has appeared 
in newspapers and magazines around the world. 
He is the author of the best-selling How to Cheat 
in Photoshop, and is the creator of “2 Minute 
 Photoshop” on YouTube and CreativePro.com.

TRISH WITKOWSKI is Chief Folding Fanatic at
foldfactory.com and president of Rock the Mailbox. 
An educator, author, speaker and award-winning 
designer, Trish has a specialized expertise in creative 
solutions for direct mail and marketing, and is the 
curator of the world’s most exciting collection of 
folded print and direct mail samples.

VON GLITSCHKA is the creative director and
owner of Glitschka Studios, a multi-disciplinary 
boutique design firm with clients such as Adobe, 
HGTV, Rock and Roll Hall of Fame, Major League 
Baseball, Microsoft, Pepsi, Disney, and Ogilvy & 
Mather. Von is the author of videos at Lynda.com 
and several books, including Vector Basic Training.
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Venue Sheraton New Orleans

ESCALATORS

ELEVATORS

REGISTRATION

EXHIBITORS

MAUREPAS
BORGNE

NAPOLEON 
D

NAPOLEON 
C

NAPOLEON 
B

NAPOLEON 
A

BREAKFAST 
ALL DAYS

LUNCH 
WEDNESDAY 
AND FRIDAY*

*LUNCH ON 8TH FLOOR MONDAY, TUESDAY, THURSDAY

Third Floor
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ripon adRipon Printers is a leading provider of integrated print and digital solutions. You’ll benefit 
from flexible scheduling, exceptional customer training programs and equipment diversity 

for handling any job.  Get a step ahead of the market with Ripon Printers.

Contact us today • 920-748-3136 • www.riponprinters.com

Discover World Class
Print & Digital Solutions

Direct Mail   •   Catalogs   •   Publications   •   Digital Communications

A

B

C

D

E

F

  SHERATON NEW ORLEANS 
CreativePro Week conference venue

A JACKSON SQUARE 
location of the iconic St. Louis Cathedral 
and Cafe du Monde café

B AUDUBON BUTTERFLY GARDEN AND 
INSECTARIUM

C CANAL STREET FERRY TERMINAL 
and Audubon Aquarium of the Americas

D WOLDENBERG PARK

E LAFAYETTE SQUARE

F WALGREENS PHARMACY



Sponsors thank you!

ANIMATION & SOFTWARE STUDIO

MasterPlan
from Circular Software

PRESENTATION

GUILD

TM
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Hi there!

I’m so glad you’ve decided 

to attend Creative Pro Week. 

You’re in great hands with 

Anne-Marie, David, and the 

rest of the Creative Publishing 

Network crew.

Are you interested in 
applying all of your 
InDesign skills to 
digital designs?

I have an exclusive offer for 

you as a Creative Pro Week 

attendee. Sign up to get both 

offers at the right, as well 

as updates and tips about 

creating interactivity with 

InDesign.

Best regards,

Justin Putney

Ajar Productions

Sign up today at

to enter & claim your free extension

http://ajar.pro/cpweek

Enter to win a 1-year in5 PRO subscription  
($360 value)

Get the Split Text extension for InDesign at no cost

Break frames up for animation and interactivity.

Export your InDesign documents as digital magazines, 
mobile apps & more.

2

1

device
on any

viewable

The drawing ends soon after the conference, so don’t wait to sign up!

http://ajar.pro/cpweek/?ref=handout18


ONLINE TRAINING
You can fi nd tutorials for our plug-ins on Facebook, YouTube, Lynda.com, Skillshare and PPLLUV.com

PLUG-INS FOR AI

ASTUTE GRAPHICS - A BRIEF HISTORY

The story so far…

We are leading innovative experts in designing imaginative tools for vector designers that signifi cant-
ly save time, boost creativity and achieve refi ned results. We lead the way with cutting-edge design 
software — we bring back the fun to drawing whilst making it far easier to meet tight deadlines and 
make on the fl y changes. Astute Graphics is driven by its employees who demonstrate a passion for 
continuously enhancing your design workfl ow. We invest time in fi nding out what you really need and 
with our wealth of creativity and resourcefulness we are able to bring out a steady stream of releases 
each year.

Well established with an enviable reputation in our fi eld, this has led to strong alliances with key part-
ners such as Adobe, Wacom, authors and high profi le designers. We have deep values and ethics to 
conduct our business responsibly and fairly both with our valued clients and suppliers. These values 
transcend into our every day dealings whereby we ensure speedy responses to customer queries and 
prompt payment to suppliers.

Eff ects Bundle Includes:
• Texturino
• Stipplism
• Phantasm v3
• WidthScribe v2
• Stylism
• MirrorMe
• ColliderScribe v2

Core Bundle Includes:
• VectorFirstAid
• VectorScribe v3
• Phantasm v4
• AutosaviourPro v2
• DirectPrefs (Free)

Draw Bundle Includes:
• DynamicSketch v2
• VectorScribe v3
• InkScribe
• ColliderScribe v2
• Subscribe

OUR BUNDLES

ELITE BUNDLE INCLUDES ALL PLUG-INS, WE ALSO HAVE THREE SEPERATE BUNDLES

Free Plug-ins Include: 
Autosaviour (Free) DirectPrefs (Free)

ASTUTEGRAPHICS.COM



Circular Software
development • training • consultancy

CircularFLO
from Circular Software

Beautiful interactive
fixed layout eBooks

MasterPlan
from Circular Software

Search, comment & share
publications online

from Circular Software

Consistent InDesign
setup & exporting

GreenLight

CircularFLO
from Circular Software

Beautiful interactive
fixed layout eBooks

MasterPlan
from Circular Software

Search, comment & share
publications online

from Circular Software

Consistent InDesign
setup & exporting

GreenLight

CircularFLO
from Circular Software
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Introducing

MasterPlan WORK lets creative teams 
connect, plan, preview, comment and 
track their InDesign work in progress. 

MasterPlan LIVE adds searching and  
secure social media sharing of any spread 

of any publication to any website.

Contact Ken Jones at CreativePro Week 2018
for a live demo and to use MasterPlan for free! 
@CircularKen or ken@circularsoftware.com
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“MasterPlan WORK is a slick tool to help you quickly and easily collaborate 
and share your InDesign work.” – Keith Gilbert – Adobe Certified Instructor

“MasterPlan LIVE is so cool! It offers us a secure new way to present, search  
and share publications online.” – Chad Chelius – Adobe Certified Instructor

https://circularsoftware.com/apps/masterplanwork/
https://circularsoftware.com/apps/masterplanlive/
https://twitter.com/CircularKen
mailto:ken%40circularsoftware.com?subject=
https://www.circularsoftware.com
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WordsFlow  
• Place live, active links 
to Word/Excel docs 
• When linked docs are 
edited a double-click 
magic-merges in those 
changes with no loss 
of work on either side 
• Extends newsroom 
deadlines and absorbs 
last-minute client 
changes • Stop by our 
CPW 2018 table to see 
for yourself • Click here 
for free trial and special 

one-time show 
offer

http://emsoftware.com/wfcpw
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DocsFlow
• Place live, active links 
to Google Docs docs/
sheets • When docs 
are edited a double-
click magic-merges in 
those changes with no 
loss of work on either 
side • Collaborate using 
the world’s best shared 
editorial system with 
unlimited users • Stop 
by our CPW 2018 table 
to see for yourself • Click 
here for free trial and 

special one-
time show offer

http://emsoftware.com/dfcpw
http://emsoftware.com/dfcpw


special offers for CreativePro Week attendees:  
$25 off InDesignSecrets membership*

when you use the discount code CPW before June 15 
InDesignSecrets.com/membership

Includes 12 monthly issues of:

plus all 110+ back issues, InDesign template of the month,  
private member forum, special discounts, and more!

*new members only



Looking for the perfect 
alternative to Adobe DPS?

 has the solution you need!
While Adobe is moving away from supporting  

small magazine publishers, we at mag+ are not.  
We love businesses of all sizes.

Switch to mag+ and we’ll convert your DPS content free of charge.  
Contact us to learn more at sales@magplus.com

Powering Mobile Apps to 
Grow your Business

An MPS Company 
magplus.com



1-800-300-3532
sales@markzware.com

+ View Adobe InDesign page previews
+ View and export styled story content
+ Adobe InDesign is not required

InDesign Preview
ID Util

+ Supports QuarkXPress 2018 through 9
+ Converts InDesign CC 2018 through CS
+ Allows the freedom to choose your layout application

InDesign to Quark
ID2Q

+ Supports InDesign CC 2018 through CS5
+ Converts Adobe InDesign file to IDML
+ Modify files created in a newer verison of InDesign

InDesign to IDML
MarkzTools2

+ Supports InDesign CC 2018 through CS6
+ Edit PDF in a familiar page layout program
+ One-click conversion quickly and simply converts PDFs

PDF to InDesign
PDF2DTP

+ Preflights PDF and Non-PDF files
+ Native Applications are not required
+ Collect and package fonts and images

Preflight for Print
FlightCheck

+ Supports InDesign CC 2018 through CS5
+ Converts QuarkXPress 2018 through v4
+ Eliminates time re-creating content

Quark to InDesign
Q2ID

from Markzware
CREATIVE SOFTWARE

Visit markzware.com/cp2018 for 25% offVisit markzware.com/cp2018 for 25% offVisit markzware.com/cp2018 for 25% off
valid June 4-8, 2018

Visit markzware.com/cp2018 for 25% offVisit markzware.com/cp2018 for 25% offVisit markzware.com/cp2018 for 25% off

https://markzware.com/cp2018/?src=cp2018_ad
https://markzware.com/?src=cp2018_ad
https://markzware.com/products/q2id/?src=cp2018_ad
https://markzware.com/products/flightcheck/?src=cp2018_ad
https://markzware.com/products/pdf2dtp/?src=cp2018_ad
https://markzware.com/products/markztools2/?src=cp2018_ad
https://markzware.com/products/id2q/?src=cp2018_ad
https://markzware.com/products/id-util-macos/?src=cp2018_ad
https://markzware.com/?src=cp2018_ad
mailto:sales@markzware.com


APPROVE AMAZING CREATIVE WORKTM

DEEP ADOBE CREATIVE CLOUD INTEGRATION
Send proofs out. Get changes back. From within your CC document.

DISCOVER MORE START FREE TRIAL

ADOBE CREATIVE 
CLOUD EXTENSION

The intrinsic GoProof extension 
runs from inside Id, Ps and Ai

REVOLUTIONARY 
TWO-WAY INTEGRATION
Send proofs out and get changes 
back without leaving Adobe CC

MANAGE CLIENTS 
AND PROJECTS

Add new clients and projects 
from within your CC app

NO PDF EXPORTS 
OR EMAIL TRAILS

Send documents for proof 
directly from your CC panel

ALLOW COPY 
EDITING ON PROOFS

Collaborators can edit text boxes 
you have unlocked for them

GET EVERYONE’S 
COMMENTS TOGETHER

Edits and changes are combined 
and delivered to your document

STEP THROUGH 
CHANGES AND LOG TIME

Add a time when you complete 
a change in our wizard

AUTOMATIC 
REVISION CONTROL

Ensure nobody jumps ahead 
or falls behind with feedback

INTEGRATES 
WITH GOVERSION
CoVersion auto-saves and 

restores CC documents

GET ADOBE CLOUD ADD-ON

  

  

  

https://www.goproof.net/?referrer=CPW18
https://app.goproof.net/Home/Signup?referrer=CPW18
https://www.adobeexchange.com/creativecloud.details.15291.html


Offers expire June 30th 2018, so move fast!

EXCLUSIVE UPGRADE OPTIONS FOR 

3 
MONTHS FREE*

50%
 

OFF PRO

USE CODE CPW18 AT THE 
CHECKOUT WHEN YOU UPGRADE  

Applies to monthly 
and annual purchases!

“I’m a big fan of any technology that makes it easier to 
collaborate on projects, and GoProof certainly does so.”

Anne-Marie Concepcion 
IndesignSecrets, CreativePro, Lynda.com.

MENTION CODE  CPW18  
WHEN YOU ENQUIRE  

*Based on a minimum 
1 year contract.

SIGN UP AND BUY ENQUIRE NOW

© 2018 Oppolis Software Limited All Rights Reserved

https://app.goproof.net/Home/Signup?referrer=CPW18
https://www.goproof.net/enterprise/?referrer=CPW18
https://oppolis.com/?referrer=CPW18


Pagination is a privately owned company founded in 2009. 
In only seven years, it has grown into a market-leading provider of database publishing solutions.

The Pagination approach to data publishing
Pagination’s new approach defines "database publishing solutions-as-a-service" (SaaS).
A solution that lets you take data from any source and convert it automatically into documents.

The entire system is cloud-based and works through a simple structure of shared folders.

The workflow is agile:

Pagination takes care of data transformation, library field mapping, creating chapters or versions of the documents 
based on the available data, and merging them in complete, cross-referenced documents. 

This approach resolves the three main inefficiencies of data publishing:

 
With Pagination database publishing becomes a cloud-based service: fast, flexible, and effective.

Pagination pros
The Pagination approach defines a new set of advantages and innovations in the data publishing process:

Customer base
Pagination has worked on more than 300 database-publishing projects, serving customers (from Fortune’s caliber 
corporations to SMEs) operating in a wide range of industries: automotive, distribution, fashion and luxury, 
home and furniture, and manufacturing.

Submit an
InDesign layout

Edit the
data source

Choose the
 images

1

Upload your
 files

2

Download your
 documents

3

Data 
Preparation

Complex Field 
Mapping

Resource-intensive Publication
 Cycles (“babysitting”)

The training required to use the system is near zero.User-friendliness

The service can process data from any source (Excel, Access, SQL, XML, Magento, etc.).Any data 

Update finished documents by uploading data or images in the cloud folders. Automatic updates 

Automatic updates of InDesign reduce the need to reopen the finished document, 
increasing the efficiency and effectiveness of the process.

High performance 

As a cloud-based system, the customer can access the shared folders anywhere, anytime.Anywhere, anytime 

Reduces the time need for publishing a document from days to minutes.  Less time, lower costs

Allows wide personalization in terms of layouts and file formats.Wide customization 

Finished documents will be ready for print, online, and mobile devices. Multi-channel strategy 

347-708-1631 info@pagination.com



WE CREATED THE GUILD

JUST FOR YOU

Presentations. 

Love ’em or hate ’em, they’re part 

of the modern designers’ workload. 

In fact, there’s a whole subset of the creative industry 

which is dedicated to designing, developing, and 

supporting presentations. 

We formed the Presentation Guild for those of you 

working in this space. We want to strengthen your 

support networks, stoke your creative passion, and 

help you cultivate skills which can further your career.

Join the Presentation Guild now and receive $20 off*

your $99 annual membership dues. Register at 

presentationguild.org

*Offer valid through July 8, 2018. You can only use one coupon 

or special offer per membership, but you can tell all your friends 

and co-workers about it, give them to your dog sitter, golfing 

partner, drinking buddy, hairdresser, or the person who takes 

your latte order. Be everyone’s hero.

20OFF

$

ANNUAL DUES

DISCOUNT CODE

CPW20
presentationguild.org
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WRIKE IS HERE! 
VISIT OUR BOOTH!

Empower your creative team to work with 
confidence. See why creatives from more 

than 16,000 agencies and organizations choose 
Wrike’s collaborative work management platform.

wrike.com
+1 877 779 7453

twitter.com/wrike

facebook.com/Wrike

plus.google.com/+Wrike

linkedin.com/company/wrike



Definition of Publishing Professional
There was a time when access to publishing production tools was one of the primary definitions of a professional pub-

lisher – someone who had the resources and tools to disseminate information or entertainment. And while everyone could 
eventually be a publisher, or could be a publisher on a small scale, it is only recently that the tools of publishing are available 
to nearly everyone without a large barrier to entry. Removing the barriers to publishing has left us with a situation where 
value has been challenged and a re-definition of “professional” needs to occur.

In the era when the tools more broadly defined what it was to be a publisher, the selection of those tools and the sub-
sequent training of individuals to use those tools, distinguished professional publishers from amateur ones. Access to the 
various distribution channels of publishing (books, newspapers, magazines, etc.), reasonably assured that most publishing 
was up to a minimal standard, though, of course, content has always been a big variable. As the tools and distribution chan-
nels for publishing have become more available (or new ones have emerged), it is harder to define or distinguish what it is 
that makes something professional (which I equate with value). This creates a dilemma for those who consider themselves 
professionals and wish to be treated like, and paid like, a professional.

How we defined professional in the past:
• Someone who got paid for the work

• Someone with access to publishing tools

Don’t Bleed on the Paste-up, and Other 
Life Lessons Learned
Gene Gable
ggable@sonic.net
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• Someone with special skills or training

• Someone who worked on projects of scale

The new definition of professional
While many of those definitions are still true, with access to publishing 

tools and distribution channels much more available, I believe we need to 
come up with some new definitions of professional, especially as we try to 
maintain value for professional services. I believe the new definition of pro-
fessional needs to include:

• Someone who has special skills or training, either in regards to the con-
tent being produced, or the technical skills needed to produce it.

• Someone who has a personal set of standards for their work and doesn’t 
compromise those, regardless of the publishing effort at hand.

• Someone who stands behind their work and takes responsibility for it.

• Someone who keeps up with new developments and is always looking 
to improve their results and skills.

Unfortunately, when it comes to determining value and engaging in com-
merce around publishing skills, those new definitions are harder to quantify 
and have a tendency to be diminished by some. That’s why it is so important 
that each individual work to establish and maintain value, not just for the 
quality of the work they produce, but for the attitude and engagement skills 
that accompany that work.  There are no longer many external criteria for 
determining a professional publisher – it’s really about behavior.

Tools will change, people not so much.
Over the decades the tools of publishing have changed several times, 

often with profound impact on the industry and the people who work in it. 
And while it may seem that the transition from analog to digital publishing 

tools has been complete, that does not mean that the primary tools of 
publishing will not change again, perhaps significantly. Amazon, Google 
and Facebook are providing publishing tools to their users now with many 
of them able to produce impressive results. So once again, the professional 
publishing community is left to mostly self-define what constitutes value.

It is also true that many of the things we do as publishers today will be 
automated in the future, forcing a refinement of individual skills and a 
renewed focus on the things that are less able to be automated or have arti-
ficial intelligence applied to them.

• Creative decision making and aesthetics

• The importance of context in making publishing decisions

• Knowledge of the audience and insight into how they behave

• How to produce distinctive material in a crowded content market

• The creative use of anarchy: breaking rules to provide more value

The reason there will always be a need for professionals in the publish-
ing process is because very often people don’t really know what they want, 
what they like, and what is effective. Even as we gain massive amounts of 
data regarding how people behave after viewing something, there is always 
an unknown or variable that makes a difference. Magazine publishers have 
known for years, for example, which colors or even which words tend to 
generate better newsstand sales. And yet, even armed with this informa-
tion, many new publications fail, while others, which break those rules and 
flaunt convention,  become runaway successes. Some of the best ideas come 
from situations where an individual or team are not aware of convention and 
don’t realize their approach is, by conventional standards, wrong.
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Ideas for professionals
Let’s assume everyone reading this is, by all of the definitions above, a true professional, and takes 

both their craft and their art seriously. The mere participation in an event such as this would satisfy 
some of the criteria already.  So what advice, based on my experience maneuvering through several 
waves of publishing technology, do I have to share?

1. Get a good keyboard.
My first tip is a practical one and perhaps a bit light, but I think important. One of my personal 

definitions of a professional publisher is someone who cares about words and images, and is certainly 
involved in presenting and perhaps finessing those words and images. A good-quality keyboard is, I 
think, an essential component of a professional workspace, and will make your life much better. There 
are many to recommend -- some of the gaming keyboards are actually quite wonderful with all sorts 
of tactile feel, great speed, and things like customizable keys, backlighting, etc. 

http://matias.ca/products/

2. If you can see it in your mind, you can make it with your hands.
Throughout every era of publishing production, the ability to visualize the finished product has 

been the single most important success factor that I have seen. This is where some of the old publish-
ing methods were stronger than today’s tools. You once had to see the finished project/layout in your 
mind and then build it by going backwards: first drawing it out, then specifying type, ordering half-
tones, drawing rules, etc. By the time you started any execution, you were already clear what the final 
result would, or should be.  Now, you can start with a blank space and make things up as you go along. 
In some regards this is terrific as it gives you flexibility and a limitless canvas. But each step in the 
process then becomes part of the design and definition of the final result. I’ve always admired those 
people, in every era, who knew exactly what they wanted and visualized it, and sometimes even ver-
balized it, as a finished thing or fete. These are the people who tend to be more productive, are higher 
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regarded, and often command higher fees -- the execution is just a process, not part of the creativity. 
Alfred Hitchcock use to say that he didn’t like making the actual movies -- he liked seeing the entire 
movie in his mind beforehand.

3. Always maintain high personal standards.
Whether doing a highly critical document or a jam label for a friend, the only standards that are left 

in this world are the ones you bring to the table. You will be measured by the results you generate, 
even if there is a checklist of requirements or other external measure. People don’t remember the 
challenges you had, like a short deadline, bad equipment, or the flu. They only remember what you 
produced and, in time, that is all that will remain. Don’t put out sloppy work, no matter your enthusi-
asm for the job. If you don’t want to do something well, don’t do it at all (unless your boss asks you to, 
but then there are still choices).

4. Sometimes the most helpful answer is to say “no.”
We don’t often get the chance to say “no,” but I wish we could all say it more. I have found over the 

years that the jobs that get me in trouble or don’t go well, were usually predictable from the start. It’s 
hard to say no to customers, even harder to say it to a boss, and I’m not suggesting you quit your job 
every time you have to do something you don’t want to do. But sometimes, whether directly or indi-
rectly (“that job might be better for so-and-so,”), it’s best to take a pass on something than to witness it 
go down in flames. 

5. Master your tools, but promote your craft.
It’s really terrific that you are at this event (see above definition of professional), and it’s great to be 

a master of all your tools, but I have seen in the past that too much focus on tools is one of the traits 
of the people who get left behind during technology upheaval. Talk about the results of your efforts. 
Show the results.  Try not to get too enamored with the technology, unless that’s your specific job. The 
tools will change in your lifetime, I believe, and your career may be better off when you leave some 
beloved tools behind. You must define yourself the way you want others to see you.
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6. Act like the publisher, but think like the reader.
It is your job as publisher of anything to make it as effective as possible and professional as pos-

sible. That requires that you always think like the reader or recipient of the material. Who am I? Why 
am I reading this? What am I suppose to do when I’m done?  Good design and good writing may soon 
become commodities (they already are to some degree), with little inherent value. The value comes 
in making those things effective, in targeting them properly and in framing them in the right context. 
Publishers are often skilled marketers as well. If you don’t think like a marketing person, then you 
should start. The first question shouldn’t be “when is it due?” or something similar, it should be “Who is 
this for?” Understanding the audience and being able to put yourself in their shoes, is a critical com-
ponent of success moving forward no matter what role you play in the process. Learn the tech skills, 
for sure, but also learn some of the marketing ones. Study UI Design. Learn everything you can about 
readability and type design. Take a class in advertising. All of this will help distinguish your work by 
making your work more effective.
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InDesign isn’t just for print. It can be used to design many types of 

digital output to be viewed on desktop and laptop computers, tablets, 

phones, and E-readers. But how do you know which output type is best 

for your audience and your content? In this session, we’ll examine 7 

different digital publishing options: HTML, Mobile apps, Mobile Web 

apps, Reflowable EPUB, Fixed-Layout EPUB, Publish Online, and PDF. 

Current Choices for Digital Publishing in 2018
Keith Gilbert
www.gilbertconsulting.com
kgilbert@gilbertconsulting.com
lynda.com/keithgilbert
twitter: @gilbertconsult
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Current Choices for Digital Publishing in 2018
Keith Gilbert

Seeking the perfect solution
We all want a digital format that…

 Is a single, universal file format

 Can be easily output from InDesign

 Is easy to learn, produce, and update

 Allows content to be read offline

 Allows for rich interactivity and media

 Can be easily and widely distributed 

 Look great on any device and screen

 Features searchable and selectable text

 Works great with social sharing

…is this too much to ask?

InDesign outputs virtually flawless print files. But exporting layouts to some 
sort of digital format is another matter. The main challenge is that there is 
no single perfect digital output format that “checks all the boxes” for 
everyone on all the different reading devices available.

A “phone first” world
 ■ 77% of Americans own a smart phone (pewrsr.ch/2Hvvh8r)

 ■ Mobile accounts for 52% of all Web traffic worldwide (bit.ly/2JmkBJO)

 ■ 68% of digital media time now spent on mobile devices (bit.ly/2phfqEk).

 ■ Apps account for 89% of mobile media time, with the other 11% spent on 
websites (bit.ly/2phtMEJ).

 ■ 83% of mobile users say that a seamless experience across all devices is 
very important (bit.ly/2phtMEJ).

 ■ 91% of mobile users say that access to content is very impor-
tant (bit.ly/2phtMEJ).

So what should you do?

To produce meaningful digital content today, you must be willing 
and ready to:  
• Frequently assess (and reassess) your audience 
• Clearly define your requirements 
• Expect to adapt and change course frequently 
• Be ready to compromise 
• Be prepared to output to multiple formats

On the following pages I compare and contrast 7 differ-
ent digital publishing options, listing the pros and cons 
of each. I’ve also assigned a “degree of difficulty” to each 
option to give you a sense of the time and resources nec-
essary to learn and produce files with that solution.
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Output option 1: HTML, CSS & JavaScript
HyperText Markup Language (HTML), Cascading Style Sheets 
(CSS) and JavaScript are the technologies that make every 
Web site work. The HTML language by itself contains only 
very simple formatting instructions. But the addition of CSS 
makes it possible to include rich formatting that nearly rivals 
print typography and layout in variety and precision. Adding 
JavaScript into the mix allows for rich interactive experiences.

HTML, CSS, and JavaScript are used to some extent by all of the 
other technologies we’re talking about in today’s session except for 
PDF. Its a safe bet that some “flavor” of HTML output will be at the 
core of all future digital publishing solutions.

Nowadays, most people expect HTML to be “responsive”. This is HTML that is 
created in such a way that the layout changes depending on the size of the 
screen on which the page is being viewed. As you can imagine, this type of 
HTML is more time consuming to create. Someone has to decide what the 
layout should look like at the various screen sizes. And, InDesign doesn’t 
really have the tooling to create complex responsive HTML.

Choosing InDesign’s Export command and selecting HTML for the output 
will generate “reflowable” HTML for very structured, repetitive documents 
that are carefully laid out following certain rigid rules.

If you want “fixed-layout” HTML output that mimics your print layouts 
exactly, you can try a free script I wrote that does the job quite 
nicely (bit.ly/2jkE7cQ).

The InDesign Plug-in in5 (bit.ly/2g62XjB), does an 
excellent job of translating the richness and complex-
ity of an InDesign layout into corresponding HTML, 
CSS, and JavaScript, and features many output and 
customization options. in5 can create both fixed-layout 
HTML output as well as reflowable HTML output using 
some of InDesign’s “Liquid Layout” features.

Pros
 ■ Output viewable on virtually any device, anywhere.

 ■ Selectable, editable, accessible text.

Cons
 ■ No simple, standard way to distribute via email or other “ad hoc” meth-

ods. Must be put on a Web server.

 ■ Difficult to monetize.

DEGREE OF 
DIFFICULTY 3
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Keith Gilbert

Output option 2: Mobile app
Mobile apps are usually created by programmers. However, solutions such 
as AEM Mobile (adobe.ly/1Zxmcyq), Twixl Publisher (bit.ly/2a3riDO), 
Aquafadas (www.aquafadas.com), or Mag+ Designd (www.magplus.com) 
allow you to create a mobile app without any programming, and then 
populate the app with content from InDesign. Services such as  Paperlit 
(paperlit.com) are similar, but can work with content exported from 
InDesign using in5, as well as PDF content. All of these solutions make peri-
odical content easy to distribute, “pushing” your periodical content into the 
app whenever you are ready to publish.

These types of apps seem to work best in 3 situations. 1) periodicals that 
publish frequently enough so that people are driven to return to the app 
for fresh content. 2) One-off apps that aren’t periodical in nature, such as 
interactive travel guides, annual reports, cookbooks, and the like. 3) Sales-
enablement apps that equip a sales force with all the latest product litera-
ture, demos, videos and other sales tools. Many of the early adopters of 
these types of apps have abandon them due to limited success with read-
ers. It’s telling that Adobe has all but walked away from their AEM Mobile 
(formerly DPS) product.

In my post-conference session on Friday titled “Make a Mobile App with 
InDesign”, I’ll be showing how to build a complete “content-first” mobile 
app for less than $200, using InDesign to create the app content, screens, 
and interaction, in5 to convert the content to HTML, and Adobe PhoneGap 
Build (included with Creative Cloud) to build the app.

Pros
 ■ Easy to monetize in an app store.

 ■ Great for periodicals.

Cons
 ■ App distribution outside app stores is difficult.

 ■ Restricted to mobile devices only.

 ■ Must keep app updated as technology changes

DEGREE OF 
DIFFICULTY 5
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Output option 3: Mobile Web App
A mobile Web app is a Web site that contains some special code that 
prompts the user to add the site as an icon to the home screen of their 
tablet or smartphone. This causes the app to occupy some valuable screen 
real estate on the user’s device, hopefully reminding them to revisit the app 
again and again.

The in5 plugin for InDesign has the ability to create a Web app from InDe-
sign-generated content without any HTML or JavaScript coding knowl-
edge necessary. Or, see this Lynda.com video (bit.ly/2HzpHSy) to learn 
the coding necessary that you could add to any type of HTML output from 
InDesign to turn it into a Mobile Web App.

Pros
 ■ Many of the advantages of a 

“real” mobile app without the 
complexities and costs of app 
store distribution.

Cons
 ■ Unlike a true mobile app, mobile 

Web apps require a Web server 
and internet connection.

DEGREE OF 
DIFFICULTY 3
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Output option 4: Reflowable EPUB
Reflowable EPUB is an open-standard file format for publishing, distribut-
ing, and reading content on e-readers such as Nook and Kobo devices, as 
well as e-reader apps on tablets, smartphones, laptop, and desktop com-
puters. Amazon Kindle e-readers use their own proprietary “mobi” and “kf8” 
file formats. EPUB files cannot be read on Kindle e-readers. Thankfully, once 
you’ve created a reflowable EPUB file, converting it to Amazon’s file format 
is not terribly difficult. 

Reflowable EPUB files dynamically reformat to fit the device on which they 
are being viewed. The reader, not the designer, controls the typeface, type 
size, line spacing, and margins. In-line graphics can be included, but options 
for embedding video and interactivity are very limited. For these reasons, 
reflowable EPUBs are typically used for novels and other long, text inten-
sive documents.

With skilled file construction and proper training, InDesign content can be 
reliably exported to reflowable EPUB format without any additional plug-
ins or software needed.

Pros
 ■ Easy to monetize and distribute 

through e-book stores such as 
iTunes or Kobo.

Cons
 ■ Very little control over layout and 

appearance. Complex layouts are 
impossible. Support for media and 
interactive content very limited.

EPUB doesn’t appear to be a growing format. Year-over-year sales of eBooks 
appear to be fairly flat. See the chart at right. For other perspectives, see 
bit.ly/2r4UDTN and lat.ms/2r2zYQg.

DEGREE OF 
DIFFICULTY 4

Number of eBooks sold in the United States from 2010–2016

https://www.statista.com/statistics/426799/e-book-unit-sales-usa/
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Keith Gilbert

Output option 5: Fixed-Layout EPUB
Fixed-layout EPUB files are very easy to create from InDesign, and the result 
looks exactly like your InDesign layout. And, the resulting file can be viewed 
on desktop and mobile devices and will scale to fit the screen. What could 
be better than that?

Unfortunately, fixed-layout EPUB files created from InDesign can only be 
read in the iBooks app for iPhone and iPad, the iBooks app for Mac laptops 
and desktops, and the Kobo reader. Specifically, they aren’t supported by 
any of the Kindle e-readers or tablets. Furthermore, converting an InDesign-
generated fixed layout EPUB file to the kf8 format required by Amazon is 
very difficult.

A really good alternate method for creating fixed layout EPUB files from 
InDesign is the software and service Circular Flo (bit.ly/2eJE3kA). Circular 
Flo can output InDesign layouts to both EPUB and Amazon’s KF8 format, 
offers automatic “read -aloud” features, and supports a wider variety of 
interaction and animation than InDesign’s built-in tools.

Unfortunately, there is no widely-distributed desktop reader for fixed-layout 
EPUB files. Modern Macintosh computers include the iBooks reader, but 
there is no widely distributed counterpart on Windows computers.

The ability to easily include rich animation and media, the pixel-
perfect layout control, and the ability to easily create content that 
works well on iPads makes this format perfect for children’s books.

Pros
 ■ Very easy to create, good support 

for interactivity and media, easy 
to monetize.

Cons
 ■ Supported by a limited number of 

e-readers and e-reading apps.

The Readium project readium.org is an open-source effort to create EPUB 
readers for Web browsers and desktops. The Readium Cloud Reader offers a 
way to display fixed layout EPUB content on your Web site.

DEGREE OF 
DIFFICULTY 2
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Output option 6: Publish Online
Publish Online is far and away the simplest way to make your content 
available to a wide audience digitally. Just click the Publish Online but-
ton, answer a few questions, the layout is uploaded to a Web site hosted 
by Adobe, and the URL for the document is returned to you. You can then 
include this URL on your Web site, in an email, or whatever you want to do 
with it to drive people to your content.

After clicking the Publish Online button, you 
can specify a Title, Description, and a few other 
publishing options.

Once the Publish Online upload is finished, you are given 
a unique URL for the document.

Publish Online works really well. But the main drawback for many 
people is that the content must be hosted on Adobe’s servers. You 
cannot download the code and put it on your own Web server. (You 
can, however, embed it as an iFrame on your Web site). Nor can you 
customize the URL. It will begin with the domain indd.adobe.com. 

Pros
 ■ Free and easy to create, good sup-

port for interactivity and media.

Cons
 ■ Content must be hosted on 

Adobe’s servers, text is not select-
able or searchable.

See adobe.ly/29TE7Qf for a curated list of examples of Publish 
Online documents.

DEGREE OF 
DIFFICULTY 1
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Output option 7: PDF
The venerable Portable Document Format (PDF) still has a place in digital 
publishing. PDFs are easy to create and can be easily distributed in a num-
ber of ways. Most people know what to do with a PDF when they encoun-
ter one.

But as mobile devices have proliferated, so too have the number of different 
PDF “reader” apps. As a result, the on-screen fidelity of a PDF and support 
for interactive features isn’t as robust as it once was. In fact interactivity, 
animation, and video in PDF is so poorly supported in most mobile PDF 
reading apps that unless you can dictate which PDF reader app your audi-
ence uses, its best to avoid including most types of interactivity, animation, 
and video in PDFs. The only interactive elements that are really safe to use 
are button actions, forms, bookmarks, and page transitions.

Pros
 ■ Easy to create, distribute, and share. Selectable, accessible text.

Cons
 ■ Not responsive, poor support for interactivity and media.

Want more?
Much more detail is available in the 
Digital Publishing Technology Guide 
that a wrote with Justin Putney. You 
can download a free copy of the 
guide at bit.ly/2phlDju.

Digital Publishing 
Technology Guide

by Keith Gilbert & Justin Putney

DEGREE OF 
DIFFICULTY 1

Keith Gilbert is a consultant, educator, speaker, and author based in St. 
Paul, MN. He helps solve design and production problems by writing custom 
InDesign scripts, provides on-site and remote training, and is an author of 
several popular Lynda.com/LinkedIn Learning courses.   GilbertConsulting.com
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PDF is Not Just for Printing or Where Data Goes to Die
Everyone knows that PDF excels as a format for presentation – both printing and viewing – of final form textual and 
graphical content. And most seasoned InDesign, Illustrator, and Photoshop users are well aware of the ISO PDF/X standards 
supported by these applications that are used to ensure reliable printing.

However, governmental, academic, and research organizations are increasing requiring submission of PDF files conforming 
to one of the PDF/A standards designed to be “safe” for document archiving. And likewise, there are increasing calls for PDF 
files to be more accommodating in terms of supporting access to “underlying data” associated with that beautiful PDF final 
form content.

This session makes the case not only for designers and publishers to concern themselves with not only printability, but also 
archivability of their PDF. We explore the various PDF/A standards as well as methods of creating PDF that supports PDF/A 
now and directions for PDF/A and jointly tagged PDF/X and PDF/A files in the future.

But wait, THERE’S MORE!

We also study the issues of “PDF Open Data” and provide techniques that can be applied today to create such PDF files. We 
will prove by a very realistic example that you can relate to that PDF is not “where data goes to die.” 

PDF Beyond Printing & Viewing 
– PDF for Archiving and Data
Dov Isaacs
Adobe Systems Incorporated
isaacs@adobe.com
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PDF Beyond Printing & Viewing – PDF for Archiving and Data
Dov Isaacs

Handouts
There is way too much that will be presented in the presentation to do any 
justice by trying to condense 34 slides onto a few pages here.

The slides (print-ready fully color-managed PDF/X-4 file with live 
transparency – no copies of PowerPoint were were even touched in 
preparation of the slides) and the sample files will be available for you 
concurrent with the presentation session.

But to pique your curiosity, some pretty figures from the presentation slides 
are presented here.
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PDFs are where data goes to die!

The Challenge – Combating Ignorance & Misconceptions
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GUSTAV HUNKLEDINKLE 
 20821 LEINRAC AVE  
AGOTARAS, CA  95110

GUSTAV HUNKLEDINKLE 
 20821 LEINRAC AVE  
AGOTARAS, CA  95110

4011164719-0

Your Payment History
Click here to view your payments to PG&E over the last two years

Click to view

Monthly Electricity Usage & Billing 
CSV spreadsheet format:

XML format:

Monthly Natural Gas Usage & Billing 
CSV spreadsheet format:

XML format:

4011164719-0

 20821 LEINRAC AVE 
4011164719-0

Electricity Consumption by Day and Hour

Click to view

CSV spreadsheet format:

XML format:

4011164719-0

 20821 LEINRAC AVE 
4011164719-0

Natural Gas Consumption by Day

Click to view

CSV spreadsheet format:

XML format:

4011164719-0

Regulatory Notifications

These notifications were included with mailed / paper billings.

Click to view:

NOTIFICATION OF PACIFIC GAS AND ELECTRIC COMPANY’S 
REQUEST TO INCREASE RATES FOR ENERGY STORAGE APPLICATION (A.17-12-003)

NOTIFICATION OF PACIFIC GAS AND ELECTRIC COMPANY’S  
REQUEST TO INCREASE RATES FOR GAS TRANSMISSION AND STORAGE APPLICATION (A.17-11-009)

Dov 
Isaacs - 
דב איזקס

Digitally signed by Dov 
Isaacs - דב איזקס 
Date: 2018.05.08 11:19:38 
-07'00'
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1CREATE TEXTURE

As humans, touch is one of our strongest 
senses. Our minds can register how 
something feels before we even look at 
it, and marketers are jumping on this 
opportunity by creating textured print. 
Case in point — have you ever received 
a catalog in the mail from a high-end 
retailer that had “soft touch” coating,  
and you found yourself running your hand 
over the cover multiple times? Gotcha!
 Whether it’s an embossed pattern or 
a press coating, the ability to distract 
and engage us with touch is one of 
print’s greatest strengths, so leverage  
it for all it’s worth. 
 In direct mail, there is a huge trend  
in textured paper and embossed enve-
lopes, as well as in press coatings and 
textural ink effects. These textures really 
stand out in the mail, and when you’re 
carrying a handful of mail, you’re likely 
going to choose the interesting ones 
first. Texture applied to the outside of the 
mailer will grab your attention before you 
even realize that your senses are being 
manipulated.

INTEGRATE TECHNOLOGY
Many see print as just its name implies—
ink on paper—while others on the cutting 
edge see print as a medium to deliver 
different forms of technology that can 
greatly enhance the consumers experi-
ence with the printed piece. 
 If you’re on a tight budget, try 
technologies like variable data personal-
ization (VDP), QR codes and personalized 
URLs to drive customers to the next 
step – online engagement – where you 
can continue the personalized consumer 
experience with additional messaging 
and offers.
 On the higher end of the spectrum, 
there are wafer-thin high-definition  
LCD screens embedded into printed 
materials, fiber optics, RFID tracking  
devices, near-field communications 
(NFC), electroluminescence, Augmented 
Reality (AR), sound chips, and more. 
Imagine your customer opening their 
mailpiece and using the latest in print- 
integrated technology to learn about  
your new product. Now, that’s powerful.
 Adding sophisticated technology to 
your printed mailpiece definitely adds to 
the cost, however, if positioned correctly 
and sent to a targeted audience of inter-
ested parties, technology can elevate 
visibility, greatly increase engagement, 
create heightened brand awareness,  
and dramatically increase response.

4

3ADD A HUMAN TOUCH
In a world of high-speed automation,  
a personal touch is a guaranteed atten-
tion-grabber. Whether it is as simple as 
choosing a custom first-class stamp, or 
adding a handwritten note or address to 
a piece of mail, the sense that a person 
took the time to interact is a powerful 
tool we can use as marketers. Going  
“old school” can pay off big time.

 Although we can’t, as marketers, 
make every response and touch point 
a personal one—it just wouldn’t be 
efficient, scalable or cost-effective—we 
can instead give the effect of person-
alized interaction with our brands. The 
humanization of a brand symbolizes the 
crossover from intellectual relationships 
to more emotional ones. We can do this 
by letting the customer get to know the 
people who work for the company, and 
through storytelling. For example, when 
an order ships, you could send an insert 
(bounce back) that says “Your order 
was packed with care by Jennifer” and 
include a photo of her and a scan of her 
handwritten signature. Your catalog could 
identify staff favorites in the product line, 
or the models could be actual employ-
ees. Let your customers get to know 
your company and the people who work 
at it to enhance the customer experience 
and build brand loyalty.  

USE VISUAL TRICKS
Sometimes the way to create impact is to 
do so with a snazzy visual trick. The key 
is to create a situation where one image 
integrates with another—maybe perhaps 
something is changed or revealed, maybe 
there’s humor, or a new message.  
 In the example pictured above, WFG 
dresses a gate fold as a set of subway 
doors. When you open the piece, you’re 
opening the doors to the interior of the 
subway and powerful statistics. So, 
utilizing a basic gate fold and interesting 
imagery, you can entice the recipient to 
open and explore. Cheap, easy and fun! 
 You can also combine visual tricks 
with interaction devices like zip strips and 
pull tabs to reveal interesting changes in 
imagery. You can apply these devices to 
folded formats and envelopes to make 
them instantly more engaging. Interaction 
is key for this type of engagement, and 
getting them physically involved in doing 
more than just “opening” the direct mail  
is the secret.  

10 BIG IDEAS
For Adding “WOW” To Your Print

“ In a world of high-speed  
automation, a personal 
touch is a guaranteed  
attention-grabber.”

TRISH WITKOWSKI

©2018 Trish Witkowski / All Rights Reserved
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CHOOSE A GREAT PAPER
Utilizing the tactile quality of paper can 
be a great way has been proven to keep 
a printed piece in the hands of the recipi-
ent longer than the average “handling” of 
a printed piece. There is an undeniable 
physicality to print that gives it the power 
to captivate the recipient. Intentionally 
choosing papers that are different from 
the norm in some way—brighter and 
whiter, smoother and glossier, colored 
and textural—can send subliminal 
messages to your recipients. You can 
leverage paper choice (and weight) to 
communicate sophistication, eco-con-
sciousness, style, and personality. You 
can even deliberately choose low budget 
papers to look “bargain basement.” It 
all depends upon what you’re trying to 
accomplish from a brand perspective. 
 And don’t underestimate the relation-
ship between design and paper.  Prop-
erly chosen paper, complimented by a 
strategic design direction can support 
the message, the brand, and the offer as 
effectively as well-developed copy. Take 
for example Eddie Bauer. They recently 
printed a piece that fit the company’s 
personality perfectly. The texture and 
feel of the uncoated stock gave the 
impression of a sketchbook or diary  
kept while on a relaxing trip through  
the great outdoors.
 If you’re choosing white paper for 
your project, don’t just go for the house 
stock by default. Think about cream 
whites (warm) versus blue whites (cool) 
and true whites (neutral), and how those 
tones will affect your imagery. Regard-
less of what color or finish you choose, 

think about how the paper feels and how 
it folds. Always request paper dummies 
and remember that you’re creating a 
sensory experience that is tactile and 
visual, and extremely powerful.

GO WILD WITH INK
We’ve all heard and used the term “pop” 
when it comes to print, but there’s “pop” 
and then there’s “POP”! And you have 
two ways to achieve this – varnishes and 
coatings, and specialty inks.
 Varnishes no longer fall into two 
categories – overall or spot, gloss or 
dull. There are more varnish and coating 
techniques than you can shake a stick 
at, and they come in all kinds of flavors!  
Matte, dull, satin, gloss, scented, tinted, 
spot, overall, UV , aqueous, and any com-
bination of the aforementioned. We have 
varnish techniques for traditional offset 
presses, digital presses, and UV presses, 
and there are in-line and off-line applica-
tions, just to mention a few options. If you 
want to enhance the appearance of the 
paper (or the imagery on it), your choices 
have never been better. 
 Varnish—in dull, gloss or satin finish—
is ink that is either without pigment, or 
lightly tinted with pigment for a more sub-
tle wash of color. Varnish can be applied 
as a flood or spot application. Often dull 
and gloss varnishes are used together 
to create contrast on the sheet. You can 
also use it merely to protect the surface. 
And of course, the paper you choose will 
come into play as to how the varnish or 
coating will appear on the final product.

 For stronger protection and, in some 
cases, more drama, you can use a press 
coating instead. There are two kinds of 
coatings—aqueous and UV. An aqueous 
coating is a fast-drying coating that is 
usually a flood application in dull, gloss 
or satin finish. It is more resistant to 
scratching than a varnish and does not 
yellow over time. 
 A UV coating gets its name from the 
ultraviolet drying process it requires. UV 
coatings can be applied as flood or spot 
and offer tremendous gloss and surface 
protection. UV is also the most expensive 
of the coating processes, but it can be 
worth the money for the added impact 
it creates. UV press coatings can be 
applied in high gloss, sandpaper finish, 
soft touch, glitter and other textures just 
to name a few.
 If you’re printing digitally, advance-
ments in digital print have led to printing 
with white ink, transparent and raised 
ink, spot colors, metallics, fluorescents, 
and more. Ask your printer for guidance, 
and don’t forget that offset print also 
can include touch plates, spot colors, 
metallic, and fluorescents as well.

ADD DIMENSION
Dimensional print materials are always 
fun and unexpected. The surprise of 
opening something that expands, lifts, 
twists, moves or stands on its own 
is always an opportunity to engage. 
Response rates can go into the double 
digits when a dimensional campaign is 
done right. 
 The trick with dimensional, however,  
is a clear concept and message. 
Although dimensional communications 
have tremendous power to engage us, 
they can also distract us and keep us 
from getting the message. So, it’s critical 
that any added dimension makes sense, 
and drives the recipient to action. Don’t 
get so caught up in the “wow-factor” that 
you miss the marketing opportunity.
 Also in the dimensional category is 
lumpy mail. There’s something about a 
mysteriously irregular piece of mail—
you just have to open it and see what’s 
inside. Sometimes it’s a coupon or gift 
card, a heavy insert, a paper clip or a 
coin. Maybe it’s a free pen, a magnet or 
a luggage tag—and whether it’s worth 
something to you or not, it got your 
attention. 
 Object marketing is an old-school 
technique that works. Little tchotchkes 
are great for companies that offer 
certain types of recurring services like 
accounting, plumbing, dry cleaning, etc. 
Plastic coupons in the shape of credit 
cards and lenticular inserts can also be 
useful and engaging. 

©2018 Trish Witkowski / All Rights Reserved
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 More valuable giveaways, like custom- 
branded USB drives or objects that 
support creative marketing concepts  
can be attractively packaged with mar-
keting material and mailed to targeted 
customers or prospects for a memora-
ble impression. When considering what 
to give away, remember that the best 
gifts are the ones that connect somehow 
to your product, service, or offer.

GO BIG (OR GO HOME)
Big is “big” these days, as marketers are 
leveraging larger sheet sizes for digital 
presses and creative formats that allow 
for maximum impact and maximum real 
estate for eye-catching graphics. Size 
is also a tool we can use to create pres-
ence and influence and larger-than-life 
brand experiences. Oversized brochures, 
newsletters, posters and mail have a 
distinct opportunity to grab the viewer’s 
attention and hold onto it.

FOCUS ON THE DETAILS
Often what sets one printed piece 
apart from the others is the attention to 
detail. We all know it when we see it, but 
sometimes everything just works. Maybe 
you can’t put a finger on it, maybe you 
can. When the color pops and the paper 
feels perfect for the application, and the 
folding is pristine—these are all things 
that matter. Combine it with skilled typog-
raphy, good copy writing, professional 
photography and an artful eye for color. 
Now add a spectacular application of foil, 
or an understated blind embossed logo, 
or a spot varnish or a die cut. The result? 
Magic. Think of print as an experience 
and never overlook the details—they  
can make all the difference.

USE A COOL FORMAT 
We get so used to looking at the same 
few formats every day that sometimes 
it’s easy to forget that we can change 
these formats in even the simplest of 
ways to make them feel and look entirely 
different. If you’re skeptical, then take 
your usual 4” x 9” tri-fold and make it 
9” x 4” and see what that does to your 
layout (and your mind). 
 Why not trim a cover panel short? Or 
what about using asymmetry to change 
things up? You can push the gap of a 
gate fold off-center, or adjust the widths 
of the panels of an accordion fold to 
change things up. 
 On the opposite end of the spectrum, 
creative specialty formats can be impact-
ful and fun. Different stands out, and the 
opportunities are endless. To get started, 
ask your printer, or visit foldfactory.com 
for dielines and inspiration.

 With format, one of the most import-
ant things to consider is the delivery 
method. If the piece will be handed out, 
then you’ll want to think about portability. 
If it must mail without the protection of 
an envelope, there are very specific mail 
requirements to follow. If you can use 
an envelope, there’s more flexibility, but 
you’ll want to consider the enclosure size 
and weight.

“ Often what sets one printed 
piece apart from the others 
is the attention to detail.”

©2018 Trish Witkowski / All Rights Reserved

Join “Fold Club” at  
Foldfactory.com to 
gain free access to 
our award-winning 
template building  

software. Don’t forget to subscribe 
to “60-Second Super-Cool Fold 
of the Week” on the Foldfactory 
YouTube channel, and watch Trish 
Witkowski on LinkedIn Learning/
Lynda.com.



Introduction
For many designers, Acrobat is just an application to view or output their layouts. Or, it’s what clients use to mark-up a layout 
with changes. 

In this tips & tricks session, you will learn just how much more Acrobat DC can do to enhance your workflow in some very 
unexpected ways.

But before we get there, let’s take a step back to when Acrobat DC was first introduced in 2015.
First of all what the heck does DC stand for? 
No it has nothing to do with electricity. And sorry Comic Con fans, it has nothing to do with DC Comics. DC stands for 

Document Cloud, because you can save your files directly to Creative Cloud if you want. 
To me, the biggest advantage of this major remake of Acrobat was, and still is, its simplified interface, which makes it easy 

to find the tools your want in seconds. So no more playing “Adobe hide and seek” every time you need to use a different 
Acrobat tool.

Secrets of the Acrobat Masters
Jeff Witchel
www.JeffWitchel.net
AdobeAce@Comcast.net
@JeffWitchel
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Secrets of the Acrobat Masters
Jeff Witchel

In this session, we’ll be taking a look at:

• Opening a variety of graphics file formats directly in Acrobat DC 

• Combining a variety of graphics files into a single PDF

• Changing the organization and orientation of pages in an existing PDF

• Extracting pages from an existing PDF

• Using Acrobat to find the differences in two layouts

• Making edits to PDFs (Illustrator is NOT a PDF editor)

• Extracting pixel images into Photoshop and vector images into Illustrator

• Turning form layouts into interactive fillable forms

Opening a variety of graphics file formats 
directly into Acrobat DC
Recently, during a training session, I was demonstrating Preferences settings 
in InDesign and showed the students the location of Preferences files on my 
system. I took a screenshot of my folder setup to email to the students but 
I wanted to add some Acrobat notes, so I dragged that screenshot to the 
Acrobat DC icon in my doc and something magical happened. 

The PNG screenshot opened in Acrobat DC and I saved it as a PDF to add 
my notes.

Does this instant PDF magic work with other graphics formats?
Absolutely! I’ve opened all of the following with no problem:

• PNG

• JPG

• TIF

• BMP

• AI

• EPS

Instead of drag and drop, you can also use the more traditional File > Open 
in Acrobat DC. But make sure to select “All Files” in the Show popup menu of 
the Open dialog or a lot of files will be grayed out.

Some of the file formats that can be converted actually surprised me. As I 
was playing with the feature, I discovered that I can open Photoshop images 
and even InDesign layouts along with some non-graphics file formats such 
as Word files. With some formats such as INDD, you’ll notice that the file gets 
uploaded to Document Cloud PDF Services, converted to a PDF, and then 
downloaded to your computer and opened in Acrobat.
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Combining a variety of graphics files into a 
single PDF
What if you need to convert many different kinds of files to a single PDF?

No problem! In Acrobat DC, go to File > Create. Then you can simply drag 
and drop the files into the window and press the Combine button to create 
a Binder of these files. It’s not a PDF however until you save the file.

You can also press Add Files to add the files or even whole folders to a 
new PDF. But this method will only work with the simpler graphics formats, 
not InDesign INDD or Photoshop PSD files.

Changing the organization and orientation 
of pages in an existing PDF
I’m sure you’ve received a PDF, at one time or another, with the orientation 
of some of the pages facing the wrong direction or pages in the wrong 
order. Instead of hurting your neck or standing on your head trying to view 
these PDFs, change the orientation so every page is facing upright in the 
right order.

After opening the PDF, go to Tools in the upper left corner of the Acrobat 
window and choose Organize pages. This allows you to do the following: 

• Change the orientation of each individual page by clicking on the rota-
tion buttons for clockwise or counter-clockwise

• Change the order of pages by clicking and dragging a page to a new 
insertion point

• Delete a page by clicking on the Trash button for that page

• Duplicate a page by Option/Alt dragging that page to a new insertion 
point

Then just return to the document 
in the Tools menu and save you 
organized PDF.

Extracting pages from 
an existing PDF
You download a United States 
government form from the web 
and there are pages of instruc-
tions and worksheets that you 
do not wish to include when you 
email the completed form.

Is there a way to extract just the 
pages you want from this PDF?

Absolutely! Simply do the 
following:

1. With the existing document 
open, click on the Pages 
icon to the upper left of the 
document.

2. In the page thumbnails, click 
on the page you wish to 
extract (Shift-click to choose 
multiple pages).

3. Click the Options menu to 
the upper left of the page 
thumbnails and choose Extract.

In the same menu, you can also Insert Pages, Replace Pages, Delete Pages, 
Crop Pages, Rotate Pages, create Page Transitions, and a lot more.
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Using Acrobat to find the differences  
in two layouts
You have two nearly identical layouts and you’d like to compare the differ-
ences between them to figure out which is the one your client is looking for.

To compare the two files, do the following:

1. Open the two PDFs, and under the Tools, choose Compare Files.

2. In the Compare Files section, you can choose your settings for what 
you wish to compare.

3. Click the Compare Files button.

4. The two files will be compared side-by-side with the difference in each 
highlighted.

5. You can compare the highlighted changes one-by-one, with Acrobat-
generated notes describing the differences.

Acrobat DC prepares a separate report comparing the two versions of your 
layout, so the originals PDFs will remain untouched.

Making edits to PDFs 

Illustrator is NOT a PDF editor
In an emergency, you need to edit a PDF. The design only exists as a PDF, so 
how can you edit it? 

Many designers will tell you to open the PDF in Adobe Illustrator. After 
several error messages about an unknown gradient type or type getting 
outlined to preserve appearance, the file opens. 

When you try to edit some text, you realize how tough this task will be. 
Each line of type or even individual characters may be totally separate text 
objects.

You may or may not be able to select the exact objects you want depend-
ing on how Illustrator is seeing groups within the design.

Experts such as Dov Isaacs, Principle Computer Scientist at Adobe, will tell 
you never to edit a PDF in Illustrator unless it’s a PDF created in Illustrator. 
Too many things can and will go wrong.

So what can you do?

4 of 7



Secrets of the Acrobat Masters
Jeff Witchel

Acrobat DC Edits 
PDFs beautifully
Open the same PDF in Acro-
bat DC and go to Tools > Edit 
PDF, and you’ll instantly see 
why Acrobat DC is a far bet-
ter choice for Editing PDFs 
than Illustrator.

Some quick examples:

• The type is contained in 
Text Frames, so the lines 
of text will re-break as 
needed when editing.

• You can change format-
ting of your type includ-
ing the font, the size, the 
alignment and spacing.

• Numbered paragraphs 
will renumber if you add 
or delete paragraphs.

• Objects can be easily 
moved and aligned.

• It’s simple to flip, crop, 
and rotate objects with intuitive tools

• Images in your layout can be edited in Photoshop and will update in the 
Acrobat when saved.

• Images can be cropped and even replaced in your PDF layout.
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Extracting pixel images into Photoshop 
and vector images into Illustrator
One of the most useful editing features in Acrobat DC is the ability to 
extract artwork from a PDF. 

Imagine that the artwork you need for a project only exists in a high-reso-
lution PDF. But the art is cropped in the PDF layout.

Can you extract the entire piece of art even though the art is cropped in 
the PDF?

The answer depends entirely on how the layout was exported to a PDF. 
This example was exported from an InDesign layout. 

If the InDesign PDF export options are set Crop Images Data to Frames, 
only the cropped part of the art will exist when extracted from the PDF. But 
if this crop option is unchecked during PDF export, the entire image can be 
extracted.

So the only way you’ll know for sure is try it using the following steps:

1. With the PDF open, go to Tools > Edit PDF.

2. Click on the image to select it.

3. In the right panels, in the Objects section, look under the Edit Using 
popup menu and choose Photoshop or Illustrator.

4. Save the artwork with a new name in Photoshop or Illustrator.

Turning form layouts into interactive 
fillable forms
You have five minutes to turn a form layout from InDesign into an interac-
tive fillable PDF form.

Ready, Set, GO!

1. Export your form, using either Print or Interactive PDF format. It does 
not matter for this example.

2. Open the form in Acrobat DC.

3. Under Tools > Forms & Signatures, choose Prepare Form, which will 
automatically detect what form features to use.

4. Press Start and it’s done.

Wow! That was fast and it did a great job. But it didn’t automatically detect 
my Submit button. I wanted the completed form to be emailed to a specific 
address.

I know how to quickly do this in InDesign. Let’s set this up in the layout 
using the following steps:

1. Select the rectangular button shape.

2. I’m going to switch to the Interactive for PDF workspace and open the 
Buttons and Forms panel.

3. Click the Convert to Button button and in the Actions popup menu 
choose Submit Form.

4. In the URL field, type “mailto:yourclient@client.com” (in my case 
“mailto:AdobeAce@comcast.net”).

5. Name the Button and add a Description in the PDF Options.

6. Then export (File > Export) as an Interactive PDF adding the word  
Button to the end of the name so you don’t replace your existing form.
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Now you have your interactive button but it’s in a separate PDF. Try the  
following simple trick to finish your instant fillable form:

1. In your “button” PDF, under tools, select Forms & Signatures.

2. Click on your button rectangle and copy and paste the object into the 
form you generated earlier.

3. Under Tools, return to your document and save your finished fillable 
form.

Take your finished form out for a spin filling in fields, checking checkboxes 
and clicking radio buttons. Then click the submit button to email your  
finished form.
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First Principles
There is an insanely intense internal tension in ebook design: how do you design knowing 
that your end user is going to change everything – the font, the leading, the type size, the 
background, even whether or not the text is justi� ed. This is truly one of main advantages 
of ebooks. They are a kind of blank slate waiting for the reader to layer their needs on top 
of the bare structure. 

This means that ebooks are ready for the readers to layer their needs on top of the 
ebook. So a Dyslexic reader can use a font that makes comprehension a little easier. And a 
print-disabled reader can convert the HTML to Braille output, or have a screenreader voice 
the text. I know I am repeating myself here, but truly this is one of the key a� ordances of 
ebooks: they are what the reader needs them to be.

And while I have long proselytized that a good ebook is one that is well-coded and ready 
for the user’s preferences to be layered on top of that solid framework, I am excited to bring this message as well: ebooks 
can be a thing of beauty, too.

Ebook Design Is Not an Oxymoron
Laura Brady
Manager, Cross-Media, House of Anansi Press
laura@bradytypesetting.com | lbrady@anansi.ca
Twitter: @LauraB7

This is one of the 
key affordances 
of ebooks: they 
are what the 
reader needs 
them to be.
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Fonts

“I personally use wingdings. Reading speed 
has  skyrocketed... Comprehension took a hit 
tho.”

—From a reddit thread on the best fonts for ereaders 

This section can be summed up very easily: use fonts that are designed for 
screens. These are generally fonts that have higher x-heights, slightly more 
weight, and are designed to be elastic on the wide variety of screen sizes 
and resolutions in the wild. 

Fonts that are hinted are ready for use on screens. Font hinting (also known 
as instructing) is the use of mathematical instructions to adjust the display of an 
outline font so that it lines up with a rasterized grid. At low screen resolutions, 
hinting is critical for producing clear, legible text. See also: http://alistapart.
com/column/font-hinting-and-the-future-of-responsive-typography

If you need inspiration, consider watching Monotype’s Steve Matteson 
giving a talk on type for screens at ebookcraft a few years ago (link in the 
resources section). 

Opposite: A few examples of hinted type
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Interoperability
In order to ensure that your ebooks work across 
the device spectrum, I advise keeping the styling 
as simple as possible. You can pull o�  some pretty 
cool tricks in some readings systems, that will fall 
utterly � at in other rendering environments. Or 
might even break completely. 

And as the goal of most ebook development 
work� ows is to produce one EPUB � le that works 
everywhere, including conversion to Kindle for-
mats, bearing interoperability in mind is espe-
cially key. The work of a few key people has taken 
all the mystery out of this process. The Blitz CSS 
framework, authored by Jiminy Panoz, is a base 
CSS whose core principles are to work with and 
through the defaults of various reading systems. 
Jiminy’s goal is the same as mine today: to help 
you make more typographically sound ebooks. 

The Blitz CSS that Jiminy developed and 
rigorously tested is available on GitHub under a 
Creative Commons license. He has very helpfully 
created both commented and un-commented 
versions of the CSS so that you can see the 
thought processes behind the code. Jiminy 
wholeheartedly believes that this CSS will help in 
“� nding simple solutions to complex issues.”

One possible approach to ebook CSS is to crib 
from this set of stylesheets. Ebook developers 
could swap in the Blitz CSS instead of letting 
InDesign create it’s (horrorshow) CSS. You would 

have to map your style sheets to the class names 
in this CSS, but that should be a manageable task. 

My mother’s ereader at the settings she enjoys.

User Controls
One of the foundational principles of ebooks is 
that they are � exible and ready for the reader to 
personalize in ways that the developer couldn’t 
anticipate. The idea is that it is not up to the peo-
ple who make ebooks to dictate how consumers 
read them. So if your audience wants 30-point 
type on a loose line height and fully justi� ed with 

gaping holes on the page/screen, then that’s 
their right. They change the fonts, manipulate the 
layout, fuss with the justi� cation until the reading 
experience suits them, potentially in ways that 
make designers gasp in horror (see my mother’s 
Kobo, left).

Since it’s technically illegal – and a little creepy 
– to follow all your ebooks home to explain how 
to read them, it’s in both yours and your readers 
best interests to design well, simply, cleanly and 
release your ebooks into the world. 

To that end, I have adapted the stated goals of 
the Blitz framework for our purposes here. The 
CSS in your ebooks should aim to:

1. Be simple and robust

2. O� er a sensible default

3. Don’t disable user settings.
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Responsive Design
Because you can not only not exert any control 
over how your ebooks are read, nether can you 
control the sceen size that they are rendered on. 
The nature of re� owable ebooks is, well, that they 
re� ow. 

The essentials of responsive design in an ebook 
context are:

1. Use percentages or ems wherever possible. 
Avoid hard pixel sizing de� nitions. This 
applies to fonts, margins, indents, image 
sizing. 

2. Relative is always better than static. If an 
image is de� ned as 80% of the width of a 

screen, it will be 80% of the screen width, no 
matter the size of the screen. 

3. Understand the CASCADING part of 
 Cascading Style Sheets and leverage it. Build 
on it. 

Some CSS Tricks
So it is now time to check your ebook design 
nihilism at the door and dig in deep with some 
ebooks tips and tricks. 

In the following pages I show some screen-
shots of ebooks on device with a corresponding 
snippet of CSS. As every good ebook developer 
knows, the intent here is to share, collaborate and 
“borrow” code from here, or from the Blitz frame-
work. (It’s not stealing if I say it’s okay, right?)

With the rise of mobile devices and now tablets, we have 
to give up this shared hallucination that we have all been  
 operating under, that we have any control over the presen-
tation. That we have any control over the size of somebody’s 
screen or the layout that they have or the input mechanism 
that they’re going to be using. That’s gone. And it’s not 
coming back. – KAREN McGRANE
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From Confessions of a Bone Woman by 
Lucinda Bakken White. Published by Wild 
Woman Books
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This website is your new best friend:
https://friendsofepub.github.io/eBook-
Tricks/

Make an image responsive to its 
caption’s font-size
@supports (height: calc(98vh - 5em)) {
  img {
    width: auto;
    max-width: 100%;
    min-height: 300px;
    height: calc(98vh - 5em);
    max-height: 95%;
    object-fi t: contain;
  }
}

For images with a portrait aspect ratio, you 
must go the extra mile so that the image 
and (part of ) its caption are displayed on the 
same page.

This is where the CSS calc() function really 
shines. It allows you to dynamically compute 
the height of an image depending on the 
current font-size.

In this example, the image’s height should 
ideally be 98% of the page minus 3 lines 
of text (with a line-height of 1.5). Finally, 
min- and max-height provide a range for the 
image sizing.

Keep an image with its caption
fi gure {
  page-break-inside: avoid;
  break-inside: avoid;
}

@supports not ((page-break-inside: avoid) 
and (break-inside: avoid)) {
  fi gure {
    -webkit-column-break-inside: avoid;
  }
}

Readability is as important as legibility and 
this is why you should take care of the rela-
tionship between elements.

For best comprehension, the image and its 
caption should be displayed on the same 
page so let’s avoid a page-break inside � g-
ures.

Vertically-align elements on a 
page
@supports (display: -webkit-fl ex) or (dis-
play: fl ex) {
  parent {
    min-height: 95vh;
    display: -webkit-fl ex;
    display: fl ex;
    -webkit-fl ex-direction: column;
    fl ex-direction: column;
    -webkit-justify-content: {value};
    justify-content: {value};
  }
}

Pages of an eBook don’t have a middle or a bot-
tom, right? With � exbox, they now do.

Make sure to use the min-height property so 
that the container’s height can grow in case the 
user sets a huge font-size… or else contents will 
collapse.

Prevent sub- and superscript 
from a� ecting line-height
sub {
  font-size: 0.675em;
  line-height: 1.2;
  vertical-align: sub;
  vertical-align: -20%;
}

sup {
  font-size: 0.675em;
  line-height: 1.2;
  vertical-align: super;
  vertical-align: 35%;
}

Sub- and superscript will a� ect line-height 
if you just use their dedicated keyword for 
vertical-align.

By decreasing line-height to the minimum value 
Kindle supports (i.e. 1.2) and using % for vertical-
align, we solve this problem and can vertically-
align sub- and superscript more accurately.
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Resources
“Readium CSS Alpha” by Jiminy Panoz, one of the Readium developers. 
http://epubsecrets.com/readiumcss-alpha-is-available.php

“What Bookerly and Literata Get Wrong” by noted typeface designer, 
Charles Nix.  
http://web.archive.org/web/20170924220200/
http://www.digitalbookworld.com/2015/
fonts-and-nonsense-what-bookerly-and-literata-get-wrong/

“Jiminy and Dave’s Excellent CSS Adventure” from ebookcraft 2018.
https://www.youtube.com/watch?v=Vx910LCYgm8
And their slidedeck from this talk:
https://www.slideshare.net/booknetcanada/jiminy-and-daves-excel-
lent-css-adventure-jiminy-panoz-dave-cramer-ebookcraft-2018

Jiminy Panoz’s Blitz CSS
https://github.com/FriendsOfEpub/Blitz

“Tom Gauld on ebook intelligence – cartoon”
https://www.theguardian.com/books/picture/2018/mar/05/
tom-gauld-on-ebook-intelligence-cartoon?CMP=share_btn_fb

“Silicon Valley Won’t Save Books”
https://newrepublic.com/article/146430/silicon-valley-wont-
save-books?utm_source=social&utm_medium=facebook&utm_
campaign=sharebtn

Rachel Andrew’s CSS in Ebooks SlideShare is chock full of useful things
https://www.slideshare.net/rachelandrew/css-for-ebooks

“Which Font Should I Use On My Kindle?”
https://www.fastcodesign.com/3061940/
which-font-should-i-use-on-my-kindle

Blitz Ebook CSS Tricks
https://friendsofepub.github.io/eBookTricks/

“Going from Print to Ebook: Next Steps”
https://indesignsecrets.com/going-from-print-ebook-next-steps.php

“Type 3.0: The Future of Typography Today” 
Steve Matteson at ebookcraft 2015
https://www.youtube.com/watch?v=TY-XmJv9u2M

Amazon Kindle Publishing Guidelines
https://kindlegen.s3.amazonaws.com/AmazonKindlePublishingGuide-
lines.pdf

Responsive Ebook Design: A Primer” by Sanders Klein� eld
https://medium.com/@sandersk/
responsive-ebook-design-a-primer-8bba01328219

Responsive Web Design by Ethan Marcotte
https://abookapart.com/products/responsive-web-design
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Setting the Record Straight on Workflow Concepts & Misconceptions
Now that we have gotten your attention, prepare yourself for some seriously good, “real world” print advice you can take 
home and use today. In this session we’ll dispel the many myths you’ll encounter in prepress and print situations, including 
such all-time favorites such as:

• You should just convert all your text to outlines

• You should just choose “Press Quality” when you make a PDF and everything will be fine

• You should always make a PDF with crop and bleed marks

• You should convert everything to CMYK first

And of course, remembering that “font” is a four letter word beginning with an ‘f’, we will certainly attack the usual 
type (pun intended) of myths, legends, bubbe meises, and downright lies associated with use and misuse of fonts.

Agenda
• A quick review of the Reliable PDF Guiding Principles

• A generous sample of “lies your printer has told you” including what your printer / PSP tells you as well as the truth

• A brief analysis of some of the root causes and issues behind these “lies”

• Q&A – Almost anything is game – this is your chance to enter the fray!

Lies Your Printer Has Told You
Dov Isaacs
Adobe Systems Incorporated
isaacs@adobe.com
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Handouts
There is way too much that will be presented in the presentation to  
do any justice by trying to condense 30 slides onto a few pages here.

The slides will be available for you (print-ready fully color-managed 
PDF/X-4 file with live transparency – no copies of PowerPoint were  
were even touched in preparation of the slides) concurrent with  
the presentation session.

But to pique your curiosity, one “interesting” figure from the 
presentation slides is presented here. The quick 

brown fox …

40 pt Text 
Rendered with Font 
– Live 1:1 Rendition

Text Rendering with Fonts versus Text Outlining
Examples use Garamond Premier Pro Italic

The quick 
brown fox …4 pt Text 

Rendered with Font 
– Live 1:1 Rendition
& RIPed @ 600 dpi
(1000% magnification)

4 pt Text 
Outlined Text 
– Live 1:1 Rendition
& RIPed @ 600 dpi
(1000% magnification)
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The Major Points
• HTML is a versatile format.

• Many different apps can produce HTML.

• HTML can be relatively inexpensive to produce.

HTML Can Live Almost Anywhere
These are all examples of formats that are (or can be) HTML under-the-hood.

• EPUBs

• Presentations

• Mobile Apps

• Kiosks

• Digital Signage

• Desktop Apps

• Interactive Sales Aids

• E-Learning

Also, just because your HTML lives on the web doesn’t mean that it has to look like a website. It could look like...

• Evites

• Digital Magazines

• Interactive Brochures

• Virtual Tours

• Digital White Papers

• Prospectuses

• Scholarly Journals

• Annual Reports

...And the above are by no means exhaustive lists.
The thing to remember is that HTML is an information container that can be styled with sophisticated layouts and can 

include high levels of interactivity. Once your content is in HTML, it can go almost anywhere.

HTML Beyond Web Sites
Digital Magazines, Presentations, And Mobile Apps

Justin Putney
ajarproductions.com
justin@ajarproductions.com
@justinputney
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Visual tools that can create HTML
You don’t have to code to create HTML. In fact, quite the contrary.

Web Design Tools
These tools definitely have some advantages over hand coding. I left tools of 
the list that didn’t make it easy to download the HTML and repurpose it (e.g., 
hosted options like Wix and Adobe Spark).

• Adobe Dreamweaver

• Adobe Muse (no longer being updated)

• Webflow - webflow.com

HTML animation tools
• Adobe Animate

• Tumult Hype - tumult.com/hype

• Google Web Designer - google.com/webdesigner

Page Layout Tools
Even though these started as print tools, there are digital options.

• Adobe InDesign (via Publish Online [can’t repurpose], EPUB, Keith Gil-
bert’s script - bit.ly/kg-script, or in5 - in5.ajar.pro)

• QuarkXPress

UX Prototyping
Since HTML is functional, it’s great for prototypes in showing clients (or 
developers) how your design should work.

• Sketch - sketchapp.com

• Adobe XD (no HTML export, currently)

• Adobe InDesign - UX Resources: bit.ly/1NSUJCE

E-Learning Tools
E-learning is a great place to find sophisticated, interactive HTML that 
doesn’t look like a website.

• Adobe Captivate

• Articulate

• iSpring

• Brainshark

There are tons more. See a big list at bit.ly/elearnHTML.

EPUB tools
Lots of these out there. Here’s a sample.

• Adobe InDesign

• QuarkXPress

• PubCoder

• CircularFLO
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Presentation Tools
HTML can be used for presentations of all types (see more about this a cou-
ple pages down in the “Reader tools” section, also see “E-learning” above).

• Google Slides - Both the tool and the presentation are HTML.

• Adobe InDesign (using Publish Online or in5)

• Prezi - prezi.com

• Impress.js - impress.js.org

• Reveal.js - revealjs.com

HTML content creation tools
HTML is extremely well developed in certain respects. It goes far build the 
language itself. When thinking about the power of HTML, it’s important 
to look at the platforms built around HTML. You can leverage these for 
projects.

Content Management Systems (CMS)
Content Management Systems (CMS) like Wordpress can be used for all 
types of digital content, not just blogs. At its core, a CMS splits up jobs. Here 
are 3 basic jobs that a CMS can split up.

1. Design

2. Function

3. Content

The design is usually handled by a template which you can create or pur-
chase. The function is the underlying programming in the template and 
the CMS itself. The content is easily entered into an editing area inside the 

admin section of the site.
The CMS has basic units like “articles,” but they don’t have to be literal 

articles, they could be products, or levels, or anything else you can imagine.
Mobile apps can be 100% driven from a Wordpress installation, for 

example.
Here are the big 3 CMS tools, but there are tons more.

• WordPress

• Joomla

• Drupal

Wordpress in particular has a phenomal ecosystem built around it.
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Reader tools to put HTML in various places
There are so many things you can do with HTML. Here’s a list of tools that will 
take your HTML to new places by reading in your HTML into some kind of 
shell.

Kiosks
Turn your computer or tablet into a Kiosk for tradeshows, museum displays, 
and retail stores.

• Kiosk Pro - kioskproapp.com

• SureFox - 42gears.com/products/surefox-secure-browser

• SiteKiosk - provisio.com/web/us/products/
windows-kiosk-software-sitekiosk

• Kiosk - github.com/cook-company/kiosk

• Offline Kiosk - codiumlabs.com/ios/offline-kiosk

• Chrome Kiosk App - support.google.com/chrome/a/answer/3316168

Sales Enablement
“Sales Enablement” is a fancy, unclear name for getting content design and 
marketing materials to sales people, often offline on tablets for onsite sales 
visits.

• ShowPad - showpad.com

• Vablet - vablet.com

• Mobile Locker - mobilelocker.com

• Accent - accent-technologies.com/accent-mobile

• iPresent - ipresent.com

Mobile Apps
No reason to learn Objective-C for iOS and Java for Android, etc. HTML will 
do the trick with the help of a service that can wrap your HTML inside a 
mobile app shell.

• PhoneGap Build - build.phonegap.com

• Baker Framework - bakerframework.com

• Framework7 - framework7.io

Web Apps
In some cases, you don’t even need the wrapper. A simple meta tag in your 
HTML is enough to create app experience.

• Using InDesign and in5 - bit.ly/1PDr5iJ

• Video tutorial on manually creating an iPad Web App - bit.ly/cc-webapp

Desktop Apps
Yes, desktop apps, too!

• WebDGap - michaelsboost.tk/WebDGap

• Applicationize - applicationize.me

• Electron - electronjs.org

• HTMLCompiler (Windows) - davidesperalta.com/htmlcompiler

Self-Extracting Package
What about an executible that opens itself and runs the HTML inside?

• Windows - bit.ly/selfextract

• Mac - You can attach content to an AppleScript app, but it’s more com-
plex. Email me (justin@ajarproductions.com) if you’re really interested 
in this.
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Digital Magazines
In most cases, you won’t need an extra reader tool for a digital magazine or 
e-book. Your target format will determine what is used to view your con-
tent. For example, raw HTML will be read through a web browser, a mobile 
will be downloaded and opened directly, and an EPUB will be opened by an 
EPUB reader.

Presentations
Presentations can live in a wide variety of enviroments. From the browser, to 
a mobile app (and don’t forget about Web Apps). 
See “Kiosks” and “Sales Enablement” above for more options.

Additional Resources
Check out the Digital Publishing Guide for more on choosing a digital 
format.

• ajar.pro/techguide

More questions?
It’s no doubt that I’ve forgotten something. If you have other questions feel 
free to email me (justin@ajarproductions.com).
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What are your goals?
One thing that I have come to realize over the past few years is that, as eBook producers, we often do not have the same 
goals for our final files.

• Some of us prioritize the visual capabilities of ePub, especially when viewed on the iPad’s Retina display

• While some of us will prioritize the Kindle format, because of it’s sheer popularity

• Some of us build our eBook files from scratch

• Some of us build our eBook files using InDesign

• And some of us use Microsoft Word to generate our eBook files

Here is my angle
My personal approach to eBook production is to use a single-source workflow (whenever possible) and to produce a final 
eBook product that will look good and WORK in most (if not all) of the many available readers.

With this approach, it is important to keep the eBook markup and CSS as simple (and clean) as possible. I try to avoid 
design elements that only work in iBooks but not in other ePub readers or Kindle (and vice-versa). The main goal here is to 
avoid the need for multiple workflows and multiple eBook files that are optimized specifically for individual devices. In my 
opinion, that completely defeats the idea of the reflowable digital book file.

ESSENTIAL EPUB CLEANUP STEPS
Thursday, June 7 (2:15 PM - 3:00 PM)

Ron Bilodeau
www.oreilly.com
ron@oreilly.com
ron.bilodeau@gmail.com
@biladew on Twitter
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Here is what I hope to cover
• A few InDesign-specific tricks for better ePub output

• Image size

• Image format

• The difference between photos and vector-based images

• Embedding fonts: should you? And if so, when?

• Common markup and CSS tweaks 

• Using Find/Replace or GREP to make fixing things way easier

• Other issues that may come up 

Things that will not be covered (sorry)
• Fixed Layout eBooks

• Embedded audio

• Embedded video

Due to the lack of global support in these specific areas, it has been my 
philosophy to avoid them. And because of that, I have little to no experience 
dealing with them.

What will/won’t be covered in the session
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Support for HTML 5 and CSS 3
Though ePub 3 supports HTML 5 and CSS 3, you need to be careful about 
general device support. 

I have found that there are still many devices that do not recognize the 
newer HTML 5-specific tags (ie. <section> or <figure>). In order to maintain 
global support, it is much safer to use the <div> tag with specific classes.

CSS support is far better, but with the same limitation. Many devices still 
do not support some common pseudo-selectors (ie. :before or :first-of-type).

Differences between ePub 2 and ePub 3

Sample NCX content (ePub 2) Sample NAV content (ePub 3)

For a detailed list of changes, see http://www.idpf.org/epub/30/spec/
epub30-changes.html.

It is important to remember that even though ePub 3 offers many more 
options, we are still limited by the constraints of the available eBook read-
ing devices and apps. So, depending on what your target audience is using to 
consume your digital books, you want to make sure that your included content 
is supported.

Here are some of the more important changes that I feel affect us the 
most:

Navigation
ePub 2 used the NCX file to drive device naviga-
tion. ePub 3 brought along the more elegant and 
readable NAV element (toc.xhtml).  Anyone familiar 
with HTML/XHTML will immediately recognize the 
markup as a nested list.

Note
I highly recommend including the NCX in your ePub 3 
files. There are still many older devices out there that 
do not support ePub 3 yet. Without the NCX, these 
older devices will not be able to offer navigation. It is a 
nice fall-back to have in place.
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Differences between ePub 2 and ePub 3 (continued)

Scripting Support
Including scripts is a great way to get more out of your ePub file, especially 
when reading via iBooks or other readers with support for scripting. The 
trick here is to make sure that the reader does not miss out on anything 
important if consuming the eBook via a device that does not support 
scripting.

Better Support for Audio/Video
ePub 3 includes support for HTML 5 Audio and Video elements.

Some supported audio formats include:

• MP3 • MP4 • AAC

As for video formats, the IDPF does not directly endorse any specific format 
or codec, but recommends using either of these codecs:

• H.264 • VP8

However, as I keep mentioning, if the chosen device does not support 
embedded audio or video then that content will simply be ignored.

With that said, it is always a good idea to include a fall-back message to let 
readers know that there is supposed to be something there. 

Video tag markup including fallback message

Video being properly rendered in iBooks

Missing video with fallback message in Adobe Digital Editions
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Some Find/Replace & GREP examples
Here are a couple of examples of ePub fixes, accomplished by using the 
Find/Replace and/or GREP function. Most text-based editing apps will offer 
at least Find/Change or Find/Replace. Some of the more basic programs 
may not offer a GREP option, but it is becoming more common. 

If you are looking for a FREE option, TextWrangler is a good one that 
includes GREP. See the last page of this handout for more info and link.

For the purposes of my examples, I will be using <oXygen/> XML Author.

Removing empty links
This example is from and InDesign-generated ePub that has lots of page 
ranges included as part of the Index (ie. 2-5, 77-78). When InDesign creates 
the ePub file, it correctly creates links for the first number in each range, but 
then it leaves an <a> tag with an empty href on the second number. 

Using Oxygen’s Find/Replace option, remove the empty <a> tags from the 
index

1. Open the index file inside Oxygen

2. Go to Edit --> Find/Replace

• Text to find: (<a href=””>)(\d+)(</a>)

• Replace with: \2

• Make sure that Regular expression is checked

3. Select Replace All

4. Close and save the index file

Even though this is an InDesign-specific example, you can apply this kind of 
GREP search to anything that helps you with your particular ePub issue. 

Remove unnecessary <span> tags
<p>I need to remove these <span class=”char-style-answer-

text”>unneeded span tags</span></p>

Text to find: (\<span class=”char-style-answer-text”\>)(.[̂ \<]+)

(\<\/span\>)

Replace with: \2

Format unformatted fractions (cookbooks)
This is an issue that I dealt with over the course of converting many cook-
books. The fraction glyphs for 1/2, 1/4, and 3/4 are safe to use in ePubs. But 
there is very little support for the rest of them (ie. 1/8, 3/5, etc.)

<p>My recipe requires 1/4 stick of butter and 1/8 of a 

whole chicken</p>

Change 1/4 to ¼:
Text to find: 1/4
Replace with: ¼

Add this to your CSS:
sup, sub {
    font-size: 0.6em;
    height: 0;
    line-height: 1;
    position: relative;
}
sub { vertical-align: baseline }

sup { vertical-align: text-top }

Fractions for 1/2 and 3/4 can be fixed the same as the 1/4 example. All 
other fraction variations can be fixed using the 1/8 example, along with the 
accompanying CSS.

Change 1/8 to 1⁄8:
Text to find: 1/8
Replace with: <sup>1</sup>⁄<sub>8</sub>
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Embedded fonts
The use of specific fonts can add a lot to the overall look and feel of a well-
designed ePub file. However, due to the lack of support for embedded 
fonts, I recommend avoiding this, with the following exceptions:

• Rare/Uncommon GLYPHs
If your eBook is about Math or Unicode characters, then there is a good 
chance that the default fonts, available on the various ePub readers, 
will not support the extensive glyph sets necessary to display all of your 
content. In this case, it is a good idea to include a font that contains 
these glyph sets. Readers that support embedded fonts will revert to 
that when looking for the special glyphs (as long as it is set up correctly 
in the manifest and CSS).

However, with readers that do not support embedded fonts, this will 
not be helpful.

• Branding Tie-Ins
If there is a special font that is directly related to the branding of your 
book or product, then it is not a bad idea to include that. However, you 
first need to make sure that you are legally allowed to include the font 
in your eBook. Then, the font must be in a format that makes it possible 
to embed (OTF or TTF).

With that criteria met, I recommend applying this special font only to 
titles (and possibly headers).

In addition to the current font-limitations in many eBook reading devices, 
there is also the legal aspect of the fonts that you may want to embed. 
Many font creators/distributors will charge an extra fee (on top of the origi-
nal use fee) in order to include the font in an eBook. And then you need to 
be sure to follow the necessary steps to properly encrypt and/or obfuscate 
the font in order to be compliant with their policies (See Font Embedding/
Obfuscating for more information). 

NOTE
It is important to note that, even if your ePub is being read on a device that 
supports your embedded fonts, the user has the ultimate control to change that 
font at any time, if they so desire.

Use FREE fonts
There are tons of free/open-source web fonts that can be used instead of 
expensive licensed fonts. Thus eliminating the need for special handling, 
such as encryption, mangling or obfuscation. 

Here are some sources:

• Font Squirrel

• Google Fonts

• Adobe Edge Web Fonts

Use fallbacks
Whether you are calling on an embedded or device font, by name, in your 
ePub CSS, it is very important to include generic fallback information. This 
will, at the very least, attempt to force the device to acknowledge the basic 
font-face that you would like used in certain places:

h1 { font-family: “Minion-Pro-Bold”, Georgia, serif }

The example CSS (above) will attempt to do the following:

1. Look for and display the embedded font “Minion Pro Bold”.  
If not, then . . .

2. It will attempt to find and display the device font “Georgia” (one of the 
default iBooks fonts). If not, then . . . 

3. It will display the “h1” using the device’s default serif font
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Write your own CSS
Whenever possible, I recommend writing your 
own custom CSS for your ePubs. 

Programs, such as InDesign, do a very good 
job at “attempting” to write good CSS and 
HTML when exporting ePub files, but, due to 
the “translation” issues between the print and 
digital worlds, many things get missed or misin-
terpreted. This is why ePub files that are gener-
ated this way tend to have bloated HTML and 
CSS code that is littered with confusing and often 
unnecessary tags.

Note
For the record, I think that the InDesign engineers at 
Adobe have done an absolutely amazing job with 
how far they have come with ePub export. The CSS 
part of the equation is an extremely difficult chal-
lenge to overcome. 

As good as the InDesign ePub CSS has become, if 
you know how to write your own, you will be hap-
pier and much better off in the long run.

With that said, if you are using InDesign to build 
your ePub file, and you are happy with the output 
(requiring little or no editing after the fact), then 
go with it. If it validates and you are happy with 
it, then there is no reason to over think it.

Us control freaks will continue to write our own 
stylesheets, because that’s how we roll!!

Start your CSS with a reset
Many eBook reading devices have their own 
default display settings, which can sometimes 
mess with your styles. Though it will not solve 
every issue on every device, it is good practice to 
include a “reset” at the beginning of your ePub 
CSS.

Here is what the reset looks like in our O’Reilly 
ePub files:

/* reset */

html, body, div, span, applet, object, 

iframe, h1, h2, h3, h4, h5, h6, p, 

blockquote, pre, a, abbr, acronym, 

address, big, cite, code, del, dfn, 

em, font, img, ins, kbd, q, s, samp, 

small, strike, strong, sub, sup, tt, 

var, b, u, i, center, dl, dt, dd, ol, 

ul, li, fieldset, form, label, legend, 

table, caption, tbody, tfoot, thead, 

tr, th, td { 

  margin: 0;

  padding: 0;

  border: 0;

  outline: 0;

  font-size: 100%;

  vertical-align: baseline;

  background: transparent;

}

/* end reset */

Include CSS comments
This is one of the simplest and best ways to make 
sure that your CSS is easy to understand and edit. 
Not only for you, but for anyone who may need 
to make edits or updates to the file at a later time.

In order to comment your CSS, simply surround 
your comments with these: “/*” and “*/”

If you look above, you can see that comments 
are used to indicate where the “reset” CSS begins 
and ends.

Other examples:
code.number { color: rgb(165,42,42) } 

/* brown */

You can also “comment out” pieces of CSS that 
you need to remove now, but may have to put 
back in later. See the example below, where the 
“margin” attribute is being “commented out”.

img {

  max-width: 95%;

  /*margin: 0 auto;*/

  padding: 0;

}
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Organize your CSS for 
easier navigation
The better you organize your CSS, the easier it is 
to find things.

Here are 2 examples of the same CSS snippets. 
You tell me which one is easier to follow?

1

div.chapter>h1,div.preface>h1,div.
appendix>h1{font-size:1.5em;line-
height:1;margin-bottom:15px;padding-
bottom:10px;border-bottom: 1px solid 
#000}

2
div.chapter > h1,
div.preface > h1,
div.appendix > h1 {
   font-size: 1.5em;
   line-height: 1;
   margin-bottom: 15px;
   padding-bottom: 10px;
   border-bottom: 1px solid #000
}

Both of the above examples contain the exact 
same information and are both completely valid. 
However, #1 is almost impossible to read with the 
naked eye, while #2 is relatively easy to follow.

 
Some things to avoid using in ePub

• Forced Caps 
The CSS property “text-transform” has 
some support, but it is not very good. If it is 
important for elements of your ePub to be 
displayed as “uppercase”, then I recommend 
changing those elements to “true” all-caps.

• Empty Paragraphs 
Some people like to use empty paragraphs 
to create spacing in their manuscripts. When 
converting to ePub, this can often create 
empty <p></p> tags. Some devices will 
honor the extra space, while others will not. 
You are better off removing any empty tags 
in your ePub HTML, and using margin top/
bottom to control spacing above/below.

• Forced Line Breaks 
Due to the flexible nature of ePub, these can/
will be problematic. I recommend removing 
any and all instances of forced line breaks in 
your ePub file. Let the text flow naturally.

• Justified Text 
Because the text size and font face can be 
changed at any moment, it is not a good 
idea to use justified text. You can very eas-
ily end up with odd and inconsistent spac-
ing between words, which can make it 
very difficult to read. Left-aligned is what I 
recommend.

• DRM (Digital Rights Management) 
I get why you may want to, but here is the 
reality: It is quite easy to bypass/remove DRM 
from ePub files. Also, I have found that it sim-
ply turns people off and often causes them to 
look around for a non-DRM alternative. 
If it wasn’t so easily hacked, I may feel differ-
ently about it, but that just is not the case.

• Large file sizes 
There is a content/file-size limit of 300kb. I 
also recommend that none of your image 
files exceed 1000px height or width.

• Embedded fonts 
Unless it is absolutely necessary to include 
some specific fonts, I would recommend 
avoiding it. Support is still lacking for embed-
ded fonts, currently. And even devices that do 
support this, ultimately leave it up to the user 
to decide whether to use the embedded font 
or one of the reading device’s default fonts.
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Resources

<oXygen/> XML Author
This is my favorite tool for editing ePub files. It allows you to edit without 
having to crack the file open first. It has a nice interface and even includes 
ePub validation: 
http://www.oxygenxml.com/

TextWrangler
TextWrangler is the “baby brother” to BBEdit. This is a very good FREE 
option if you just don’t have the money to spend on another app : 
http://www.barebones.com/products/textwrangler/

eCanCrusher
For those of you that prefer not to pay for a program like <oXygen/>, this is a 
wonderful and FREE tool that will unzip/zip your ePub file for you: 
https://www.rorohiko.com/wordpress/2013/10/08/
ecancrusher-dragdrop-conversion-of-folder-to-epub-and-vice-versa/

GREP resources
This is a great list of GREP resources, courtesy of indesignsecrets.com: 
http://indesignsecrets.com/grep

ePub 3 Best Practices
This concise guide includes best practices and advice to help you navigate 
the format’s wide range of technologies and functionality.
http://shop.oreilly.com/product/0636920024897.do

IDPF
Trade and standards organization for the Digital Publishing Industry: 
http://idpf.org/

Changes from ePub 2 to ePub 3: 
http://www.idpf.org/epub/30/spec/epub30-changes.html

Online ePub Validator: 
http://validator.idpf.org

W3schools.com
I use this link all the time as a CSS selector reference: 
http://www.w3schools.com/cssref/css_selectors.asp

#eprdctn group on Twitter
This is a wonderful community of eBook producers. If you have any interest 
in eBooks at all, you need to follow this group: 
https://twitter.com/hashtag/eprdctn?src=hash

KindleGen and Kindle Previewer
KindleGen is a command line tool which enables publishers to work in an 
automated environment with a variety of source content including HTML, 
XHTML or ePub.

Kindle Previewer is a tool that emulates how books display on Kindle 
devices and applications. This tool also has KindleGen built-in, which allows 
you to drag/drop your HTML, ePub or OPF files in order to instantly convert 
them to Mobi Kindle eBooks.
http://www.amazon.com/gp/feature.html?docId=1000234621
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The path to ISO-standardized PDF

 June 1993 – 25 years since Adobe PDF 1.0

 July 2008 – 10 years since ISO 32000-1

 Since 2008 - 2 ISO drafts / year for review

 ISO 32000-2 (PDF 2.0) – published 2017-07

 Updated subset standards coming soon… 
(PDF/A-4, PDF/X-6, PDF/UA-2)

PDF/VT

PDF/X PDF/E PDF/A PDF/UA

ISO 32000 - Core PDF Standards
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PDF Standards
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dfa.org

PDF Reference Date Pages Random Facts

Adobe PDF 1.0 June 1993 230 43 tables, 42 figures

Adobe PDF 1.1 23 January 1996 302 20 references

Adobe PDF 1.2 12 November 1996 394 137 tables, 86 examples

Adobe PDF 1.3 July 2000 696 223 tables, 73 figures

Adobe PDF 1.4 December 2001 978 277 tables, 20 colour plates

Adobe PDF 1.5 August 2003 1172 333 tables, 70 figures

Adobe PDF 1.6 November 2004 1236 370 tables, 80 figures

Adobe PDF 1.7 October 2006 1310 389 tables, 98 figures

ISO 32000-1:2008 (PDF 1.7) 1 July 2008 756 (A4) 78 Normative References

ISO 32000-2:2017 (PDF 2.0) July 2017 984 (A4) 5836 “shall”, 411 “should”

Some statistics
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What hasn’t changed

 The key value proposition of PDF

 Reliable, portable, fixed layout, self-contained, deterministic appearance, author 
control, …

 Wide range of use cases & applications

 Open & closed workflows

 The technical fundamentals of PDF

 File structure

 Syntax & grammar

 Many, many things…

PDF 2.0 is an evolution, not a revolution!
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PDF 2.0 — ISO 32000-2

 Goals for PDF 2.0

 Enhance

 Refine

 Deprecate

 Standardize

 Democratize PDF

 Industry experts

 Committee owned

 Active process
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PDF 2.0 — Enhance

 Enhancing PDF

 Printing and Graphic Arts

 Engineering

 Tagged PDF 2.0

 Document Parts (DPart), Associated Files

 Long Term Signature Validation

 Document Requirements, Barcodes

 And more…
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Advancing the state of the art

 XMP Metadata only

 UTF-8 support

 Stronger alignment with other data formats such as XML

 Avoid processing problems

 File IDs now required

 Length (/L) required for inline images

 Consistency of appearance

 Clarification of resource inheritance 

 Handling of dashing & degenerate lines

 Required appearance streams (/AP) for annotations

 Better user experience

 Thumbnails for embedded files, Enforced print scaling, Collection navigation
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Metadata (XMP)

 XMP = eXtensible Metadata Platform

 XML-based metadata commonly used across many file formats  Many systems know 
how to understand & index

 ISO 16684-1:2012 Graphic technology - Extensible  metadata platform (XMP) 
specification - Part 1: Data model,  serialization and core properties

 XMP Metadata is now a “first class” requirement of PDF 2.0  

 Fully aligned with all ISO subset standards

 Can also attach XMP Metadata to any PDF object  

 Can encrypt metadata with AES 256 bit

 The original “DocInfo” metadata model is deprecated

Enables easier, richer search & indexing
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Print & Graphic Arts improvements

 Page-level Output Intents

 BlackPointCompensation as a graphic state attribute

 Halftone Origin

 Ink Attributes

 Ink laydown order

 CxF as Ink metadata (aka Spectral Data)

 Overprint Simulation – “how to”
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All 
New
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Transparency Changes

 Consistent inheritance model for blending spaces

 More direction on some color conversion considerations

 ie. When to use ICC and when to use “Red Book”

 Removal of “Overprint Compatibility” mode

 Clean up the text in a few places to clarify
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Improvements



© 2018 Adobe Systems Incorporated.  All Rights Reserved. 

Annotations

 Transparency & Blend Mode attributes

 Stamp Intent

 Real paths for Polygon & PolyLine

 Improvements to Field Tab Order
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All 
New
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Structure and Tagging

 New (simplified) set of “Standard Tag Set”

 New extension system (namespaces) for other tags

 Structured Destinations

 Pronunciation Hints

 New attributes owners (HTML, CSS, aria)

 Misc. changes

 PageNum & BatesNum artifacts

 New list types

 Table header “short name”
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All 
New

Tagged PDF in PDF 2.0 is much cleaner (fewer tags),  much clearer (better descriptions of 
tags, clear  indication where they can/cannot be used) and more  flexible / open ended 
(restrictions exist only where  necessary).
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Associated Files (AF)

 Associated Files provide a 

 “… means to associate content in other formats with selected objects of a PDF file and 
to identify  the relationship between them.”

 Object can be anything: PDF document, page, graphics object, a  structure 
element, annotation, …

 AFRelationship describes the semantic relationship

 e.g. Source, Data, Alternative, Supplement, FormData, Schema

 Enables new capabilities via semantic relationships between  PDF objects and 
other arbitrary data

 attach MathML to equation graphics

 attach spreadsheet or raw data to chart graphics  

 attach business XML to an electronic invoice

Almost 
New
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Engineering

 Support for PRC (ISO 14739)

 RichMedia annotations

 New architecture for media & 3D-based content

 Geospatial data (2D and 3D)

 Measurement properties (2D and 3D)

 Color management for 3D
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Already There!
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Inclusions from other standards

 ETSI - Improvements to Digital Signatures

 PAdES Compatibility/Alignment

 Support for ECC-based certificates

 PDF/A - Associated Files

 Additional metadata for attachments (embedded files)

 PDF/VT – DParts (and GoToDPart)

 Way to group page ranges together w/associated metadata
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Almost 
New

http://www.iso.org/iso/en/ISOOnline.frontpage
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Other improvements 

 Collections/Portfolios

 Barcode form fields

 Reader Requirements

 Enforcable Viewer Preferences

 Document Requirements

 Stronger/Improved Encryption

 256-bit AES & Unicode-based passwords

 Unencrypted Wrapper (aka Page0)
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Already There!
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PDF 2.0 —Refine

 Refining PDF

 Enhance descriptions and language

 Add previously implied normative language

 Corrections

 Fix typos

 Conversion mistakes
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PDF 2.0 — Deprecate & Standardize

 Additive standard

 Replaced mechanisms – Info dictionary, platform file specifications

 PDF 2.0 enhancements – Insecure cryptography, accessibility permission

 Unused features – Sound & Movie, Form XObject names

 Continue de facto to de jure

 Adobe JavaScript

 Rich Text

 XFDF

 Update references

 Newer standards

 Where appropriate
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Conformance

 Conforming processor requirements recast as conforming file requirements 
where possible

 Easier to test & validate

 Requires PDF writers to create valid files

 Distinction between interactive and non-interactive processor requirements

No requirement to implement all of PDF 2.0!
But for every feature you choose to implement, you “shall” comply!
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Conclusion

 PDF 2.0 is the first core PDF standard developed entirely under ISO guidelines & 
processes
 International, Open, Vendor neutral, Collaborative

 ISO 32000-2:2017 PDF 2.0
 Backwards compatible  

 Many new features

 Improved clarity, less ambiguities & lots of corrections  

 Supports non-proprietary technologies & open standards  

 Improved cross-referencing & usability of the standard

 Enabling a solid foundation for
 New use cases, capabilities & workflows

 Improved interoperability & consistent implementations
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Questions
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Overview
Markup-based toolchains allow you to build fully-automated transformations that can turn your text into laid-out pages and 
distribution-ready EPUBs in just minutes. These sorts of workflows were historically built around XML, which was combined 
with a formatting language called XSL-fo to create print-ready PDF files. 

HTML is already the heart of the Web, as well as the primary content format for EPUB files. With the introduction of the CSS 
paged media spec which enabled people to create print-ready PDFs from HTML content, HTML became a viable alternative 
to XML-based workflows. Working in HTML sets you up to take advantage of all the tools and expertise in web programming 
today, while still being able to create beautiful print files using the CSS formatting language. 

However, building and implementing an HTML-based process is a big change from the traditional InDesign method and 
can require a lot of time and resources.

A Note About Standardization

Kris discussed this at length during his demo, and it applies just as much here: The key to a cleanly 
automated workflow is standardized and predictable source. This means use good, semantic 
styles and tags for each element in your content, and use them consistently. Check out his hand-
out for more on this.
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HTML and CSS
HTML (short for “HyperText Markup Language”) is a way of classify-

ing information. You use HTML tags to classify the different parts of your 
content, for example as headings, paragraphs, sidebars, and so on, which 
makes it easier for computers, web browsers, and developers to know how 
to handle each piece of information. Today’s HTML is actually a subset of 
XML, which means that it comes with all the same rules and behaviors as 
standard XML. The difference between XML and HTML is that while XML can 
consist of any tags you want (XML stands for eXtensible Markup Language, 
which means that it is, by nature, extensible or designed to accommodate 
changes), the tags allowed in HTML have already been determined and can’t 
be changed.

CSS (“Cascading Style Sheets”) is the companion to HTML, and controls 
the look and feel of an HTML file—think of it like applying paragraph and 
character styles in InDesign. CSS makes a web developer’s job a lot easier, by 
letting them maintain their design separate from their HTML content, and 
also apply designs to multiple HTML pages at the same time, like a template. 

What Does This Look Like?
In its simplest form, an HTML workflow looks like this (see the diagram 

below):
1  Get your content marked up as HTML
2  Transform to PDF using a PDF processor and CSS
3  Transform to an ePub using a tool like Pandoc or HTMLBook
4  Transform to any other formats you might require (like MOBI)

OF course, there are a number of things to take into consideration to get 
to each of these steps.

Getting your content into HTML
HTML is still a coding language and requires some coding knowledge. It 

may not be practical for you to require your staff to learn HTML, but you still 
have options:

1. Author directly in HTML

• Pros: Skip any extra conversion steps

• Cons: Hard to control the markup; finding tools for authoring; hard to 
train people

2. Author in an intermediary markup language like markdown, and then 
convert to HTML

• Pros: Slightly easier to control the resulting HTML markup; easier to 
learn than full HTML

• Cons: Requires extra processing steps; training on text editors; training 
on the markup language itself

3. Author in some separate program, like Microsoft Word, and then con-
vert that to HTML

• Pros: Well-known program; easier to control the resulting HTML 
markup

• Cons: Requires extra processing steps; training on styling Word files

1
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Transforming to PDF
Right now, most people use a tool like Prince, Antenna House, or Vivlio-

style to create their print pdfs. These tools take your HTML files, apply your 
CSS designs, and paginate the book automatically. In a matter of seconds 
they return a laid-out, paginated pdf. Of course it’s not quite that simple...

There aren’t a ton of good tools out there for building CSS designs for 
either print or EPUB, so this requires someone with some CSS development 
chops.

Many people who use HTML-based automation choose to use uniform 
templates for their book designs, to save themselves some development 
work. However, it’s important to note that if you’re using CSS templates, 
you need your HTML markup to be standardized and consistent, so that you 
don’t need to update your CSS for every book.

Additionally, the pagination process happens behind closed doors, so if 
the program creates a page- or line-break you don’t like, the process for fix-
ing it is more complex than just resizing a text box. If you care about pagina-
tion, you’ll need to build-in time for this and train your staff accordingly.

Transforming to EPUB
As long as you’re working with reflowable (I.e, NOT fixed-layout) EPUB, this 

step is a lot easier than PDF generation. Configure a program like Pandoc 
or the HTMLBook scripts, and then run your content through along with 
any supporting files (like CSS or cover image files), and out will come a valid 
EPUB file ready for distribution.

Resources
Check out Nellie’s talk on automating workflows from last year: https://

bit.ly/2LK7pjU

Transform Word to HTML
• Mammoth - https://github.com/mwilliamson/python-mammoth

• Pandoc - http://pandoc.org/epub.html

Some HTML & XML Specifications
• HTMLBook - http://oreillymedia.github.io/HTMLBook/

• EDUPUB - http://www.idpf.org/epub/profiles/edu/spec/ 
education-20160211.html

• DocBook - http://docbook.org/

• DITA - http://www.dita4publishers.org/

Transform HTML to EPUB
• HTMLBook - https://github.com/oreillymedia/HTMLBook

• Pandoc - http://pandoc.org/epub.html

Transform HTML to PDF
• CSS paged media spec - https://www.w3.org/TR/css3-page/

• “Building Books with CSS3” - A List Apart, June 2, 2012 - https://ali-
stapart.com/article/building-books-with-css3

• Nellie’s 4-part video series on learning CSS for paged media: http://bit.
ly/2qadQC5 (YouTube)

• Prince - http://princexml.com

• Antenna House - https://www.antennahouse.com/antenna1/

• Vivliostyle - http://vivliostyle.com/

Browser-Based Tools
• Hederis - http://hederis.com

• PagedMedia Working Group - http://pagedmedia.org

• Vivliostyle - http://vivliostyle.com/

• Mywo - http://www.mywomags.com/
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When To Automate
I want to highlight two important considerations which help determine whether automation might be considered.

The first consideration is Return-On-Investment: how much does it cost vs. how much does it save?
The second consideration is whether the workflow-to-be-automated is structured well enough to allow automation. Insuf-

ficient structure can make it infeasible to automate.

Productivity Enhancement vs. Batch Processing
I tend to distinguish between two main types of automation for publishing workflows.

Some automation can be used to gain productivity. A difficult or complex operation can be automated so the designer 
can interactively select an element on a page, and then, with a single click, perform some complex task. 

This is beneficial if the task is complex or error-prone, or needs to be performed many times on many scattered page ele-
ments. When activated, the automated process will typically complete in a very short time, a few seconds at most.

The benefits are time savings, better consistency, and to leave less room for human error.
An second form of automation is ‘batch processing’. In this case, there is a task to be performed on many similar elements. 
The batch process is started, it consumes some form of input, and generates some form of output. The process might take 

a while to complete, sometimes even hours or days.
The input could take many forms. It could be a bunch of files (a bunch of InDesign documents, Illustrator files, image files, 

XML files, Word documents) or some other ‘things’ (e.g. a collection of designated text frames in a document or book, a 

Three Forward-Looking Publishing 
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selection of broken links…)
Similarly, the output can also take many forms.

Forethought and planning are half of the battle.
To set up a successful and efficient automated process, much of the effort 

depends on how well structured the input it.
Similar to the old adage of prevention versus cure, defining a proper struc-

ture beforehand is much easier than trying to bring structure into chaos later 
on. 

Even if you don’t consider automating it will always be worth your while 
to describe and document some standards and guidelines for document 
design beforehand. 

Style names, image naming conventions, style structures, folder structures, 
image resolutions, image file types ... can often all be defined and docu-
mented beforehand. 

Having these guidelines written up will then help make all documents 
consistent.

This can be most beneficial when there are multiple team members work-
ing on the same project. It also helps when additional team members need 
to be introduced to the existing team.

Even for a ‘team of one’ there are benefits to having a well-defined 
structure.

A Bad Example
Two projects, the same project brief. One project was unrealistic, the other 
was successfully automated. The difference: having structure.

Sometime ago we were requested to convert the content of a pool of 
InDesign documents into a database, so the content could be searched and 
re-used later on. 

These documents were coming from multiple different providers. 

When we examined a collection of representative sample documents, it 
turned out that there was no structure or regularity to the way the docu-
ments were built.

Only some had some paragraph styles. 
There was no regularity to the styles, and the style names were different 

from document to document. 
Some documents were set up as a single large text story that flowed 

through multiple text frames. 
Some documents had text as high-res bitmaps.
Other documents consisted of many small stories, all scattered across a 

number of text frames.
Trying to automate such conversion would never be perfect. 
The software would have to make a ‘best guess’ to determine what some 

piece of content was. 
For example, a larger font size might mean ‘headline’. A smaller font size 

might mean ‘body text’. That could work most of the time, but not always.
The main issue here was that there was no overarching structure, and that 

made things difficult. 
We’ve learned that in such situations, developing the automated process 

is very expensive. And to make matters worse, the best we can achieve is 
‘assisted automation’. 

With ‘assistend automation’, the automated process makes a best guess, 
and then a human operator has to verify and possibly correct the result. 
Automation could bring some improvements, but the benefits remain lim-
ited because you still need human eyeballs to make sure all is well.

This project never got off the ground.

A Good Example
A different customer asked us the exact same question. The end result was 
very different. In this second project we were able to fully automate the task. 
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All documents were structured the same, rigid 
way.

The documents all used consistent paragraph 
styles and paragraph style names (so we could 
discern different types of text simply by looking 
at the paragraph style name).

They all used a single large text story flowing 
through multiple text frames.

Automating this conversion was very straight-
forward, and we succeeded in converting all 
documents into the database without much, if 
any, need for human interaction. 

This lead to much lower operating costs, and 
the project was a success.

Custom vs. Standard Software
 Custom-developed automation looks very 

expensive when compared to typical prices paid 
when purchasing or subscribing to standard 
software. 

Standard software prices are driven by the laws 
of large numbers: the cost of software develop-
ment is spread out over many thousands or mil-
lions of customers, and each customer pays a few 
tens or hundreds of dollars. 

Custom automation, on the other hand, passes 
the full cost of the software development on to a 
single customer, and customers will typically pay 
multiple $10,000 or $100,000 to get some solu-
tion developed.

The real question that needs to be asked is 
whether the custom-developed automation leads 
to savings. 

If the savings accrued over some reason-
able period (e.g. a year) surpass the cost of the 
custom-developed solution, the investment 
is worth it. If a custom software development 
costs $20,000 to develop, but leads to a $40,000 
increase in yearly revenue, it more than pays for 
itself.

When considering automation, the most impor-
tant ballpark figure to estimate is how much dif-
ference the automation could make. 

If it can lead to an increase in revenue, that 
needs to be added into the estimate. 

If it can lead in a reduction in employee-hours 
on mind-numbing tasks, that saving needs to be 
added too.

If it can reduce the occurrence of expensive 
mistakes, that needs to be added too. Nothing 
hurts like having to throw away a large print run 
because of human error.

Once the potential savings have been esti-
mated, you end up with a rough idea of what 
your budget for custom software development 
should be.

If developing a custom solution ends up being 
much more expensive than this budget, it is not 
worth pursuing. If it ends up being lower than 
this budget, it might be worth the effort.
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Point #1. It Is Time To Choose A Web-Based Ebook Reading System
Since the introduction of digital books (mainly Epub and 
Mobi), it has been a constant battle to ensure that those prod-
ucts display well on the various available reading devices.

Many Ebook developers/producers have fallen into the 
black hole of having to provide multiple versions of the 
same files just to account for the variation in display.

In my opinion, this goes directly against one of the biggest 
reasons for going digital. To make it easier for more people 
to consume the information. I also believe that it should 
also be easier for us, the ebook creators, to create a single 
final file that just works as expected across the board.

Time to stop relying on others
In the past few years, it has become painfully obvious 
to me that the makers of the most popular ebook read-
ing devices (Kindle, iPad, Android tablets, etc.) have 
no interest in improving their overall support of better 
stylesheet-rendering. 

We need to take control. Attempting to develop a better 
device is not sustainable because physical devices eventu-
ally become obsolete. Also, people are really attached to 
their Kindles and Tablets.

It seems to me that a really good web-based ebook ren-
derer is really the way to go. Every tablet/reader has a web 
browser. If were to somehow able to provide an excellent 
browser-based reader to display our ebook products, that 
would be a step in the right direction. Readium and Blue-
fire Reader are 2 great examples that currently exist.

Our New direction
At O’Reilly, we have decided to takes steps in this direction. 
When we create our digital content (ebook and otherwise), 
we optimize the visual styling for display on our own web-
based environment (Safari Books Online). This gives us 
the flexibility and control that we need to ensure the best 
reading experience for our users.
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Point #2. Automation Is The Goal, But Not Without Some Manual Input

When we first began toying with the idea to build our own internal auto-
mated publishing system (Atlas), I think we put too much emphasis on 
trying to make everything automated. After multiple attempts to entirely 
replace our traditional publishing workflow (InDesign), we are finally begin-
ning to strike a better balance.

It has become clear to me that there are certain subject matter and visual 
designs that do not fit into a fully automated workflow. Even for some 
relatively simple book layouts. If there are lots of images and thoughtfully 
chosen font faces incorporated into a well-designed visual template, then 
chances are it may be better suited for a more traditional (less automated) 
workflow.

So, our more traditional publications (books), now fall into 1 of 2 
categories:

• Can be automated (Atlas workflow)

• Needs special handling (InDesign workflow)

This is where the human element really begins. We need to carefully assess 
the content and decide which design template is most appropriate.

If the elements (text, notes, sidebars, figures, etc.) are meant to be visu-
ally consistent and there are not too many page-breaking rules, then the 
content will likely be well-suited for our Atlas automated workflow.

If there are lots of images and lots of different kinds of notes & sidebar 
elements, then the content may be better suited for our InDesign workflow. 
This is especially true if the book requires each page or spread to be indi-
vidually designed, like a traditional magazine layout.

Currently, the majority of our publications go through our Atlas (auto-
mated) workflow. But the number of titles that are better suited for InDesign 
are on the rise, once again.
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Atlas (Automated Workflow)
Our Atlas workflow is an entirely web-based environment. The author will 
log in and begin writing directly inside the browser window.

Content can be written in the following forms:

• HTML (includes code/visual editors)

• AsciiDoc

• DocBook

When the content is ready, it can produce 5 outputs:

• Web PDF

• Print PDF

• ePub

• Mobi (Kindle eBook format)

• HTML

Even though this is a highly automated environment, we still rely heavily on 
our editors to look over the final product to ensure proper spelling, page-
breaking, grammar, and overall quality. 

Things that a robot may not understand quite as well as a human.

Currently, our Atlas platform is in-house only, and not for public consump-
tion, but here are some references to give you an idea of what it is all about:

• HTMLBook Project (https://github.com/oreillymedia/HTMLBook) 
Open source resources for using HTML5 as a book authoring/produc-
tion format: XML Schema, CSS stylesheets for print book design, and 
XSLT-based tools for producing ebook and Web outputs.

• HTMLBook Specification (http://oreillymedia.github.io/HTMLBook/) 
Latest Unofficial Working Draft specification and content model for 
HTMLBook.

InDesign  
(Traditional, Semi-Automated Workflow)
Our goal for the more traditional InDesign workflow is to take our current 
template designs and add custom scripts that will automate part of the 
workflow.

There are aspects of this type of layout that require lots of hands-on atten-
tion in order to get it right. This is the part that needs the human element.

On the other hand, there are plenty of tedious tasks that can absolutely 
be automated, such as:

• Formatting sidebars

• Formatting notes

• Formatting figure frames (with/without captions)

• Importing and placing images

• Applying cross-references

• Formatting fractions

• And pretty much any other tedious tasks that 
you want to get off of your plate

I highly recommend reaching out to the incredibly talented script-writers 
and plugin developers (many of which will be with us in NOLA this week) for 
ideas on how to accomplish this type of automation. Here are some of my 
favorites:

• Kris Coppieters (www.rorohiko.com)

• InDesign Secrets 
(https://indesignsecrets.com/category/secrets/pluginsscripts)

• Multi-Find/Change  
(http://www.automatication.com/index.php?id=24)
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How EPUBs can be read on every website, desktop and mobile device
With Readium, we can securely publish standards-based, reflowable and fixed-layout EPUB3 on our own websites.

This session and handouts cover how to use the Readium CloudReader to instantly and automatically publish rich online 
EPUBs to any browser, how to host EPUBs on your own website and how to work with the new Readium 2 reading apps. 

Who and what is Readium?
The Readium Foundation (readium.org) is an Open Source Foundation collaboratively developing technology to accelerate 
the adoption of EPUB3. Not a retailer, not a publisher, they are a non-profit organization supported by members since 2012. 
With around 50 current members, the Readium Foundation has attracted support from the largest tech and publishing 
companies including Adobe, Disney Publishing, Google, Hachette Livre, Penguin Random House, Sony and Yahoo.

Perhaps rather confusingly ‘Readium’ is also the name given to their set of open source technologies.
Readium is not new. It has been in development since the EPUB3 was published as the IDPF (International Digital  

Publishing Forum - originators of EPUB standards) decided to actively promote the use of the EPUB3 standard for ebooks.

Readium Chrome Extension
Readium gained some early success with their extension of the Google Chrome browser (bit.ly/ReadiumCE)

Once installed, the Readium Chrome Extension turns Google Chrome into an EPUB3 reader, displaying a bookshelf of 
locally loaded EPUBs which can be read offline. However, Google has announced it is depreciating all Chrome apps in 2018.

Publishing EPUBs to your website with Readium
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www.circularsoftware.com
ken@circularsoftware.com
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“The Readium 
Foundation is an Open 
Source Foundation 
collaboratively 
developing technology 
to accelerate the 
adoption of EPUB 3”

“EDRLab is an 
international,  
non-profit development 
lab, working on the 
deployment of an 
open, interoperable 
and accessible digital 
publishing ecosystem”

Who are EDRLab?
The European Digital Reading Lab (edrlab.org) is an innovative non-profit organization, created in 
2015 and based in Paris.

They are actively developing the many parts and projects that make up Readium today. Namely:

• Readium SDK

• Readium CSS 

• Readium JS

• Readium CloudReader

• Readium 2

• Readium LCP

Readium SDK
The Readium Software Development Kit (SDK) is available to developers who are looking to build 
ebook reading apps or to allow ebook reading as part of a larger app. e.g. Adobe used an early 
Readium SDK for Adobe Digital Editions (but don’t hold that against it!). Previously the Readium SDK 
was prohibitively expensive for small developers at $30,000 USD for a commercial application but 
Readium announced in February 2018 that the Readium SDK is now free to use.

Further info –  www.edrlab.org/readium/readium-sdk-js/

Readium CSS
Readium CSS is a set of reference style sheets for EPUB Reading Systems. It is used in Readium 2, (see 
later), but can be freely used by any EPUB Reading System.

Further info – medium.com/@jiminypan/on-readium-css-5a7d87f7b671

Readium JS
Readium JS is a set of javascript (JS) libraries that turn modern web browsers into EPUB readers. These 
are used for the Readium Chrome Extension and the Readium CloudReader.

Further info – readium.github.io/development/readium-js-overview/

2 of 4

http://edrlab.org
http://www.edrlab.org/readium/readium-sdk-js/
https://medium.com/@jiminypan/on-readium-css-5a7d87f7b671
http://readium.github.io/development/readium-js-overview/


Publishing EPUBs to your website with Readium
Ken Jones

Unzipping EPUBs
Readium CloudReader works with expanded EPUB folders so to use EPUB 
files, from InDesign or elsewhere, you will need to expand them first.

I recommend these epub zipping/unzipping utilities
Mac - bit.ly/ePubZipUnzip
Windows – rorohiko.com/downloads/eCanCrusherWin.1.2.0.zip

Readium CloudReader
If you can accept the requirement to be online then I recommend using the 
Readium CloudReader over Readium Chrome Extension for three reasons:

1. It works without the need to pre-install any extensions, you simply 
send readers a URL

2. Not limited to Google Chrome

3. Can be placed inside an iframe or overlay on your site

Readium CloudReader caters for both reflowable and fixed-layout EPUB3 
(as does the Readium Chrome Extension) and has impressive support for 
audio, video, animations, media overlays including speed controls, javascript 
interactions and background soundtracks.

The CloudReader is currently validated against the latest version of all 
major browsers, including:

• Safari (OSX and iOS only)

• Firefox (iOS, OSX, Windows, Android)

• Chrome (iOS, OSX, Windows, Android)

An up-to-date build of the Readium Cloud Reader resides online at  
readium.firebaseapp.com and by passing it a path to an expanded EPUB 
folder on a web server as a query parameter (so adding the full URL to 
the top level folder after ?epub= including the http:// or https://) you can 
instantly view and share an EPUB online.

The catch here is that the URL to the expanded EPUB folder needs to be an 
encoded JavaScript URL, meaning all the colons and slashes etc. have to be 
replaced with the corresponding escaped characters. Paste your URL here 
meyerweb.com/eric/tools/dencoder to convert a URL to an encoded path.

An example of a full URL of an EPUB on my web server is quite a long string 
https://readium.firebaseapp.com/?epub=https%3A%2F%2Fcircularsoft
ware.com%2Fsamples%2Falice (note I have encoded the URL to the EPUB).

Using UpDog to share EPUBs from Dropbox and 
Google Drive
Since Dropbox retired their public folder feature last year, I now use and 
recommend the simplicity of UpDog (updog.co) to convert files and folders 
on either Dropbox or Google Drive into instant web content.

Combine your expanded EPUB content from UpDog with Readium Cloud 
Reader e.g. here is an EPUB running from my Dropbox account with UpDog 
readium.firebaseapp.com/?epub=https%3A%2F%2Fcpw.updog.
co%2Fphilip-k-dick_short-fiction (note I have encoded the URL path).

For $4 a month you can either specify folders or even allow your entire 
Dropbox to be shared as a web server. Unlimited file transfer is included and 
space is only limited by your Dropbox or Google Drive plan. I am a pro user 
of UpDog and as such I can offer a free trial link. Contact me for an invitation.

Sharing links to specific places or pages
As well as sharing instant links to specific EPUBs, 
it is also possible to share your position within a 
publication from Readium CloudReader using the 
link button in the top navigation bar. The exact 
level of location will depend on the landmarks 
and structure within the EPUB.
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galdosgift.com/book-sample note the complex interactions possible 
in this fixed layout EPUB3 and that some features of the Readium 
CloudReader are disabled, such as table of contents and page link sharing.

Hosting Readium CloudReader on a web server
The Readium Cloud Reader can be freely deployed to a web server or 
UpDog shared folder. The full cloud-reader installation features an ebook 
library with bookshelf whereas the cloud-reader-lite distribution is a more 
simple option for just displaying publications one at a time. Benefits include:

• Keeping the entire code for presenting EPUBs on your network

• Guarding against changes to the firebase build that you have not tested

• Ability to amend the appearance and functionality of the reader

Download from github.com/readium/readium-js-viewer/releases and 
then place the unzipped folder onto a web server. The full URL to a hosted 
reader and EPUB gets quite long, but also makes you look super techie! e.g. 

https://www.circularsoftware.com/samples/Readium_cloud-reader/
?epub=https%3A%2F%2Fcircularsoftware.com%2Fsamples%2Falice 
(note I have again encoded the URL path after the /?epub= part).

Readium 2
With Readium 2, EDRLab are expanding their horizons and taking Readium 
beyond their SDK and the browser based reader apps. They are set to offer 
a free ‘vendor neutral’ well-featured ebook reader for every desktop and 
device later this year. To include iOS, Android, Windows, Mac and Windows.

At the time of writing (May 2018) we have the first public release of 
iOS reader for iPhone and iPad itunes.apple.com/app/r2-reader/
id1363963230 and a desktop app for Mac, Windows and Linux (currently in 
alpha) github.com/edrlab/readium-desktop/releases.

Further info – edrlab.org/readium/readium-2

Readium LCP
Protection of content against piracy is an essential requirement for many 

publishers. Readium Licensed Content Protection (LCP) is installed into 
every Readium reading app. Any publisher can use LCP and there is no cost 
per transaction. A well featured ‘vendor neutral’ solution which allows for 
loaning, loan extensions and advanced return of a loaned ebook.

Further info – edrlab.org/readium/readium-lcp

Questions?
I’m happy to follow up after the session and to offer help and advice in the 
future where I can. Please feel free to contact me.

ken@circularsoftware.com  @CircularKen  linkedin.com/in/kenjones
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Overview
CSS and HTML are the fundamental building blocks of the Web, and are being used in more and more ways, including as the 
base for eBook files and as content and design languages for creating print books. This handout includes the basic back-
ground information as well as some key tips and tricks for you to get up and running with CSS and HTML. We won’t go into 
the specifics of every element that we covered during the in-person tutorial, but check out the final sample files for even 
more guidance about how to use specific HTML elements and CSS properties to build your design—look for the <!-- --> 
(HTML) and /* */ (CSS) comment tags throughout the code. 

Download all the sample files here: https://bit.ly/2GdSGde (this link is also at the top of every page of this handout). 

What is HTML?
HTML (short for “HyperText Markup Language”) is a way of classifying information. You use HTML tags to classify the differ-
ent parts of your content, for example as headings, paragraphs, sidebars, and so on, which makes it easier for computers, 
web browsers, and developers to know how to handle each piece of information. 

Today’s HTML is actually a subset of XML, which means that it comes with all the same rules and behaviors as standard 
XML. The difference between XML and HTML is that while XML can consist of any tags you want (XML stands for eXtensible 
Markup Language, which means that it is, by nature, extensible or designed to accommodate changes), the tags allowed in 
HTML have already been determined and can’t be changed. (There’s a link to a list of all the allowed HTML tags in the Refer-
ences section at the end of this handout.)

CSS and HTML for Designers
Nellie McKesson
www.hederis.com
nellie@hederis.com
@nelliemckesson
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Versions of HTML
HTML has been around for a long time, and gone through many changes. 
There are people who cringe when they think about using HTML to classify 
documents and data, because they remember the early “wild west” of 
HTML, where there weren’t a lot of rules around how HTML needed to be 
structured, which resulted in messy files that were hard to support.

These days, when people talk about HTML, they typically mean either 
XHTML or HTML5, which are the two most recent versions of HTML, and 
include a lot more structure than earlier versions.

Anatomy of an HTML Element
An HTML element consists of a few parts:

• Opening tag: The opening tag marks the beginning of the element. 
It contains the tag name (in this example, p), followed by any optional 
attributes that describe the element (more about attributes later). All this 
is wrapped in a set of angle brackets (< >).

• Content: The content of the element is sandwiched between the open-
ing and closing tags. The type of content allowed depends on the type 
of tag. Sometimes it can be text, or other HTML elements. Read about 
what types of content and tags are allowed within each HTML tag in the 
HTML reference linked at the end of this handout.

• Closing tag: Finally, an element ends with a closing tag. The closing 
tag will only contain the name of the element, preceded by a slash, and 
wrapped in angle brackets just like the open-
ing tag. In XHTML and HTML5, closing tags are 
almost always required for every element.

Creating and Editing HTML (and CSS) Files
While you can export HTML from programs like InDesign (see the end of this 
handout) and Microsoft Word, you can also create them from scratch using a 
text editor application, like: 

• Atom (Windows & Mac, free)

• Brackets (Windows & Mac, free)

• Notepad++ (Windows, free)

• Sublime Text (Windows & Mac, $70 — this is what I use)

To create an HTML or CSS file from scratch:

1. Open your text editor of choice.

2. Create a new file via your text editor’s built-in options (in Sublime, you 
would choose File > New).

3. Save your new file, giving it a filename of your choice followed by either 
the .html or .css extension, depending on which type of file you are 
creating.

To open an HTML or CSS file:

1. Open a file navigator window (Finder for Mac users, Explorer for Win-
dows) and navigate to the location of your HTML or CSS file.

2. Right-click/control-click/command-click on your file’s name.

3. From the menu that appears, select your operating system’s version of 
“Open with…”.

4. From the list of programs, choose the name of your text editor and click 
“Ok”.

Opening Tag Closing TagAttributes Content
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The Parts of an HTML File
HTML files must start with some specific elements, and have a certain 
structure:

➊ The DOCTYPE declaration tells browsers or other HTML processors what 
kind of document this is.

• Required position: first thing in the HTML file

• Restrictions: Must appear only once

• Read more: https://www.w3schools.com/tags/tag_doctype.asp

➋ <html>: this is the root of your HTML file. Everything besides the DOC-
TYPE tag will go inside this element.

• Required position: immediately following the DOCTYPE tag.

• Restrictions: Must appear only once

• Read more: https://www.w3schools.com/tags/tag_html.asp

➌ The <head> element is a place to put any extra  
metadata about your file, as well as link to any files  
(including your external CSS files—see below).  
Everything inside the <head> will be invisible when  
the HTML page is displayed in a browser.

• Required position: immediately Inside the <html>  
root, before the <body> tag

• Restrictions: Must appear only once

• Read more: https://www.w3schools.com/tags/ 
tag_head.asp

➍ <title> is required for all HTML documents, and serves as a descriptive 
title for your file. For example, if the HTML file is intended to be a webpage 
for a company, the title might be the name of the company; if the HTML file 
is the text of a book, the title might be the title of the book.

• Required position: Anywhere within the <head>, or if no <head> is pres-
ent, before the <body>.

• Restrictions: Must appear only once

• Read more: https://www.w3schools.com/tags/tag_title.asp

➎ <body>: This is where you’ll put all of your content, and is the only part 
of the HTML page that a web browser will actually display.

• Required position: After the <head>, or after the <title> if no <head> 
is present.

• Restrictions: Must appear only once 

• Read more: https://www.w3schools.com/tags/tag_body.asp

➊
➋

➌
➍

➎
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Nesting, Vocabulary, and the DOM
Once you have your basic HTML structure in place, you can start filling in the 
<body> with any content you’d like. The <body> can contain any variation 
of valid HTML elements (except for those that are restricted to the <head>, 
like the <title> element). Remember this core terminology for describing 
your HTML file:

• When you put an element inside another element, this is called nesting. 

• When an element is nested inside another element, it is called a child of 
that element. 

• The level at which the element is nested determines if it is a direct child 
or indirect child (sometimes called a descendant).

• Children at the same level within a parent are called siblings. 

This introduces the concept of the DOM. The DOM stands for the “Docu-
ment Object Model”, and refers to the overall structure of your HTML docu-
ment. The DOM is a standard that defines the relationships between differ-
ent elements and how they interact with each other. It is most commonly 
used in scripting (for example, when developers are writing JavaScript to go 
along with an HTML page), but you may hear it mentioned by developers 
simply as a way of referring to the structure of your HTML file.

Attributes
Attributes let you add extra information about an element. They live inside 
the start tag of each element, and typically consist of the name of the attri-
bute followed by the attribute value, like this: 

An attribute

HTML includes a number of predefined “global” attributes that can be 
applied to any element, and there are also special attributes that apply only 
to specific elements (for example, the href attribute applies to the <a> 
[a.k.a. link] element, and defines the destination that the link points to). You 
can read about which attributes are allowed for each type of HTML tag in 
the HTML reference linked at the end of this handout.

Additionally, as part of HTML5, you can define your own attributes using 
the “data-” prefix. This is a special construction that lets the browser know 
that you’re providing extra information about the element that is specific to 
your site or application. For example, you can make up an attribute called 
“data-type” to describe the different types of sections in a book, like this: 

Browsers don’t have any inherent handling for this kind of custom attribute.
Class and ID are probably the most-used attributes in HTML, and provide a 

way to group elements together, or target elements directly via CSS.
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The class attribute
Think of a class as a category of elements that all share something in com-
mon—this could be something as simple as being aligned to the right, or 
it could be a more generic grouping, for example a way of grouping all the 
elements that make up a navigation menu. Elements can have multiple 
classes, which you apply separated by spaces, like this: 

 

The names of classes are yours to create and the only rule is that they can’t 
contain spaces (best practice is to use only letters and numbers and the 
occassional dash or underscore), but bear in mind that when you’re creating 
class names, you’re creating your own taxonomy for information; make sure 
you think about how easy it is for other people to learn and use that tax-
onomy. Here are a couple of tips for creating good class names:

• Choose descriptive names. There are many opinions about how to 
name your classes: should they reference the function of the class, or 
some sort of semantic description? Should you call your class “centered”, 
or “pullquote”? Ultimately, the answer will come down to your specific 
content and needs, but one thing is for certain: choose class names that 
mean something. Don’t name your classes things like “myclass”, which 
gives no hint as to what the intent of the class might be.

• Be consistent, both in terms of the types of class names you choose, 
and in the way that you spell them (for example, don’t call one class 
“appendix“ and then another “chap“—spell them both out, or abbrevi-
ate both). Additionally, be consistent in the way that you apply classes, 
with the goal of keeping your code as DRY as possible (DRY: Don’t 
Repeat Yourself; in this context it could be interpreted to mean don’t 
create multiple classes to accomplish the same thing).

The id attribute
ID is a unique name that you give to an element, as a way to single that ele-
ment out for some purpose—perhaps as a destination to link to, or if you 
need to define a custom design just for that element via CSS. You apply an 
ID the same way you apply any other attribute:

Just like classes, the value of an ID is up to you to create, and up until 
HTML5 the only rule was that an ID must not start with a number (starting 
in HTML5, even that rule was removed). Unlike classes, an element can have 
only one ID. Because IDs are meant to be unique, many people choose to 
use a random string of characters for their IDs, to reduce the risk of duplica-
tion. Another standard practice is to use the text of the element as the ID, 
with all spaces and special characters removed. There are pros and cons to 
either approach, and ultimately the choice depends on how you are creat-
ing your HTML and what you need to do with it.

A Note About Good Semantics

When you’re working with HTML and CSS, it’s easy to make pretty much any element look and act 
the way you want, but it’s important to use the right HTML element for your content. For example, 
use h1 tags for headings, or use button tags for buttons, instead of using p tags for every-
thing and making it all look right via CSS. Using the correct tags makes your HTML (and CSS) more 
maintainable and more accessible. Each type of tag inherently means something, and browsers 
add special handling based on that tag meaning--including how to convey that tag content to 
users with disabilities. Read more about good semantics here: https://developer.mozilla.org/
en-US/docs/Learn/Accessibility/HTML.
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What is CSS?
CSS (“Cascading Style Sheets”) is the companion to HTML, and controls the 
look and feel of an HTML file. In the early days of HTML, many developers 
embedded their designs within each HTML tag, like this:

No! Bad!

This meant that every time they wanted to update a design, they had to 
hunt through their HTML code to find the embedded styling, and if they 
had multiple elements that they wanted to apply the same design to, they 
had to update each element one by one. 

CSS makes a web developer’s job a lot easier, by letting them maintain 
their design separate from their HTML content, and also apply designs to 
multiple HTML pages at the same time, like a template. 

A Note About Cross-Browser Compatibility

While the “browser wars” of the 90s are mostly over, there are still some differences in the way 
browsers handle certain CSS properties--especially when it comes to new additions to the CSS 
spec. To find out whether you need to worry about any browser support issues with the CSS you 
want to use, you can check the details for each CSS property on the W3Schools site (https://www.
w3schools.com/cssref/default.asp) or on the Mozilla Developer Network (https://developer.
mozilla.org/en-US/docs/Web/CSS), but it’s also a good idea to preview your site in as many 
browsers as possible, so you can catch any unexpected behavior--we’ll talk about previewing your 
files later.

Anatomy of a CSS Rule-set
CSS files consist of sets of rules (called “rule-sets”, naturally), each of which 
define the design of a specific element or set of elements. You can include 
CSS rules in an HTML file, or put your CSS rules into a standalone file that 
exists separately from your HTML, making it easier to maintain your content 
and design as separate entities (more on that later). A CSS rule-set has two 
parts: 

selector

declaration block

property value

• Selector: This targets the specific element(s) that you want to apply the 
CSS design to. There are many ways to select HTML elements, which 
we’ll go over in detail below.

• Declaration block: This is where you put the actual design definitions, 
and is wrapped in a set of curly brackets ({ }). Each definition consists 
of a property and a value, separated by a colon and terminated by a 
semicolon.

Check out the complete list of CSS properties here: https://www.
w3schools.com/cssref/default.asp
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CSS Selectors
Selectors are the most important part of your 
CSS rule-sets; they allow you to design in broad 
strokes or to dive into the fine details of just a 
single element. By combining the different types 
of selectors, you can target the elements in your 
HTML file with a high degree of specificity. Here’s 
an overview of the types of selectors you can use:

1

15

14

13

12

11

10

9

8

7

6

5

4

3

2

Global selectors
1  Use an element name to select every instance 

of an element, or the “all” (*) wildcard ( 2  ) to 
select all elements in your file. 

Positional selectors
You can select elements based on where they 
occur in your document structure:

3  selects every p element that is a child (at 
any level) of a section element.

4  selects every p element that is a direct 
child only of a section element.

5  selects every p element that directly fol-
lows a section element:

6  selects every p element that is preceded by 
a section, anywhere in the document (new!):

You can combine global and positional selec-
tors, like 7 , which would select every p element 
that is a direct child of any div that is itself a child 
(at any level) of a section element.

Class and id selectors
You can get even more specific by selecting ele-
ments based on either their class or id values. 
Remember, classes can be shared, but ids should 
always be unique.

8  selects every element that has a class of 
“centered”.

9  selects any element that has an id attribute 
equal to “whatiscss”.

You can combine, global, positional, and class/
id selectors, as well. 10  selects every p element 
with a class of “centered” that is a direct child of 
the div element with an id of “container”.

Other attribute selectors
You can select elements based on any attribute 
value—not just classes and ids—using this 
construction: [attr=value]. 11  selects every 
section element with a data-type attribute 
equal to “chapter”.

You can also use wildcards to select attribute 
values that match a certain substring, as follows:

~= or *= to select an attribute value that con-
tains a particular string of text, anywhere in the 
value; see 12 .

|= or ^= to select an attribute value that starts 
with a particular string; see 13 .

$= to select an attribute value that ends with a 
particular string; see 14 .

Again, you can combine these with other 
selectors. 15  selects p elements that are direct 
children of the div element with an id of “con-
tainer”, which itself is a direct child of any div 
with a class that starts with the word “note”.
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Pseudo-classes and pseudo-elements

1

5

2

3

4

Pseudo-classes select elements that have a specific state, and should follow 
the selector for the element that they are modifying, separated by a single 
colon. For example, 1  selects every p element that is the first child of 
another element; 2  selects any div that is empty. 

Pseudo-elements select just certain parts of elements, and should be 
appended to the selector for the element they are modifying, separated by 
two colons. 3  selects only the first letter of the text inside a p element;  

4  selects only the area after an h1 element’s content (the space before 
and after an element is considered part of that element). 

There are many different pseudo-classes (https://
developer.mozilla.org/en-US/docs/Web/CSS/
Pseudo-classes) and pseudo-elements (https://
developer.mozilla.org/en-US/docs/Web/CSS/
Pseudo-elements), and they too can be combined 
with other selectors. 5  selects the p element with 
a class of “centered” that is the first-child of the 
div element with an id of container.

The Cascade
The cascade is such an integral part of CSS that it’s part of the name: Cas-
cading Style Sheets. The styles that you define in your CSS cascade to the 
end of the file, from top to bottom. For example:

1  If you define a CSS rule globally for all p tags, that rule will also apply 
to any more specific rules that you define, for example for p tags that have a 
specific class.

2  Additionally, rules that you put lower in your CSS file will override rules 
that came before.

3  However, a more general rule will not override a more spe-
cific rule. Read more about specificity here: https://css-tricks.com/
specifics-on-css-specificity/.

Remember that the cascade is cumulative, meaning that it takes into 
account all the styles that are applied to your HTML file (for example, the 
browser’s default stylesheet, any and all external stylesheets you have 
included, as well as any CSS you’ve defined within the HTML file itself (see 
the next section for more on applying CSS to HTML files). The intricacies of 
the cascade can make it a bit tricky to pinpoint where your different style 
definitions are coming from when you’re troubleshooting a design, so your 
browser’s developer tools can really come in handy here (see the section on 
“Using Browser Developer Tools” below).

1  p.centered 
inherits  

color: red

2  this rule  
overrides  

color: red

3  this rule has a 
higher degree of 

specificity than the 
following rule
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Applying CSS to HTML
There are two main ways to apply your CSS to 
your HTML: 

• internally, via the <style> tag

• externally, via the <link> tag

Using internal stylesheets (see the left-hand 
image below) is typically only recommended 
for small, single-page sites that don’t need a 
lot of designing, since you can’t reuse internal 
stylesheets across multiple HTML pages (the 
rules in the <style> tag will only apply to the 
specific HTML file they are included in). Internal 
stylesheets also make it hard to maintain your 
content and design separately, which is the 
preferred way of working for most teams (the 
designer handles the design, and a developer or 
CMS handles the content).

External stylesheets are generally the best 
way to go (but internal stylesheets can be useful 
in a pinch). When you’re working with external 
stylesheets, you create your CSS in a separate file 
with a “.css” extension, and then apply it to your 
HTML file by using a <link> tag, as shown in the 
right-hand image below.

Link tags should be nested inside the <head> 
element, and should include the path to your 
CSS file. 

Formatting File Paths
Here are some tips on formatting the path to your 
CSS file (these apply both to hosted sites and to 
files on your computer):

• A file or folder name, without any slashes 
or other content preceding it (e.g., 
href="styles.css"), means that this file or 
folder should exist within the same folder as 
the HTML file that references it (in HTML  
terminology, they’d be siblings).

• A single slash at the beginning of your path 
(href="/styles.css") means that the 
browser will start its search for your file at the 
root directory (the main folder for the website 
or on your computer), and then navigate from 
there. 

• Precede your path with “../” (href="../
styles.css"), and the browser will start at 
the same folder where the current HTML file 
lives, move one folder *up*, and then keep 
looking for the rest of the path.

• Similarly, “../../” (href="../../styles.
css"), will move you two folders up; repeat 
as needed.

• When in doubt, you can always use an abso-
lute path. If your files are just saved locally on 
your computer, then the absolute path might 
look something like this: href="/Users/
nellie/documents/my_site/styles.
css". An absolute path to CSS for a live site 
might look like this: href="http:// 
nelliemckesson.com/css/styles.
css"

External stylesheet:

Internal stylesheet:

9 of 13



CSS and HTML for Designers
Nellie McKesson

Download the sample files: https://bit.ly/2GdSGde

Previewing Your Work
Of course you need to be able to preview your work! You have a few 
options, depending on where you’re at in the design process. 

Open Your Files in the Browser
The easiest way to preview is simply to open your file in a browser window 
and see how it looks. You don’t need your HTML and CSS files to be hosted 
anywhere online—you can do this locally, right on your computer, without 
ever connecting to a network. 

1. Open a file navigator window (Finder for Mac users, Explorer for Win-
dows) and navigate to the location of your HTML file.

2. Right-click/control-click/command-click on your file name.

3. From the menu that appears, select your operating system’s version of 
“Open with…”.

4. From the list of programs, choose the browser you want to use.

Live Code Previewers
If you’re just trying to get a few CSS rules to work the way you want, a live 
code previewer can save you a lot of time. Live code previewers are typically 
websites where you can put your HTML and CSS into an editor window, and 
then immediately display a preview of the result. You can edit your HTML 
and CSS right there in the browser window and see how your site will be 
affected. There are many code previewers to choose from today; here’s a list 
of just some of them:

• JS Fiddle: https://jsfiddle.net/

• JS Bin: http://jsbin.com

• W3Schools TryIt Editor: https://www.w3schools.com/html/tryit.
asp?filename=tryhtml_intro

• Scratchpad: http://scratchpad.io/

• LiveWave: https://liveweave.com/

• CSS Desk: http://www.cssdesk.com/

Using Browser Developer Tools
Another great way to troubleshoot and inspect your site is to use the 
browser’s built-in developer tools. You can use these tools both on live sites 
on the Web (whether you created them or not) and on sites that you’re 
building locally, before you’ve uploaded them to the Web. Each browser 
offers slightly different options (my personal favorite is Google Chrome), 
but will generally give you options to inspect the HTML markup for specific 
elements or for the whole page, make changes to the CSS and see how it 
will look, and inspect the CSS to see where the styles are coming from (since 
many websites use multiple stylesheets, all of which cascade). Here’s how to 
access developer tools in a few of today’s most popular browsers:

• Chrome: Go to View > Developer > Developer Tools. If you just want to 
see what the HTML for a site looks like, then go to View > Developer > 
View Source.

• Safari: Go to Develop > Show Web Inspector. If you don’t see the 
Develop menu in the menu bar, choose Safari > Preferences, click 
Advanced, then select “Show Develop menu in menu bar.”

• Firefox: Go to Tools > Web Developer > Toggle Tools. 

• Internet Explorer: Go to Tools > F12 Developer Tools.

If you’re using a different browser and aren’t sure how to access the 
developer tools (or if they even have any), search online for “[insert your 
browser name] developer tools”.
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Units of Measurement
In browsers, the standard unit of measurement is the pixel (px in CSS 
shorthand), which falls into the ‘absolute lengths” category. This means 
that when you define a length using a unit like pixels, inches, or centime-
ters, elements will be displayed at exactly that size regardless of whether 
there’s enough space in the browser to fit the entire length. The other class 
of units—”relative length” units—are defined relative to the length of some 
other property (for example, the size of the browser window or the user’s 
chosen font size). Check out the CSS Units reference on W3Schools for a full 
rundown of all your unit options: https://www.w3schools.com/cssref/
css_units.asp

When defining your CSS measurements, the unit must directly follow the 
size value and may not be separated by a white space. I.e., do this: 2px; not 
this: 2 px. The exception is when you’re setting the size to a value of “0”, in 
which case no unit is required. I.e., both 0px and 0 are ok.

A Note About px (Pixels)

When you’re working with pixels, bear in mind that pixel size is actually relative to the viewing 
device, rather than being a universal fixed size. For example, on a low-res computer monitor, 1px 
corresponds to a single screen pixel, as you’d expect. However, on hi-res devices, 1px actually 
equates to multiple screen pixels, which could cause your webpage to look shrunken or otherwise 
distorted. A quick fix for resetting the pixel value for hi-res devices so that they behave more like 
lower-res browsers is to add this line to the <head>:

The Box Model
Every HTML element is made up of a series of nested boxes, and these 
boxes are used to design the different areas of an element—this is called 
the “box model”. Each box consists of four pieces:

• Margin: the space between an element and the elements around it

• Border: the border around an element

• Padding: the space between an element’s border and its content

• Content: the actual content of an element (both text and other nested 
elements)

Actual content of the 
element

Margin
Border

Padding Content

Use the margin, border, and padding CSS properties to adjust the way ele-
ments are positioned relative to each other, and to position the content 
within an element. You can define every side of a box individually, as shown 
on the left below; or define them all at once, as shown on the right:

 

Check out the details for each specific property to learn more about its 
options and syntax (https://www.w3schools.com/cssref/default.asp).

11 of 13



CSS and HTML for Designers
Nellie McKesson

Download the sample files: https://bit.ly/2GdSGde

Accessibility
Accessibility refers to how accessible your content is to all users, including 
hearing-impaired users, vision-impaired users, and other differently-abled 
groups. Good HTML semantics are one of the most important things you 
can include to make your content accessible, as noted on page 5 of this 
handout. Additionally, the very act of using CSS and thereby separating 
design from content can improve the accessibility of your site, by allowing 
users to apply their own custom stylesheets that override designs that may 
be difficult for them to interpret as-is. 

Some examples of potential hazards to accessibility are things like color 
contrast between text and its background, elements that are hidden via 
display: none, fixed font sizes that are very small, or content that is 
structured non-linearly (and thus would be difficult for screen-reading 
software to present to users in a way that makes sense). Read this article for 
a primer on thinking about accessibility: https://developer.mozilla.org/
en-US/docs/Learn/Accessibility/CSS_and_JavaScript.

The ARIA standard is a way to make Web content accessible to more 
users, by adding extra information that is used by assistive technology. 
It requires extra attributes to be added to certain types of elements. For 
example, if you have a navigation menu on your site, you’d add an extra 
role="menuitem" attribute to each item in the menu, like this:

Read more about ARIA here: https://developer.mozilla.org/en-US/docs/
Web/Accessibility/ARIA.

Responsive Design and Media Queries
Designing responsively means creating designs that can adapt to any type 
of screen—a browser on a PC, a tablet, a phone, or however else people are 
consuming media. The requirements are different depending on the type 
of content you’re producing (for example, your team might make a choice 
to disable certain features for mobile users), but the general rule in 2018 is 
that responsive design should be a standard part of the design process, not 
something special. 

Media queries let you add special instructions for how to handle ele-
ments differently at different screen sizes or media types. Here are some 
tips:

• Media queries start with the @media rule, and then instead of a selec-
tor, they include a set of conditions that must be met in order for the 
query’s rules to be applied, like a minimum screensize or orientation. 

• Your CSS rules should be nested inside the media query’s curly brackets.

• The size at which the media query becomes effective is called a 
breakpoint.

• Most people put media queries at the end of their CSS file, to override 
the cascade.

Read more about media queries here: https://developer.mozilla.org/
en-US/docs/Web/CSS/Media_Queries/Using_media_queries.
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Download the sample files: https://bit.ly/2GdSGde

Exporting HTML and CSS from InDesign
To export HTML (and optionally CSS) from InDesign, go to File > Export, and 
choose HTML from the Format dropdown menu.

InDesign will open up the HTML Export Options pane, where you can 
configure a few options for the exported HTML. You can also choose to have 
InDesign translate your design into CSS to go along with the ouput HTML, 
though be warned that the code this generates could be messy.

You can also fine-tune your exported HTML via your paragraph styles. 
Open the Paragraph Style Options pane for any style and go to the Export 
Tagging tab. There, you can configure the following:

1  HTML tag: You can choose from a small list of options, or you can type 
in a tag name of your choice.

2  Class: Apply the class name of your choice to the exported element.
3  Emit CSS: Translate your style configuration to CSS along with the 

HTML. You can see a preview of what the generated CSS will look like in the 
Export Details preview window ( 4  ).

1

2

3

4

Frameworks
You may find that your development team wants to use a framework as 
a starting point for your site’s functionality and design. Frameworks are 
predefined toolsets that can make site development a lot easier, by letting 
you create things like grids, dropdowns, and other utilities simply by adding 
a few classes to your HTML. However, they also tend to result in somewhat 
generic-looking sites. Here are some of the most popular frameworks today:

• Bootstrap: http://getbootstrap.com/

• Semantic UI: https://semantic-ui.com/

• Bulma: https://bulma.io/

• UIKit: https://getuikit.com/

• Foundation: https://foundation.zurb.com/

• Miligram: https://milligram.io/

Resources and References
• HTML elements: https://www.w3schools.com/tags/default.asp

• HTML global attributes: https://www.w3schools.com/tags/ref_ 
standardattributes.asp

• HTML & CSS colors: https://www.w3schools.com/colors/default.asp

• CSS selectors: https://www.w3schools.com/cssref/css_selectors.asp

• CSS pseudo classes: https://developer.mozilla.org/en-US/docs/Web/
CSS/Pseudo-classes

• CSS pseudo elements: https://developer.mozilla.org/en-US/docs/
Web/CSS/Pseudo-elements

• CSS properties: https://www.w3schools.com/cssref/default.asp

• HTML and CSS, by Jon Duckett (book): https://amzn.to/2IIBy4R

• Stack Overflow (a forum for developers to get help from eachother): 
https://stackoverflow.com/questions/tagged/css
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Creative Cloud Libraries
Creative Cloud (CC) Libraries is a built-in brand system that empowers creatives across organizations to create more consis-
tent brand experiences with less effort. It appears as a panel within the core CC desktop apps to provide easy access to core 
design assets, ranging from color swatches and character styles to more advanced components such as vector graphics, 
image-based graphics, patterns, brushes, videos, animations, 3D models, and more. Its main goal is to maintain creative con-
sistency and increase production efficiency across personal and team workflows by organizing, reusing and linking assets.

Where can you use CC Libraries?
The most obvious way of creating and adding assets to a Creative 
Cloud Library is via one of the design applications. Most Adobe 
applications support Creative Cloud Libraries and the way to add 
assets to them is exactly the same for all asset types. Do note that 
not all asset types are supported in all Adobe applications so you 
might sometimes see some assets being grayed out.

Also you have to keep track of what you’re doing. Sometimes 
you’ll notice that assets are linked to the library panel, giving you 
the ability to globally update that asset over multiple documents. 
But some assets are not linked to the library and you have to 
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figure out which are and which aren’t. But knowing this will help you avoid 
unpleasant surprises. And the circumstances for this behavior depends on 
the type of asset in combination with the Adobe application in which you’re 
using it. So keep your eyes open and the libraries panel will be nice to you.

Creative Cloud desktop apps that have the panel include:

• Adobe Photoshop

• InDesign

• Illustrator

• After Effects

• Premiere Pro

• Animate

• Dimension

• Dreamweaver

• Adobe XD* 

*currently allows consumption but not modification of assets in existing CC 
Libraries

Which asset types are supported?
Types of assets that can be added to CC Libraries include:

• Colors: Color, Color Themes, Gradients

• Typography: Character Style, Paragraph Style, Text

• Styles: Layer Style, Looks

• Brushes: Brushes

• Graphics/Symbols: Vector-based graphics, patterns, pixel-based graph-
ics (jpg, png, etc)

• Motion: Animations, Videos

• 3D: Models, Materials, Lights

• Template: ID/PS/ILL Templates, Motion Graphic Templates (MOGRT’s) 
(Note that templates are only supported when downloaded from Adobe 
Stock.) 

What is the added value of CC Libraries?
There are many advantages to using CC Libraries in a design workflow. 

And many companies have implemented this solution in their own way. A 
couple of these advantages are:

1. Work across graphic design, illustration, UX/UI design, 3D and motion 
design, and video production.

2. Drive the consistency of digital assets.

3. It’s natively built into and maintained for future releases of CC apps –
not dependent on 3rd party plug-ins.

And because of these advantages, an organization can leverage CC Libraries 
for a wide variety of use cases, including:

• Brand management: a company’s style guide or a retailer’s seasonal 
guides.

• Project-based collaboration: a full-service creative team’s campaign or 
product design system.

• Input into UX/UI kits used by screen designers

• A creative’s own repository of favorite assets

• Creation of a moodboard for a specific project

• Sharing assets with external freelancers who don’t have access to the 
company server.
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Adobe recently brought out an update for CC Libraries, enabling two interesting new features:

1. You can now sync Typekit fonts included in a Character Style directly from the library.

2. You can drag and drop files from your OS directly into the library, withoug having to open the file 
first in a CC app. Supported file types are AI, PNG, BMP, PSD, SVG, GIF, JPEG, TIFF and PDF.

Also, at the time of this writing, I can also already disclose that more exciting updates are coming. as 
you’ll soon have the abillity to export and import libraries. This allows users to download a library as 
a backup and locally load this library onto multiple computers. (We’ll see ;-)

How to use CC Libraries

Creating a CC Library
1. In InDesign, open the CC Libraries panel 

by choosing Window > CC Libraries.

2. From the panel fly-out menu choose 
“Create New Library”.

3. Give it a name and press OK.

CC Libraries FAQ
• How many Creative Cloud Libraries can I 

create? 
You can create as many libraries as you want. 
As long as you have storage available in your 
Creative Cloud account.

• Can the library ever be full? 
You can store up to 1,000 items per library.

• Do I have to be online to use them? 
You can use library items while being offline 
since these are cached. But triggering updates 
and uploading new assets requires you to be 
online.

• Do I need Creative Cloud to use them? 
Trial users get 2Gb of storage with their free 
Adobe ID. So technically you don’t need a 
Creative Cloud membership but it’d be very dif-
ficult to use libraries without desktop apps.

• Can I use CS6? 
You can’t use the libraries panel in CS6, but 
you can share and store files on Creative Cloud 
storage using a free Adobe ID instead.

• Is everything I use always linked online? 
No, you can choose to unlink library items 
when using them in your design, avoiding 
unwanted changes during updates. This 
behavior does depend on the desktop app 
you’re using.
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Adding an item from your page
The easiest way to add something to a library is by selecting it and then 
dragging and dropping it into the libraries panel. When you do this in a pro-
gram like Adobe InDesign, the asset will be stored as an InDesign snippet 
which is exactly the same file format that an InDesign Library uses (remem-
ber those libraries? You created these by choosing File > New > Library, so 
don’t confuse Creative Cloud Libraries with the native InDesign libraries. 
 

Remember that because we’re working with snippets, the Creative 
Cloud Library will only save XML and formatting settings. But all the other 
resources that are needed to keep the asset intact e.g. the font on your hard 
drive (or TypeKit), or the link to the original image, are still required to suc-
cesfully reproduce the library asset in a different document. So remember 
that fonts are never copied into the library, they are merely referenced. The 
only here exception is when using Adobe Typekit fonts.

What about images?
Saving images into a library will give you a different result depending on the 
application you’re using.

• When you drag placed images from InDesign into the Libraries panel to 
save and re-use them in another InDesign document they’ll be used as 
InDesign Snippets. And these will still reference the original location of 
the placed image (offline local link). If the original referenced image isn’t 
available when reusing the asset, a missing link will occur.

• When you drag images from Photoshop or Illustrator into the Libraries 
panel and then use them in InDesign they’ll be linked as online assets.  
So the actual image itself is stored in the library, not just the link to it on 
your HD. Because of this, you can never have a missing link when plac-
ing this asset into e.g. Adobe InDesign.

Saving text styles
You can save your Character- and Paragraph styles in a library in Adobe 
InDesign. Saving your styles can be done in 2 ways:

• Put your text cursor in the text that is using the style and then click the 
“Add xxx style” button in the libraries panel. 
 

• You can also add it directly to the library while creating the style.
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Keep in mind that reusing these styles will give you the experience you’re 
expecting in other InDesign documents. Clicking the style in the libraries 
panel will apply it and copy it to the libraries panel. Do keep in mind that 
the style is copied over to the new document when applying it and there is 
no live link. This means that changes to the style will not be applied to the 
library nor to other documents where the same style was used.

Careful when saving Paragraph Styles from Adobe 
InDesign into a CC Library
Most design applications like Photoshop only have the ability to use Char-
acter Styles via the libraries panel. And even though Photoshop does have 
a Paragraph Styles panel, it can only use Character Styles from the Libraries 
panel. This means that when you want to reuse your text styles in Photo-
shop, you need to create a Character style instead. The same counts for the 
video apps like Premiere Pro or After Effects.

Saving colors
Saving colors is just as easy as everything 
else. Note that libraries support both indi-
vidual colors and color themes e.g., from 
Adobe InDesign or Adobe Capture CC, the 
mobile app.

Clicking a saved color will add this color 
as a swatch to an Adobe InDesign docu-
ment, but won’t in Photoshop or Illustrator 
where it will only apply the color instead. 
It’s important to learn these differences 
when managing branded assets in multiple 
programs. 

Careful when saving colors into a CC Library
Libraries support RGB, hex and CMYK colors. But remember that colors are 
added the way they were built. Hover over a library color to see the name of 
the color, its hex value, and then the original color values (which sometimes 
can be a bit confusing.)  

In this InDesign example, the gray color was 
originally CMYK but was converted to RGB so it 
could be used in a Publish Online project. And 
though the original name of the swatch is still 
implying it’s a CMYK swatch, it actually isn’t. 
Notice the actual RGB color values at the 

bottom of the yellow pop-up. There is currently no support for spot colors. 
If you add a spot color into a library, these will be added as a process color.

Reusing assets

Using Creative Cloud applications
When you drag an item from the library to your page or artboard remember 
to keep an eye out for that little cloud icon. This means the asset is linked 
and can be updated globally across multiple applications and documents.

This icon can appear in Adobe InDesign where you’d usually see the link 
icon when using images. And it can also be seen in the Links panel itself. 
Make sure that you’re online and you see this cloud icon when printing or 
exporting to hires PDF from Adobe InDesign. 
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Other applications like Adobe Photoshop or Adobe Illustrator will always 
place the full resolution graphic so it’s ok if you’re offline when you’re deliv-
ering your final product. Notice that you can also place unlinked copies of 
the same graphic in most design applications. Hold down the Alt (Option) 
key while placing the image from the library, or alternatively you can right-
click and choose “Place Copy” instead of “Place Linked”.

Updating assets
• For colors, you can right-click the swatch in the CC Library and choose 

“Edit”. Note that this will only update the CC Library item and not the 
document(s) in which it was used since there is no live link.

• You can double-click InDesign snippets to edit and update it in InDesign 
and save it back into the CC Library. Note that this will only update the 
CC Library item and not the document(s) in which it was used since 
there is no live link.

• Text styles need to be recreated and added to the library after which 
you then manually delete the old asset. You can do this by dragging the 
item to the panel trash icon.

• When you have saved images and vector shapes from Adobe Illustrator 
or Adobe Photoshop you can double-click the asset in the libraries 
panel to open the original. When you then edit and save the asset it will 
overwrite the original and update all linked instances in all applications 
and documents.

Replacing assets
Replacing assets is similar to updating assets but not entirely:

• For colors, text styles and InDesign snippets, see above.

• Using either the Links panel in Adobe InDesign or Illustrator, or right-
clicking a layer in Adobe Photoshop you have the option to replace 

the item with a library graphic. When doing so the program will give 
you the option to choose a different asset from the libraries panel as a 
replacement.  
 

Sharing assets

Sharing a link
There are a few ways to hand over your library to others. Whether this is a 
client, co-worker or freelance designer you want to be sure that they always 
have access to the latest brand assets.

And since you don’t want some people to change the original assets it’s 
important to give them a copy and not the original one you created. You 
can share your library with others either by using the “Share Link” option 
from the libraries panel fly-out menu, or by using the Creative Cloud asset 
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website. When you do, you’ll send a link which others can open. And if they 
are Creative Cloud users they’ll have the option to save a copy of the library 
into their own account. That copy is theirs to use and edit as they like and 
will not be updated if changes are ever made to the original library.

From the Send Link options it is however possible to click the Follow 
button which will give the user an updated library whenever the source is 
updated, but with read-only permissions. 
  

Collaborating with others
A different way of sharing your work is by using the “Collaborate” option 
which you can again find from either the libraries panel or the Creative 
Cloud website.

The difference with “Share Link” is that you’re actually sharing the same 
library with others. Giving them the option to make changes, additions or 
remove existing items. This is something that could be interesting when 
working in the same team. But if you want to keep your brand experience 
consistent it is important that some collaborators have read-only access 

instead. And you can set these permissions while sending out the invita-
tions to collaborate, or update these later. 

Creative Cloud storage
Every Creative Cloud subscription comes with xx GB of storage, depending 
on the type of subscription you have. But most CC users will have 100Gb of 
storage available. That doesn’t sound like a lot, especially when you com-
pare this to other environments like Dropbox or OneDrive. But it’s important 
to understand that the underlying strategy behind the CC storage is differ-
ent when compared to other storage solutions that easily offer you 1TB. 

The main reason why you have storage available within CC is because 
it allows apps and services to leverage that storage while working on a 
project. So typically you can consider the CC storage as temporary space in 
which files and assets flow while you’re working on a project. It’s not meant 
to replace your NAS or local server.

CC storage is automatically enabled for most CC users. But some enter-
prise customers’ IT dept’s have disabled this for internal reasons. Enabling 
CC storage allows you to use these services:

• Adobe Sign

• Adobe Spark

• Market

• CC Libraries
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• Behance and Portfolio

• Extract

• Typekit

• PDF services

• Lightroom Mobile

• InDesign Publish Online

• XD Publish Services

• Team Projects

Fortunately for us, only services like assets, CC Libraries, mobile creations 
and Lightroom images will count against your storage quota. You can 
always track your quota by using the Creative Cloud Desktop app.

How does it work?
It’s important to understand that with the current version 
of CC storage there is always a tight relationship with your 
desktop computer. When you activate storage (which is 
done so by default) the Creative Cloud Desktop App will 
place a folder on your HD called “Creative Cloud Files”. This 
is a hot folder that is synced to Adobe’s cloud environ-
ment. Whenever you place a file or folder into this local CC Files folder, these 
files will be backed up and synced to the cloud environment. This enables 
certain advantages:

• You’ll have these files available to you whenever you log in with your 
Adobe ID.

• Other mobile apps and services can use assets stored in the cloud.

• You can share and collaborate on specific files and folders.

• Users can comment on files.

• You can view specific file properties in a browser that are not possible 
using your OS alone, e.g. layers in a Photoshop document.

• It’s possible to go back several versions of your document, even if you’ve 
overwritten the original (note: this features is under re-development at the 
time of this writing).

It is also interesting to know that users have the ability to purchase addi-
tional storage, per 1TB with a maximum of 10TB in total. Do note that 
everything that is stored in the CC Files folder gets synced to the cloud 
environment and vice versa. Adding a file via your web browser will also 
sync that file to your local HD. This means that in practice you’ll spend the 
same amount of disk space on both the cloud and the HD simultaneously. 
This might cause storage or bandwidth problems to some users. But Adobe 
is constantly trying to optimize how these services work. And as storage 
size will only increase in a cloud-driven world, so will the amount of control 
you’ll have using Creative Cloud services in the future.

Viewing your assets

From a computer
The easiest way to inspect your CC assets or CC Libraries is of course by 
launching one of the design applications in which you’ve created them. But 
there’s another way as well.

Remember that your assets are synced to the cloud. And you can access 
that cloud environment yourself by opening a web browser and navigating 
to http://assets.adobe.com

From here you can view all your online libraries, mobile creations and 
other online files. 
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From a mobile device
Many users still haven’t discovered the Creative Cloud mobile app for iOS and 
Android (and even Apple Watch). It’s a handy little tool to keep with you. With it you 
can browse through your files, mobile creations, libraries, LR Mobile images and 
more. You’ll receive push notifications when you get feedback on your project, you 
can share assets with others and search for Adobe Stock images. 
Also note that most other Adobe mobile apps like Adobe Capture, Adobe Sketch, 
Adobe Comp and many others also use Creative Cloud Libraries. So you’ll always 
have access to your saved assets.

Adobe Typekit
In 2011, Adobe acquired a solution called Small Batch and implemented it in the (then brand new) 
Creative Cloud under the name of Adobe Typekit. Adobe Typekit offers designers a wide and versatile 
library of design fonts for online and offline use. Adobe works with over 100 type foundries that supply 
Typekit with fresh fonts every month, which become instantly available to all Creative Cloud users.

I personally believe that Adobe Typekit is one of the most valuable additions to Adobe Creative 
Cloud. The font library offers a very wide range of fonts to designers and I find myself using only fonts 
that come from Typekit for my demos and design projects. There 
are a few other advantages to Typekit, including:

1. The ability to quickly filter fonts by size and type.
2. Multilingual support for fonts.
3. Typekit fonts or OpenType format that work on both Mac+PC.
4. The fonts are of high technical quality, allowing users to use 

them in CSS, ePUB, PDF and print.
5. Typekit is tightly integrated with all of CC’s mobile and desk-

top apps.
6. Typekit even offers a visual search feature, allowing you to 

upload a picture for immediate font identification.

Typekit FAQ
• Do I have to pay for Typekit? 

Typekit is available to anyone in multiple 
plans and subscriptions, but a “Portfolio” 
subscription is also included in your Creative 
Cloud membership.

• Are there any restrictions? 
With the Typekit plan included in CC, you are 
limited to syncing up to 100 fonts at a time. 
But you can always unsync fonts and choose 
others instead.

• Do I have to be online to use the fonts? 
No, fonts are downloaded in a hidden folder 
for offline use. Just make sure the Creative 
Cloud Desktop App is running, which acts as 
the font vault.

• Are Typekit fonts included when creating 
an InDesign package? 
No, only the reference to the font. So anyone 
opening the ID doc will need to have Typekit 
available. Not a problem for CC users.

• Can I upload my own fonts to Typekit? 
No. Typekit is a font library from which you 
choose what you want to use. It is not a font 
management system like FontExplorer or 
Suitcase.
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Adobe Market
One of the best hidden gems in Adobe Creative Cloud must be Adobe 
Market. This is a royalty-free curated gallery of assets, available for free to 
all Creative Cloud members (with the exception of the Photography plan). 
These assets range from user interface elements to patterns, product place-
ment models (e.g. mobile devices), brushes, icons, etc.

Stop Googling for icons and other 
assets, use Adobe Market instead. 
Why?

• You’re not allowed to use assets 
from sources like Google in your 
work since you don’t own the 
rights.

• As a CC member, you’re already 
paying for the assets included in 
Adobe Market.

• All assets are handpicked by the 
Market team and come from 
Adobe Behance. So these assets 
are created by designers.

• There’s a wide variety of assets, 
including many rich Photoshop 
documents.

• Market is connected to CC Librar-
ies, storage and many CC mobile 
apps.

Keep in mind that even though these 
assets are offered to all CC members 
for “free” (well, they’re included in your CC membership), there are always 
certain limitations. All assets are royalty-free which means you can use and 
edit them as you like. But this license also restricts you from sharing these 

with users that don’t have a CC membership. Of course you’re free to reuse 
and backup these elements as you see fit. But remember that despite being 
able to use these as you like, you don’t own these assets. This prevents you 
from e.g. downloading a coffee icon and copyrighting it as the logo of your 
customer’s coffee bar. Because the icon is not yours to copyright.

Adobe InDesign Publish Online
Adobe InDesign offers users a unique way of publishing your InDesign 
documents online in the form of an interactive experience. It offers design-
ers an alternative way of presenting their work online, without having to 
leave their InDesign comfort zone.

The process itself is very simple. You simply design your InDesign docu-
ment as an interactive project, meaning something you’d prefer to see in a 
landscape orientation using RGB colors. Next, you add interactive features 
using InDesign’s tools and panels. Popular examples of interactive features 
are:

• Buttons

• Slide shows

• Audio and video

• Hyperlinks

• Animations

• HTML (e.g. embedded YouTube 
videos or Google Maps)

When you’re done with your layout it only takes the push of a button to 
push your layout online as an interactive file. InDesign will upload and 
convert your file to HTML5, making your document viewable on all mobile 
and desktop browsers. Do keep in mind that these files aren’t responsive. 
So viewing a landscape document on a smartphone will scale down the 
design, sometimes making it difficult to read.
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Getting started
Start by creating a new document in Adobe InDesign. You can use com-
mon screen resolutions like 1024x768 or choose a 16/9 aspect ratio instead. 
Remember that InDesign comes with interesting and free templates from 
Adobe Stock. You can choose these templates when creating a new docu-
ment. Notice that the “Mobile” category has multiple digital magazine 
layouts that you can use. But whatever you choose, just make sure you’re 
using pixels as units and that your colors are in RGB. Technically you can also 
use CMYK or spot colors but it’s more predictable to work in RGB instead, 
especially when combining assets from other documents or programs like 
Photoshop or Illustrator.

Adding interactivity
There is a wealth of information available about InDesign’s interactive fea-
tures. And some people, like Diane Burns, have even created entire Lynda.
com courses on using InDesign Publish Online and creating animations with 
Adobe InDesign. Here’s a quick overview of the available options.

Buttons
You can convert almost anything into an 
interactive button. Choose Window > Inter-
active > Buttons and Forms to bring up the 
right panel. While having an object selected, 
click the “convert to button” icon at the 
bottom of the panel. Optionally, you can 
change the button appearance by selecting 
the Rollover and Click states and changing 
the object’s formatting. When you’re done 
it’s time to add an action to your button. 
Make sure you have the right Event selected 
and then click the plus symbol to add an 
action (note that some actions are PDF only). 
Choose the appropriate action and set up 
additional settings, if required.

Keep in mind that it’s always good prac-
tice to place certain buttons e.g. those that 
navigate back to the table of contents or with 
“next” or “previous” page destinations on the 
master page of your document.
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Multi-state objects
Multi-state objects (MSO) are objects that 
consist out of multiple other objects, of which 
each of them have been assigned a state. 
MSO’s can be used to build slideshows or to 
show/hide specific content. A MSO is a very 
versatile feature in InDesign, but try and 
remember these rules:

• A multi-state object needs to have at least 
two objects (though there are “tricks” when using only one). This is 
because a multi-state object is a MULTI-state object, which means you 
need more than one item.

• A multi-state object can only have one of its states visible at a time. It is 
impossible to have two states of the same multi-state object visible or 
active at the same time.

• It is possible to nest other interactive objects into a multi-state object. In 
fact you can put any object you like into a multi-state object … except 
another multi-state object.

• When using a multi-state object to build a slideshow, multi-state objects 
will play their respective states from top to bottom in the list.

Choose Window > Interactive > Object States to open the correct panel. 
Then select all elements you want to include into your MSO. Click the page 
icon at the bottom right of the Object States panel to convert your selection 
into a MSO.

To navigate a slideshow you’ll need to create a separate button that has 
a “Go to Next State” action applied to it. Optionally, you can also use “Go to 
State” or “Go to Previous State” buttons to navigate the slideshow.

Hyperlinks
Hyperlinks are widely supported when using 
Publish Online. You can use hyperlinks to create:

• URLs

• Emails

• Page destinations

• TOC markers

• Index markers

• Cross references

Choose Window > Interactive > Hyperlinks. Select an object or use the Type 
tool to select text. Then click the hyperlinks panel menu and choose New 
Hyperlink. From here you can add various additional settings.

Animations
InDesign has taken a very simply approach 
when it comes to using animations. There 
is no visual timeline or keyframes to take 
care of. Instead you can choose from a list 
of existing animations and apply these to 
your objects.

Choose Window > Interactive > Ani-
mations to open the Animations panel. 
Select the object you wish to animate, 
then choose one of the presets from the 
Preset list. Use the remaining options to 
change the animation speed and timing 
options. You can also use the Buttons and 
Forms panel to let buttons trigger the start 
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of your animations. Try to experiment as much as possible as it is possible 
to create more advanced animations by playing around with buttons and 
groups of objects, each holding multiple pre-animated objects. 

Audio and Video
Adding audio and video files are obvious choices when creating an interactive 
document. You can place these files just like you would place text or images, 
by using the File > Place command. Just keep these settings in mind:

• For audio, be sure to use an .MP3 format.

• For video, keep your file as light as possible and use an H.264 codec and 
.MP4 file format. You can convert your video files using tools like Adobe 
Media Encoder or Handbrake.

Choose Window > Interactive > Media to set various controls for video and 
audio playback. Also note that you can use buttons to operate your video 
and audio files.

Publishing your document
1. When you’re finished. Click the Publish Online button at the top of 

your screen.

2. Set a title and description for your document and choose the page 
range. Also notice you can choose to also include a print PDF version 
of your document as a separate download.

3. In the advanced section you can set up various other options. I rec-
ommend setting a custom thumbnail for your work and setting your 
image resolution to 150ppi, unless your document has a lot of images 
and videos embedded.

4. Optionally, choose the PDF preset that can be used to download a 
local version of your Publish Online document once shared. Do note 

that this PDF version won’t have many of the interactive features you 
designed since it’s an offline document and many features aren’t sup-
ported in PDF viewers e.g. HTML, MSO or animations.

Various other options
Navigation
Keep in mind that the Publish Online interface already provided the user 
with various methods of navigation like page navigation and a thumbnail 
view for jumping to different pages. You can also share your work using 
social media or even get the embed code to your project. This way you can 
embed your Publish Online document into your own website. Try to learn 
more about this native navigation before designing your document.

Analytics
Publish Online will automatically track various metrics for you. To see these 
metrics, choose File > Publish Online Dashboard. Interesting metrics will be 
measured like average read time, views and used devices. Keep in mind that  
metrics are recorded with a delay of a few hours, so it’s a good practice to 
check “the next day” when creating reports.
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Adobe Stock
Adobe Stock is a massive collection of over 110 million assets, curated by 
Adobe. It consists out of various types of content, including:

• Microstock images

• Premium images

• Illustrations

• Vector shapes

• HD and 4K video

• 3D objects, materials and lights

• Templates

• Editorial content

Credits for purchasing content via Adobe Stock is not included in your Cre-
ative Cloud membership, but designers can use the low resolution images 
and video for building mockups for free. Getting credits for Adobe Stock can 
be done by either subscribing to Adobe Stock via http://stock.adobe.com, 
or by including Stock credits into your Creative Cloud for Enterprise 
contract. 

The great thing about Adobe Stock is that it is very well integrated with 

Adobe Creative Cloud’s applications. Every application that has the ability 
to use Creative Cloud Libraries can take advantage of Adobe Stock’s deep 
integration with Creative Cloud. But there are other advantages to Stock:

• A collection that is growing every day.

• Partnerships with other stock vendors e.g. Stocksy, Reuters and others.

• Intelligent search capabilities like smart filters and image based 
searches.

• Integration with desktop and mobile apps.

• 1-click licensing and updating of projects.

• Adobe Stock for Enterprise (which is a subset of Stock, only available 
directly from Adobe) offers granular control over credit consumption, 
reporting and user management.

Finding Stock images from within InDesign
1. Choose Window > CC Libraries to open 

the Creative Cloud Libraries.

2. Use keywords to find an image.

3. When you found an image you like, 
hover over the image and click on the 
second icon (the cloud icon) to down-
load a low resolution watermarked 
version of the image into your current 
library.

4. Now drag the image out of the library 
and on to the document. You’ll see the 
image is now loaded in the cursor and ready to place.

5. Place the image.
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Finding Stock images from the Stock website
• Use keywords to find your image.

• You can also drag an image onto the page to perform a visual search.

1. Use the Filters option on the left to add additional requirements e.g. 
the Depth of Field or Vivid Color filters.

2. Click the image you like.

3. Add a low resolution image to a CC Library.

Licensing Stock images from within InDesign
Once you’re happy with the image you want, you can license it. Licensing 
an image requires Adobe Stock credits which are sold separately. Licensing 
involves downloading a high resolution version of the image, removing the 
watermark, replacing the low resolution version and updating all artwork in 
all projects in all applications that had a live link to this image.

1. License the image in one of these ways:

2. Right-click the low resolution image in the library and choose “license 
image”.

3. Click the shopping cart icon in the top right corner of the image. 

4. Use the Links panel.

5. Now InDesign will ask you if you want to use one of your credits for 
this purchase.

6. Confirm the image license and watch the magic unfold.

Adobe mobile apps

Adobe Capture CC
Use Adobe Capture to collect and generate assets and 
inspiration on the go. It’s a nifty little app that’s available on 
iOS and Android. The app uses the camera of your device to 
capture and covert images and shapes into assets that are 
stored in a Creative Cloud Library. Use it to capture:

• Shapes

• Color themes

• Character styles

• 3D Materials

• Brushes

• Patterns

Adobe Comp CC
Can you feel an idea bubbling up to the surface? Then forget 
about scribbling it down onto a napkin. Use Adobe Comp 
CC instead. I’d recommend using Comp CC on a tablet but 
it’s also available for smartphones. Adobe Comp CC is an 
application that allows you to lay out a simple document 
using gestures for drawing shapes and assets from various sources, incl. 
Lightroom Photos, CC Libraries, Adobe Typekit and Adobe Stock. It allows 
you to mock up a first version of your design and later send it off to InDe-
sign, Photoshop or Illustrator with just one click of a button. Adobe Comp 
CC is an app I keep with me at all times because it’s easy and fun to use and 
integrates very well with Creative Cloud’s services.

Adobe Acrobat for mobile
Adobe Acrobat for mobile devices gives you a powerful PDF 
viewer for your phone or tablet. It allows you to do several 
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useful things e.g.:

• Open PDF documents directly from your email

• Saving PDF documents onto cloud services like Adobe Document 
Cloud, Adobe Creative Cloud or Dropbox.

• Annote PDF documents and send them back

• Export PDF documents to Office formats.

• Fill and sign electronic forms.

• Use Adobe Scan app to scan and search paper documents.

Personally I find the Adobe Acrobat and Adobe Scan mobile apps to be 
invaluable for my daily administration.

Extra resources

• Creative Cloud Libraries overview

• Detailed list of all library features in all products and services

• Collaborating using read-only workflows

• Creative Cloud libraries productivity study

• Using Creative Cloud assets

• InDesign Publish Online

• Using Adobe Comp CC

• Adobe InDesign + Adobe Stock productivity report

• Using Adobe Reader on mobile
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In this session you will learn how to build a complete “content-first” 

mobile app yourself for less than $200! We will use InDesign, in5, and 

Adobe PhoneGap Build. This method works well for projects such as 

travel guides, “how-to” apps, or interactive annual reports.

Make a Mobile App with InDesign
Keith Gilbert
www.gilbertconsulting.com
kgilbert@gilbertconsulting.com
lynda.com/keithgilbert
twitter: @gilbertconsult
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What this is about…
Today I will be describing the process of building a mobile app using 3 pri-
mary components:

1. Adobe InDesign (version not important)

2. in5 from Ajar Productions

3. PhoneGap Build (included with a Creative Cloud subscription)

Build an app for in5-generated content
in5 exports your app content to a folder that contains HTML, CSS, and Java-
Script. This content is ready to include in an app, but in5 doesn’t include the 
functionality to build the app. There are several methods for building apps 
that don’t require writing any code. You can use your choice of these meth-
ods to create an app to house your in5-generated content.

Build a single-issue app with in5 content

If you want to create a “single issue” app, that is, an app that consists of a 
single bundle of content that isn’t updated on a regular basis, Adobe Phone-
Gap Build (build.phonegap.com) is one way to build a single issue app for 
iOS, Android, and Windows devices. PhoneGap Build is completely free for 
Creative Cloud users.

Baker Framework (bakerframework.com) is a somewhat more technical 
solution for building apps with direct support by in5. Baker Framework can 
be used to create both single issue and multi issue apps for iOS.

App content created 
in Adobe InDesign

Content exported 
with in5 to HTML/

CSS/JavaScript

App (with in5-exported 
content) created by 

PhoneGap Build or Baker 
Framework

App submitted to 
App Store

App (with content) 
downloaded to 

user’s device

The workflow for creating a single issue app with InDesign, in5, and PhoneGap Build or Baker Framework.

InDesign + +in5 PhoneGap Build
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Build a multi-issue app with in5 content

If you want to create a multi-issue app with subscriptions or the abil-
ity to distribute different content to different groups of people (useful 
for private sales apps, for example), check out the solution from Paperlit 
(paperlit.com) specifically for in5 users. Content created in 

Adobe InDesign

App created by 
Paperlit service

App downloaded 
from App Store to 

user’s device

App submitted to 
App Store

Content uploaded to the 
Paperlit service

Content downloaded 
on demand into the 

app from the 
Paperlit service

Content exported 
with in5 to HTML/

CSS/JavaScript

The workflow for creating a multi-issue app using the Paperlit service with app content generated by in5. 
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First, determine if your project is a good fit
There are many ways to create apps. You are a good candidate for this 
method if:

 ■ You prefer to author all your content and create all your screens 
in InDesign

 ■ You don’t want to write any code (programming)

 ■ You want to create an app “on the cheap”

 ■ You’re willing to accept a few limitations and roll up your sleeves and 
figure a few things out

 ■ Your app content changes only infrequently. In other words, you aren’t 
publishing a magazine or other periodical.

This method would be good for creating an interactive travel guide, a “how-
to” app, or an interactive annual report, for example.

App or EPUB?

Warning: Apple has a history of rejecting apps that are too “book-like”. Their 
position is that if your app is a book, it should be an EPUB on the iBook 
Store instead of an app on the App Store. 

Apps on Google Play are not curated, so there are no such restrictions for 
Android apps.

Examples

Here are a couple of examples of apps that could be created with 
this method.

 ■ Winslow, AZ app (apple.co/2q1oAFo) Created with InDesign and Twixl, 
but most of the functionality could be done with this method.

 ■ Outdoor Knots app (apple.co/2q162VV) Created with DPS, but most of 
the functionality could be done with this method.
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Step 1: Phone, tablet, or both?
Smartphone app and Web usage is much greater than tablet app 
and Web usage.

For some fascinating statistics about this, see the Comscore 2017 
U.S. Mobile App Report at bit.ly/2IvboiB. A couple of excerpts are 
shown at right.

Apps developed with the method we’re discussing today 
aren’t responsive. They will scale up and down proportion-
ally to fit different size screens, and that’s it. So you’ll need 
to decide at the start which device(s) you are going to sup-
port. In other words, if you want to have a beautiful portrait 
phone version as well as a landscape tablet version, you’ll 
need to create at least two layouts.

© comScore, Inc. Proprietary. 6

The smartphone dominates for 18-24 year-olds, who spend an amazing 
2/3rd of their digital media time on smartphone apps alone

Share of Platform Time Spent by Age
Source: comScore Media Metrix Multi-Platform & Mobile Metrix, U.S., Age 18+, June 2017
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Key Takeaways

• The average user spends 2.3 
hours per day using mobile apps

• Apps dominate mobile web in 
usage time, 87% to 13%

• Half of digital media time spent 
occurs in smartphone apps

• Smartphone users’ #1 app 
drives half of their app time, and 
the Top 10 drive 95%+

• Apps have a shorter long-tail for 
usage compared to the web, 
with less than 30% of app time 
occurring outside the Top 50

1 Mobile Apps are the 
primary driver of digital 
media consumption but 
activity is concentrated

• Many app acquisition methods 
are seeing modest declines over 
the past year

• The majority of app users don’t 
download any apps per month

• Most app users across all age 
segments access 20 or fewer 
apps in a month

• While many fast growing apps 
still exist, fewer apps have 
emerged of late to revolutionize 
the digital landscape

More signs of having 
reached ‘peak app’ are 
emerging as interest in 
new apps begins to wane

2

• Millennials are more likely to 
engage in curation of apps by 
location and accessibility on 
their home screens

• While they love social and 
entertainment apps, they are 
also extremely reliant on more 
functional apps

• They can’t live without their 
apps, but also show signs of 
app fatigue

3 Millennials prove to be the 
most engaged, 
sophisticated and 
addicted users of apps
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Step 1: Prototype and test with Adobe XD
Adobe XD is included with your Creative Cloud 
subscription. It is a very simple way to quickly 
mockup and iterate app screens, create icons and 
navigation elements, and test interaction with 
users. See adobe.ly/2q124fO for more info.

Step 2:  Set up InDesign files for mobile 
screens

Setting the Intent to Mobile in InDesign’s 
New Document dialog box will set the Trans-
parency Blend space to RGB, set the default 
swatches to RGB, and set the measurement 
system to pixels.

I like to create mobile app content at 750 x 
1294 pixels. This 16 x 9 proportion is used by 
most modern smartphones. For iOS phones, 
it fits nicely under the required title bar at 
the top of the screen.

Step 3: Include interactivity, animation, 
and media
in5 supports interactivity created with InDesign’s Buttons and Forms panel, 
Hyperlinks panel, Object States panel, form elements, and the Bookmarks 
panel. In addition, in5 supports animation created with InDesign’s Anima-
tion and Timing panels. And, as a bonus, you can use much of the func-
tionality found in the Overlays panel, which is intended for use with AEM 
Mobile. You can find a full list of which interactive and media features of 
InDesign are supported by in5 at bit.ly/1wBZGY9.

Hyperlinks

in5 fully supports InDesign’s Hyperlink functionality. Hyperlinks can be 
added in InDesign using 2 methods:

1. The Hyperlinks panel. This panel can be used to add hyperlinks to 
either selected text or selected objects.

2. The Buttons & Forms panel. This panel can be used to add hyperlinks 
to objects.

For additional Hyperlink tips, see this Three ways to improve your hyperlinks 
blog post: bit.ly/1k3jWQt.

Pan & zoom

Pan & zoom images created with the Pan & Zoom option in the Overlays 
panel are supported by in5.
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Video

To include video content in your app, you will need to decide if you want to 
a) “stream” the video into the app on-demand, or b) embed the video in the 
app. Its a trade off between file size and reliability.

Streaming video occupies no room in your app content, so it won’t affect 
the download speed of the content.  But it will require the user to have a 
reliable, fast internet connection on their device.

To include streaming video in an app, you can just include a hyperlink to 
a video on a video streaming site such as YouTube or Vimeo, or copy an 
“embed code” from the site.

Embedded video makes the content larger, so it will take the user to down-
load the content into the app. But you can be assured that it will play reli-
ably, every time, online or offline.

If you choose to embed video, you will want to create video files that are 
cropped to a specific pixel dimension, converted to the proper format, and 
compressed to occupy the least amount of space in the app. 

Rule of thumb: Properly compressed video should occupy no more 
than 10mb of space per minute of video.

In5 supports all of the video settings in the Overlays panel, except the Tap 
to View Controller and Do Not Allow Pause options. To add a controller to 
a placed video, select the video, and choose any of the controller options 
in InDesign’s Media panel. Regardless of which one you choose, a single 

full-featured controller will be added to the video. To hide the controller, 
select None for the controller option in the Media panel. For more informa-
tion about working with video in in5, see bit.ly/1qLHGMc.

The options to control video 
playback with in5 are in both 
the Overlays panel and the 
Media panel.
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Audio

In my opinion, audio is under-utilized in apps. High-quality audio can be 
easier to produce than video, and takes up far less space. If your video con-
sists of just a “talking head”, why not consider a still shot of the individual 
with an audio interview instead? Instead of just text in an article, what 
about including the option of the author of the text reading it aloud?

 ■ Audio must be saved in the MP3 file format. 

 ■ If you are a Creative Cloud subscriber, you have access to Adobe Audi-
tion, a full-featured audio editing tool. Audition will also convert audio 
from almost any format to MP3 format.

 ■ To import an MP3 audio file into InDesign, just choose File > Place, and 
select the MP3 file. The audio file will appear as a small frame on the 
page (if you have Frame Edges displayed). 

 ■ Use “auto play” audio sparingly. Keep in mind that the user may be view-
ing your content in a quite environment, without headphones.

 ■ It is a good practice to always indicate to 
the user the length of the audio clip that 
you are asking them to listen to. I use the 
format [00:05:34] (5 minutes, 34 seconds).

InDesign doesn’t provide any interactive audio controller files. There are 
two ways to control audio in in5 output.

1. If you select in5’s Show 
Audio Controls option 
in5 automatically adds a 
400 x 30 pixel interac-
tive audio control to the 
frame containing the 
audio. You may need 
remove any existing 
icons from your audio 
frames and adjust your 
frame sizes to accom-
modate the in5-gener-
ated audio controls.

2. Or, you can use the Buttons & Forms 
panel to create your own custom 
buttons to play, pause, stop, or 
resume audio.
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Animated GIFs and image sequences

Two low-tech but effective ways to include animation in your project are 
animated GIFs and image sequences.

An Image Sequence is a series of JPEG or PNG 
images that are set to appear one after the other, 
creating an animated effect. Adobe Animate and 
After Effects are among the tools that can export 
animation as an image sequence. in5 supports 
all the Image Sequence options in the Overlays 
panel. 

 ■ Bart Van de Wiele has a nice tutorial at bit.ly/S6cGp7 showing how 
to create an animated number sequence using Image Sequences 
in InDesign.

 ■ See adobe.ly/1oijjm5 for a tutorial on how to create a rotating object 
in Photoshop, export the rotation as PNG files, and then use this as an 
image sequence in InDesign.

There are 3 things that you can do with animated GIFs that you can’t do 
with video: they can be set to play a specific number of times, and then 
stop; they don’t display an on-screen controller; and they can have a trans-
parent background.

There is no way to control the playback of an animated GIF with buttons. 
If you have an image sequence that you need to convert to an animated 
GIF, see bit.ly/1WcPdlv for easy step-by-step instruction on how to do this 
in Photoshop.

For more about animated GIFs in in5, see bit.ly/1qLHGMc.

Scrollable frames

Scrollable frames are commonly used in interac-
tive projects to create not only text that scrolls 
within a defined area, but also numerous “sliding 
tab” or “drawer” effects. Scrollable frames created 
for DPS with the DPS Overlays panel are sup-
ported by in5. The Initial Content Position: Upper 
Left option isn’t supported.

The Export Format in PDF Articles option has no 
effect in this panel for in5 output.

The free “Universal Scrolling Frames” plug-in for InDesign from Ajar Produc-
tions (bit.ly/1rIgZsI) provides an alternate way to create scrollable frames 
in InDesign. This method offers the advantage of being able to preview the 
scroll effect using InDesign’s EPUB Interactivity Preview panel.

All of the Image Sequence 
overlay options are 

supported by in5.

Scrollable frames are fully 
supported by in5, with the 
exception of the Upper Left and 
Export Format options.
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Web content

In5 supports Web Content overlays. These are 
frames that either contain local HTML/CSS/Java-
Script content, or iframe HTML content for widgets 
such as maps. Everything in the Overlays: Web 
Content panel is supported except for the Scale 
Content to Fit option.

Multi-state objects and slideshows

A multi-state object (MSO for short) is a single object, kind of like a group, 
that contains multiple “states” within it. The most typical use case of an MSO 
is a slide show that either auto-plays on the screen, or is controlled by the 
user tapping buttons. In either case, each slide in the slide show is a sepa-
rate state in a multi-state object.

Here’s the key: each slide in a slideshow, (or state in an MSO), doesn’t have 
to be an image. A state can consist of text frames, images, Illustrator art-
work, hyperlinks, buttons, scrollable frames, audio, video, or even other 
multi-state objects. This is where it gets really interesting. Particularly when 
the access to individual states is controlled by buttons, the types of interac-
tive effects that can be achieved with MSOs is very broad.

To create an MSO, select one or more objects, and click the “new” button at 
the bottom of the Object States panel. Each object will become a separate 
state in the resulting multi-state object. If you want to include multiple 

objects in a single state, you must group all the 
objects you want on that state before making 
the MSO.

Slideshows constructed with multi-state objects 
and buttons are supported by in5, and almost 
all of the options found in the Overlays: Slide-
show panel are supported. The only exception 
is the Export Format in PDF Articles option has no 
effect, as the raster/vector settings are controlled 
across the entire file in in5 using the choices in the 
Export Content with in5 dialog box.

Web Content overlays are fully 
supported by in5 except for the 
Scale Content to Fit option
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Nine things to know about multi-state objects and buttons in InDesign

Mastering how to create multi-state objects controlled by buttons is the 
key to creating all kinds of rich interaction in InDesign. To that end, here are 
nine things that you need to know about MSOs and buttons:

1. Always keep the Buttons and Forms, Object States, and Layers pan-
els open and visible when creating interactive effects. You will need 
to refer to these panels frequently, so for your own sanity, open them 
up, park them on your screen, and leave them there. Consider making 
a custom InDesign workspace to save your panel arrangement (Win-
dow > Workspace > New Workspace). The Layers panel is used heavily in 
interactive projects for locating, selecting, or moving page items that 
are within groups, object states, or buttons.

2. Always work with Frame Edges displayed. Choose View > Extras > 
Show Frame Edges so that you can easily see clear buttons and the “hid-
den” states of MSOs.

3. Always name your MSOs, states, and buttons. Yes, InDesign will 
ensure that your MSOs, states, and buttons are given unique names, 
so that everything will work as it should. But the more complex your 
interaction gets, the more you will appreciate having an MSO named 
“national parks MSO” and states named “yosemite”, “rocky mountain”, 
and “joshua tree” rather than “Multi-state 23” and “State 1”, “State 2”, and 
“State 3”. The names that you give these MSOs, states, and buttons will 
appear in the Layers panel, making selecting objects through the Lay-
ers panel easy.

4. Double-click to “dive” down into the objects in an MSO, hit the Esc 
key to “climb” back out. With an MSO selected, double click on an 
object to dive into the MSO state that contains that object and select 
the object. Then, hit the Esc key once to select the state, and again to 

select the “parent” MSO. Depending on how objects within the states 
are grouped, you may need to double-click repeatedly to access the 
objects within groups, and then hit the Esc key repeatedly to climb 
back out. This simple technique is a huge time- and effort-saver once 
you master it.

5. There is no such thing as a multi-state object with one state. It 
should be no surprise that a multi-state object must have multiple 
states. If you select a single object, and choose New State from the 
Object States panel menu, a 2-state MSO will be created, with the 
object you selected duplicated in each state.

6. There is no such thing as an empty state in a multi-state object. 
Every state in an MSO must have at least one page item in it. If you 
need a state that consists of “nothing”, you will need to create a frame 
that has no fill and no stroke, and add that to the state. This is a com-
mon technique for creating “pop-up” or “overlay” boxes that appear on 
the screen when a button is tapped.

7. The initial display of an MSO is always its first state. Regardless 
of which state is selected in the Object States panel, when the page 
appears on a mobile device, the first state (the state at the top of the 
Object States panel) is the state that will be initially displayed.

8. Buttons located inside an MSO state can only “see” states within 
the parent MSO. A button that is in an MSO state can’t control a differ-
ent MSO on the page.

9. Buttons that are not part of an MSO can only “see” MSOs on the 
current page. In other words, there is no way for a button on page 2 to 
control an MSO on page 3.
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How to create a slide show with forward and back buttons

Multi-state object (MSO)

State 1

State 2

State 3

Static button artwork

Each “state” can be a 
group of objects

Button with“Go To 
Next State” action 

Button with“Go To 
Previous State” action 
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How to create a slide show with buttons for each slide

Multi-state object (MSO)

State 1

State 2

State 3

Go To “State 2”

Go To “State 3”

Buttons with“Go 
To State” actions 

Go To “State 1”

Each “state” can be a 
group of objects
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How to create a “pop-up” in InDesign

“Pop-up” or “reveal” boxes are a very common interface element that appear 
in digital publications. They are very useful: They can lead a curious reader 
deeper into your content, allow you to display dense content in a small 
amount of space, provide a mechanism for creating simple games and 
quizzes, and much more.

1. Create the close button artwork, and create a 
clear frame the size that you want the button 
to be

2. Align the 2 objects, and group them

3. Create a second group 
that consists of the 
items that you want to 
“pop-up”, close button 
artwork, and a clear 
frame that will become 
the close button

4. Select the 2 groups, and create a new 
multi-state object. Name the group 
that contains the open button artwork 
“hidden” and the other state “visible”

5. Select the Hidden state in the 
Object States panel, and then 
double-click repeatedly until you 
have the clear frame selected. 
Choose Go To Next State from the 
Actions drop-down menu in the 
Buttons and Forms panel

6. Select the Visible state in the Object States panel, and then double-
click repeatedly until you have the clear frame selected. Choose Go 
To Next State from the Actions drop-down menu in the Buttons and 
Forms panel

The advantage of this technique is that each object is “self contained”. The 
close buttons are only visible and active when the visible state is displayed. 
Once you master this valuable technique, you will be able to use it for a 
wide variety of interactive experiences.
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Step 4: Create a folder for the app content
Somewhere on your hard drive or server, create a folder called myapp. 
This folder is going to be used to store all the items necessary for building 
the app.

Step 5: Export InDesign content with in5
When you export your InDesign content with in5 to be used in an app, you 
will need to pay close attention to the settings in the Export HTML5 with in5 
dialog box.

Basic tab

A. Specify the myapp folder you cre-
ated in the step above

B. The Slider (Fade In) page format is 
most typically used for apps

C. You will need to decide if you 
want to allow the user to swipe 
between screens, or if you 
will provide alternate naviga-
tion elements such as buttons 
and menus.

D. You will probably choose Images for the Text Rendering, unless allow-
ing the user to select text in the app is important to you. Images causes 
each screen to output exactly like the InDesign layout.

E. Web is the most common output format if your content is going to be 
bundled into an app.

Advanced tab

A. Choose High Definition 
or High Definition - Text 
Frames Only depending on 
your needs

B. Typically select Let 
in5 Choose

When you’ve finished exporting with in5, your myapp folder should contain 
a file named index.html and a folder named assets.

B
C

D

A

E

myapp

A

B
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Step 6: Determine platforms and distribution methods
iOS apps

On iOS devices mobile apps can only be distributed two 
ways: through the Apple App Store, or privately within a 
single company through “enterprise” distribution. If your 
app and content are free, Apple will host it on the Apple 
App Store free of charge. If you charge for your app or 
your content, Apple will retain 30%.

There is no way to distribute an iOS app to the public outside of the 
Apple App Store.

Enrollment in the Apple Developer program costs $99/year for individuals, 
and $399 for businesses (apple.co/1ZEDAkH).

Android apps

On Android devices, you can either distribute your app 
through Google Play, with a similar financial arrangement 
to the Apple App Store, or by distributing it yourself and 
instructing users how to “sideload” the app directly on 
their mobile device, bypassing Google Play.

There is a one-time $25 enrollment fee to become a Google Play devel-
oper (bit.ly/1Nqo4YW).

Windows apps

Windows 10 apps can be submitted to the Windows Store. This store isn’t 
curated, so no app approval is needed. Like Apple and Google, Microsoft 
will distribute free apps at no charge, and will take a 30% cut if you charge 
for your app. You can also install Windows apps directly on Windows 
devices, bypassing the Windows Store.

There is a one time $19 fee for individuals to enroll in the Windows devel-
oper program. The fee is $99 for businesses (bit.ly/1TzRnF7).
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Step 7: Create an App ID and iOS certificates
To create an iOS app and submit it to the App Store, you will need 
the following:

 ■ An App ID. This is a string that is unique to your app. The easi-
est way to ensure that it is unique is to use your company’s domain 
name in reverse, with the name of your app at the end. For exam-
ple: com.gilbertguide.channelislands-np

 ■ A development provisioning profile. This is a single file with a 
.mobileprovision extension that is tied to your App ID as well as to a spe-
cific set of iOS devices that you specify for testing your app.

 ■ A distribution provisioning profile. This is a single file with a 
.mobileprovision extension that is tied to your App ID and is needed to 
submit your app to the App Store.

 ■ A development iOS certificate. This is a single file with a .p12 extension 
that is needed to create a test version of your app. 

 ■ A production (distribution) iOS certificate. This is a single file with a 
.p12 extension that is needed to submit your app to the App Store. 

I’ll walk you through the process of procuring the IDs, provisioning profiles, 
and certificates on the following pages.

Alternatively, you can hire someone to do the app signing and submission 
process for you. If they use their developer account and certificates, the 
app will show that it is “published by” them, and any funds from sales of the 

app will go into their account. If you provide them access to your devel-
oper account, they could build the certificates and submit the app on your 
behalf. 

Generate iOS certificates

1. Download and install Xcode (apple.co/2ItpReV). Xcode is a program-
mer’s tool for creating iOS and Mac apps. Don’t worry, we’re going to 
only use it for one tiny thing. But, be warned, it is a huge (almost 5gb!) 
download, so it may take awhile.

2. Run Xcode.

3. Choose Xcode > Preferences.
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4. Click the Accounts icon at the top

5. Choose your name

6. Choose Manage Certificates

7. Click the plus sign, and choose iOS Development from the drop-down list.

8. Click the plus sign again, and choose iOS Distribution from the drop-down list.

4

5

6
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9. Right-click the text under the iOS Development Certificates heading, and choose  
Export Certificate.

10. Type a name for the certificate p12 file (include “DEVELOPMENT” in the 
name so you can identify it easily later). Choose a location for the file, 
type a Password at the bottom, and click Save.

11. Right-click the text under the iOS Distribution Certificates heading, and 
choose Export Certificate.

12. Type a name for the certificate p12 file (include “DISTRIBUTION” in the 
name so you can identify it easily later). Choose a location for the file, 
and type a Password at the bottom.

13.  Quit Xcode.
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Register iOS test devices

Each iOS that you want to test your app on before you submit the app to the app store must be regis-
tered through the Apple Developer site.

1. Go to the Apple Developer Web site at apple.co/2Ixjg3a and sign in with your Apple ID.

2. Choose All under the Devices heading on the left side. 

3. Click the plus icon in the upper-right corner.

4. Type a name for your device, something like “Keith’s iPhone 6” to help you 
identify it later.

5. Type or paste in the UDID for your device. To obtain the UDID, visit 
get.udid.io/ on your device and follow the on-screen instructions.

6. Click Continue. Repeat steps 3-6 for each device you wish to use to test 
your app.
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Create an App ID

1. Under the Identifiers heading on the left, choose App IDs.

2. Click the plus icon in the upper-right.

3. Type a description, such as the name of your app.

4. Leave the App ID Prefix as-is.

5. For the App ID Suffix, choose Explicit App ID, and enter a “Bundle 
ID” for your app. This is a string that is unique to your app. The easi-
est way to ensure that it is unique is to use your company’s domain 
name in reverse, with the name of your app at the end. For exam-
ple: com.gilbertguide.channelislands-np.
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6. Click Continue.

Generate Provisioning Profiles

1. Under the Provisioning Profiles heading on the left, choose Development.

2. Click the plus icon in the upper-right.

3. Choose iOS App Development, and then click Continue.

4. Select the App ID you just created in the previous steps from the App ID 
drop-down list, and then click Continue.
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5. Select the iOS Development certificate you created earlier, and then click  
Continue.

6. Select all the devices on which you want to be able to test the app, then 
click Continue.

7. Give the profile a name, (include “DEVELOPMENT” in the name so you can identify it eas-
ily later) and click Continue.
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8. Click the Download button. The provisioning profile will be downloaded to your  
browser’s download location.

9. Click the Add another button at the bottom of the screen.

10. Select App Store under the Distribution heading, then click Continue.

11. Select the App ID you created in the previous steps from the App ID drop-
down list, and then click Continue.
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12. Select the iOS Distribution certificate you created earlier, and then  
click Continue.

13. Give the profile a name, (include “DISTRIBUTION” in the name so you can identify it easily 
later) and click Continue.

14. Click the Download button. The provisioning profile will be downloaded to your  
browser’s download location.
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Step 8: Create an Android certificate
Creating and submitting an Android app is much easier than creating the 
iOS certificates. Only a single certificate is required.

Macintosh

1. Download and install Java on your computer (bit.ly/2pXloup)

2. Run the Terminal app (in your Applications folder)

3. At the prompt, type…  
 
keytool -genkey -v -keystore keith_gilbert.key-
store -alias keith_gilbert -keyalg RSA -keysize 
2048 -validity 10000 
 
(replacing “keith_gilbert” with 
your name) 
 
… and then press return.

4. Type an answer to each 
prompt, pressing return after 
each answer.

5. When you are finished, the 
 .keystore file will be saved in 
your home folder.
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Step 9:  Upload your certificates to 
PhoneGap Build

1. Go to build.phonegap.com and sign in with your Adobe ID

2. In the upper-right corner, 
choose Edit account

3. Click on Signing Keys, and 
then the add a key button 
under the iOS category

4. Enter the name of your app+ “development” for the 
title, and then choose your development p12 cer-
tificate and your development provisioning profile.

5. Repeat the process for your iOS distribution 
certificates.

6. Repeat the process for your 
Android certificate.

Step 10: Download the config.xml file
1. Download the config.xml file from my file server at bit.ly/2GvD84G.

2. Place this config.xml file in the myapp folder.
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Step 11: Generate icons and splash screens
Many different sizes of your app icon and splash screens are required by 
PhoneGap to build your iOS, Android, or Windows app. The PhoneGap File 
Generator is an easy way to create these.

1. Use Illustrator or Photoshop to create an icon for your app that is 
2000 x 2000 pixels, and save it as a .png file. 

2. Go to the PhoneGap Icon and Splash Screen Generator at 
phonegap.appiq.software and click the Download Example PSD file 
button

3. Open the downloaded example 
file in Photoshop, and use the file 
to create a splash screen for your 
app. This single square will be used 
to create a variety of rectangu-
lar splash screens, so any critical 
artwork should be placed in the 
center “safe zone” quadrant.

4. Save the splash screen as a 
.png file.

5. Choose your logo PNG file you created in step 1, and the splash screen 
PNG file you created in step 4, and then click the Upload files button.

6. When your files are ready, click the Download your files button.

7. A folder with a cryptic name such as  
fd1eb7cf-e41c-4786-b4a3-3635f0b76498 
will be downloaded. Inside this folder, 
you’ll see a folder named res that 
contains all your icons and splash 
screens. Copy this folder into your 
myapp folder.
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Step 12: Edit the config.xml file
1. Open the config.xml file in a text editor. 

2. Edit line 2 so that the id= contains your app id. You app id should be 
something like your company’s domain name in reverse, with the name 
of your app at the end. Remember what you entered here. It will be 
needed later.

3. Edit line 4 to contain the name of your app

4. Edit line 5 to contain a description of your app

5. Edit line 6 to contain your contact info

6. Note that the end of the config.xml file contains references to all of the 
app icons and splash screens created by the PhoneGap File Generator. 
If Apple or Android ever require additional sizes of these assets and 
the PhoneGap File Generator changes, you will need to copy and paste 

the config.xml code created by the PhoneGap File Generator into your 
config.xml file.

7. Save the file as a text-only file with an .xml filename extension in the 
myapp folder.
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Step 13: Compress the myapp folder
Zip compress the myapp folder. On a Mac, you can do this by right-clicking 
on the myapp folder and choosing Compress “myapp”.

Step 14:  Upload myapp.zip to PhoneGap 
Build

1. Go to build.phonegap.com and sign in with your Adobe ID

2. Click the New App button

3. Click the Upload a .zip file button

4. Select your myapp.zip file

5. Wait while the file uploads to the PhoneGap Build server

If all goes accord-
ing to plan, your 
app should appear, 
complete with 
your app icon, 
name, and descrip-
tion, and a Ready 
to Build button.

Step 15: Build the development app
1. Click the Ready to Build button

2. Click on the 
name of 
your app

3. Next, choose 
your iOS 
development 
certificate 
and Android 
certificate 
from the appropriate drop-down menus. You will also likely need to 
click on the padlock icon to enter your certificate password to unlock 
the certificate.

4. Click the Rebuild all button.

30 of 31

https://build.phonegap.com


Make a Mobile App with InDesign
Keith Gilbert

Step 16: Test the development app
Once there are no errors displayed, you are ready to install the app on your 
device and test it. Either point a QR reader at the QR code on the screen, or 
copy the link from the Install button and distribute this link to your testers.

Step 17:  Build the production (distribution) 
app

1. Once you’ve thoroughly tested the 
app on all your devices, choose 
your iOS production (distribution) 
certificate, and rebuild the iOS app.

2. Click the .ipa button to download a 
.ipa file to submit to the Apple App Store.

3. Click the .apk button to download a .apk file to submit to Google Play.

Step 18: Submit the app to app stores
The process of submitting an app to the Apple App Store and Google Play 
changes occasionally, since it is a Web-based process. Typically, you sign 
into a Web portal for the intended store, and then upload an app descrip-
tion, example screen shots, support information, and other details, and 
then upload the signed app files.

 ■ To start your Apple App Store app submission, sign in to Apple’s iTunes 
Connect site at apple.co/1ZEMoah

 ■ To start your Google Play app submission, visit the Google Play Devel-
oper Console at bit.ly/2q737ci

Additional resources
 ■ A Lynda.com “playlist” I created that lists a handful of great 

courses for learning how to create interactive app content in 
InDesign. bit.ly/1X43Be6

Keith Gilbert is a consultant, educator, speaker, and author based in St. 
Paul, MN. He helps solve design and production problems by writing custom 
InDesign scripts, provides on-site and remote training, and is an author of 
several popular Lynda.com/LinkedIn Learning courses.  GilbertConsulting.com
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Aimed at professional and serious amateur 
photographers, Photoshop Lightroom is a modular 
approach to managing, processing, and outputting 
your photographs. 

Following are my suggested settings for a fast, 
efficient download and basic prepping of images, 
before exporting copies to be placed in an InDesign 
document. 

Behind the scenes, Lightroom uses the same 
technology as the Camera RAW plug-in, so if you 
prefer to edit your images there, the steps are similar, 
with Adobe Bridge providing the image management 
features.

GET TO KNOW LIGHTROOM
Working with RAW files
The Camera RAW file format is the ultimate in non-destructive editing 
because you cannot overwrite your original “digital negative.” Instead you 
can “develop” an infinite number of interpretations of that negative with 
the changes being saved in invisible (sidecar) .xmp files, which are tiny in 
file size.

Using Shortcuts
Lightroom is fast and streamlined. To get the most from Lightroom, use 
single-key shortcuts to access the tools—see shortcut list.

Importing images
My preferred import settings. 
1:1 previews are best, but if you’re 
pushed for time, Standard are 
adequate.  
Applying a Develop Preset, 
copyright information, and basic 
keywords at the time of import 
saves time. 

Importing into single folder, 
avoids the confusion of having 
multiple folders by date.

EVALUATING IMAGES
Grid View (g) and Loupe View (l)

You’re constantly moving back and 
forth between grid and loupe view, 
so it’s good to know the shortcuts: 
g and l.

2 of 8 Photo Walk Lightroom Workflow nigel@nigelfrench.com



Rating images

An important first step is to quickly 
evaluate your images: reject the 
bad ones (x), rate the keepers (1-5), 
and stack any that are part of a 
sequence (s)

Keywording
Keywording can sometimes feel like a chore, especially when 
you’re in a hurry, but it is essential. As your catalog grows, 
you’ll be glad of those keywords when you need to find an 
image. The painter tool allows you to “spray” keywords on 
your images, saving much time.

Collections
Collections allow you to associate images together without needing to 
drag duplicates into multiple folders. There are 3 types of collection:

• Quick: A sort of temporary holding area. Press “b” to add/remove an 
image to the Quick Collection. There is only one quick collection and 
you cannot rename it.

• Collection: You can name collections. For a further level of hierarchy, 

collections can live inside Collection Sets. Drag the image(s) onto the 
Collection icon.

• Smart Collection: You decide the criteria for “membership”—a 
particular keyword, for example—all images that meet that criteria 
automatically become part of the Smart Collection.

Stacks

A stack is a sequence of images 
(often shot as a burst) that you 
group together (Cmd/Ctrl+G) to 
conserve space in your grid view. To 
toggle the stack, press “s”.

Collapsed Expanded

Filtering and finding images

Having evaluated your images, you can filter your view to see only those 
images with a certain rating and prioritise your image editing

3 of 8 Photo Walk Lightroom Workflow nigel@nigelfrench.com



THE DEVELOP MODULE: BASIC ADJUSTMENTS 
Cropping and Straightening 

It’s largely a matter of personal choice, but I prefer to crop my images to 
one of three aspect ratios: 2x3 (the aspect ratio of my camera), 16:9 for a 
more cinematic look, and 1 x 1 for images that work best squared. Using 
the same crop ratios helps establish a consistent look.
You can also make custom aspect ratios for things like Facebook cover 
pages.
The crop overlay makes it easy to crop your image using the rule of thirds 
or other composition principles. Press “o” to cycle through the overlays.

Choosing a Profile
Profiles are broadly synonymous 
with film types and are the 
starting point for creating the 
look you’re after.

Understanding the Histogram
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Lightroom’s histogram is more powerful than its Photoshop equivalent, 
because you can scrub over it to edit the image. The tonal zones 
correspond to the Tone sliders.

Correcting white balance
Most of the time, “As Shot” gives 
a good result. For a custom white 
balance, choose the White Balance 
tool (w) and target an area of 
(intended) neutral grays in the image.
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Using the Tone controls 
For fast editing, hover over the 
slider and press the Up or Down 
arrows. If you’re in a hurry, Auto 
will (usually) give a good result. 

Presence (Vibrance, Dehaze, Clarity) 
I like to start out with a vibrance boost of +20 to most of my images. This 
saturates the more muted colors; in practice this tends to mean slightly 
bluer skies. (Note, I live in England, where the skies are more often gray 
than blue.)

Add punch and midtone 
sharpening with Dehaze and 
Clarity

Lens Corrections
Choose the profile for your lens to 
correct for known abberations.

Sharpening and Noise reduction
View the image at 1:1 to evaluate 
the sharpening. Note, in Photoshop, 
sharpening is on a scale of 0-500; in 
Lightroom it’s 0-150. 
Luminance noise reduction is great 
for smoothing noise in skies. Higher 
amounts may be necessary if you’ve used 
a high ISO
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SPEEDING THINGS UP
Creating and applying presets

Many of your images will require the same or similar adjustments. You 
can save time by creating Presets. 
Some may be “macro” with most boxes checked; others can be “micro” 
with just one or two boxes checked. 
Presets are cumulative and settings that are not included are unaffected 
by the application of the preset.
Presets can be applied to batches of images in the Library Module, Quick 
Develop area.
For a quick ’n’ dirty approach, you can also copy and paste settings from 
one image to another.

GETTING MORE SPECIFIC
Spot Removal

The Spot Removal tool does an 
adequate job of removing dust 
spots and small blemishes. For 
more detailed retouching, edit the 
image in Photoshop (Cmd/Ctrl+E).

Upright corrections
The Upright corrections are great 
for fixing keystoning distortions 
on buildings

Vignetting
Darkening the edges of the frame, 
used sparingly, can give an image 
increased presence, and draw the 
viewer’s attention to the center of 
the frame.
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THE DEVELOP MODULE: LOCALISED ADJUSTMENTS
The Graduated Filter tool (m), 

Radial Filter (Shift-m), 

Adjustment Brush (k)
The graduated filter and radial 
filter tools allow you to apply 
exposure adjustments to 
specific parts of an image. The 
Adjustment Brush allows you to 
paint in exposure adjustments—
it’s shortcoming is that it is very 
memory intensive and you may 
experience a lag. Occasionally, 
extensive local adjustments 
may need to be completed in 
Photoshop (Cmd/Ctrl+E)

EXPERIMENTING WITH DIFFERENT TREATMENTS
Making virtual copies

Converting to black and white (v)

Exploring predefined presets
There’s no penalty for 
experimentation: Right-click an 
image(s) to create a Virtual Copy and 
try out alternative looks. For black 
and white, press “V”; it’s also worth 
exploring Lightroom’s predefined 
Presets
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EXPORTING IMAGES

My preferred settings for exporting images for 
placement in InDesign: Full size, optimum quality 
jpegs with the AdobeRGB (1998) Color Space

ESSENTIAL LIGHTROOM SHORTCUTS
Show/hide Module Picker F5
Show/hide Filmstrip F6
Show/hide left panels F7
Show/hide right panels F8

Loupe view e
Grid view g
Compare view c
Survey view n
Cycle screen modes f
Cycle info overlay i
Toggle Zoom view z
Group into stack Cmd/Ctrl+G
Toggle stack s
Reject x
Set star rating 1-5
Remove star rating 0
Add to Quick Collection B

Open Develop module d
Show clipping j
Convert to grayscale v
White Balance tool w
Crop tool r
Cycle crop overlay o
Constrain aspect ratio a

Spot Removal tool q
Adjustment Brush tool k
Graduated Filter tool m
Radial Filter tool Shift-m
Before and After y
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Output Options
Once you’ve gathered your images, it’s time to decide what you want to do with them. If you want to create a layout,  
you have some good options that we’ll explore in this session.

• Fixed-Layout EPUB

• Publish Online

• Blurb

Fixed-Layout EPUB
Fixed-layout EPUB is an ebook format that you can export from InDesign and retain the entire look of your  
document, including all the colors, fonts, and images, similar to a PDF. Fixed-layout EPUBs are typically used 
for publications where it’s crucial to maintain control over the layout (textbooks, cookbooks, children’s books, 
graphic novels, etc). Unlike a reflowable EPUB, the reader cannot change the fonts, type size, or color. But text 

remains live text. So the reader can select it, and copy it, search it, etc. The process of making fixed-layout EPUBs with 
 InDesign CC, is just about as easy as exporting a PDF.

New Orleans: Walk, Shoot, and Publish
Mike Rankin
www.indesignsecrets.com
mike@cpn.co
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Design Flexibility
Fixed-layout EPUB also gives you the ability to use many design elements 
that are not possible in a reflowable EPUB, like images that bleed off the 
edge of the page and text positioned on top of images.

Navigation
Fixed layout EPUBs can have both on-page TOCs and navigational TOCs to 
allow readers to jump to various parts of a book.

Interactivity
Fixed-layout EPUB supports interactivity in the form of hyperlinks, anima-
tions, and slideshows created with InDesign.

Disadvantages
The main downsides are the fact that fixed-layout EPUBs are not responsive, 
so they may be difficult to read on a small screen (like a PDF), and they lack 
of full support from Amazon and mobile devices outside of the iPad.

Reader Software
To read fixed-layout EPUBs, you can use iBooks, Readium, Adobe Digital 
Editions, Microsoft Edge, Bluefire Reader, and others.

Publish Online
Adobe’s Publish Online service is a simple way to publish 
interactive documents from InDesign to the internet. Pub-
lish Online documents preserve your InDesign layouts like a 

PDF or fixed-layout EPUB, while also offering strong support for interactive 

features, as well as several ways to manage and share published documents. 
If you are a Creative Cloud subscriber, you can publish an unlimited number 
of documents with Publish Online at no additional cost.

Creating Publish Online Documents
You create Publish online documents from InDesign by:

• Clicking the Publish Online button in the Application Bar

• Choosing File > Publish Online

• Selecting the option to Try Publish Online in Print or Export dialog boxes.

A small dialog box opens with a few options to set in two tabs.
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Privacy and Security Issues
When you click the Publish button, your InDesign layout is exported and 
uploaded to Adobe’s servers. All Publish Online documents are hosted by 
Adobe. You cannot host them on your own website. This limitation simpli-
fies the process, but it’s a dealbreaker for many folks who don’t want their 
content on Adobe’s servers.

You can however, embed a Publish Online document on your own web-
site, in addition to it being hosted by Adobe, with HTML code generated dur-
ing the publishing process.

Also, you cannot restrict access to Publish Online documents with a 
password.

Sharing
When you create a Publish Online document, you get a unique URL that 
you can share with other people to give them access to the document (on 
Adobe’s servers). And when you update existing Publish Online documents, 
the original URL will still work.

Publish Online documents can be shared through social media like Face-
book and Twitter. There is no option to sell your Publish Online documents.

There is an option to allow readers to download a PDF version of your 
Publish Online document. Just be aware that the downloadable PDF does 
not support much interactivity because it is made with a Print PDF preset.
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Interactivity: What Works and What Doesn’t
The most compelling thing about Publish Online (besides the simplicity and 
zero added cost) is its strong support for the interactive features you can 
build in InDesign. Things that don’t work in interactive PDF, like animation 
and slideshows built with multi-state objects, work fine in Publish Online. As 
do cross-references, hyperlinks, and buttons.

Things that don’t work in Publish Online include PDF-only features like 
forms. There’s also no support for bookmarks. 

But Publish Online has its own unique navigation features, like clickable 
page thumbnails, which offer more visual (but less precise) navigation than 
bookmarks.

Managing Publish Online Documents
You can manage your Publish Online documents via a web dashboard 
that’s available you’re logged in at Adobe.com. You can access the  
dashboard directly from InDesign by choosing File > Publish Online 
Dashboard. This dashboard allows you to view any of your Publish Online 
documents, set sharing and embedding options, and delete documents. It 
also includes analytics that show statistics like the number of people who 
have viewed your document, the devices they’re using, total number of 
views, etc.

Mobile Issues
When it comes to viewing Publish Online documents on mobile devices, 
the good news is that the interactivity works, and you can navigate with the 
usual gestures of swiping and tapping. The bad news is that Publish Online 
documents are not responsive. The layout is fixed, so it will not adjust to 
accommodate a smaller screen.
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Blurb
Blurb is a self-publishing and marketing platform you can 
use to design, publish, promote, and sell professional-quality 
printed books and ebooks.

Blurb has agreed to provide attendees of the New Orleans Photo 
Walk with a discount code that will be shared during the session.

Selling Books
If you want to sell your book, Blurb can help you get your book in online 
bookstores like Apple’s iBookstore and Amazon. You can also sell directly 
through Blurb. And they offer a service to help you set up a Kickstarter 
page to pre-sell your books.

Blurb Bookwright
Blurb Bookwright is a desktop app for Mac and Windows that 
allows you to create layouts and upload them to Blurb for the 
purpose of creating print or ebooks. Print, ebook, & PDF can  

    all be output from the same project file.
The app offers many pre-designed layout templates, similar to inDesign 

master pages that you can use. And it has many familiar tools and features 
that InDesign users will instantly understand. For a free offering, it is a sur-
prisingly capable page-layout program. The biggest feature that it lacks is 
the ability to use paragraph and character styles.
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When you use Bookwright to make a book with Blurb, you also get a free 
ISBN.

If you have web content that you want 
to use in your project, you can make use of 
the Blog to Book feature. You just choose a 
layout, and enter the URL of your webpage, 
and the service flows the pictures and text 
into your layout. 

It even includes preflighting features to warn you about things like overflow 
text and inadequate image resolution.

Blurb Book Creator
Blurb Book Creator is an InDesign plug-in for InDesign CS3–CC 2018 Mac & 
Windows. With it, you can make a print book, an ebook, & PDF output from 
the same project file

Once the plug-in is installed, you can begin the process of creating a book 
by choosing File > Blurb Book Creator. This opens a dialog box where you 
choose the settings for your book, including page size, paper type, cover 
style, number of pages, and other options.

6 of 8

http://www.blurb.com/blog-book
http://www.blurb.com/indesign-plugin


New Orleans: Walk, Shoot, and Publish
Mike Rankin

The InDesign template that is created contains two layers: one with 
detailed instructions and guides showing the trim, bleed, and safe areas, 
and another layer for you to design your pages by adding text and images. 
The design of the book is entirely up to you.

After you’ve finished designing the interior of the book—and know the final 
number of pages—you’re ready to create a cover template.

The spine width of the cover will be automatically calculated from the num-
ber of book pages, and you can design the cover as you would the interior 
of your book.

When both the cover and interior are done, go back to the Blurb Book  
Creator dialog box, and choose Upload Book. The files will be preflighted, 
and if no errors are found, PDFs will be created locally for you to review. 
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The PDFs are created with a special Blurb PDF preset that is loaded into 
InDesign when you install the plug-in, so you don’t have to worry about 
which settings to use.

When you’re satisfied, the PDFs will be uploaded to Blurb where you can 
place your order.

Mobile Apps for Editing Photos

Halide
• Adds RAW support for iPhone 6S+

• $6

• https://halide.cam

RAW Power
• RAW editing

• Free ($5 upgrade)

• https://gentlemencoders.com

Focos
• Greater depth of field control for dual camera iPhones

• Free (upgrades from $1–$10)

• http://focos.me

Snapseed
• Complete image-editing features

• Free

• By Google

VSCO
• Presets galore

• Save and reapply settings

• Free, with in-app purchases

• http://vsco.co

Lightroom CC for Mobile
• Includes nearly all of the basic organizing and editing features found in 

Lightroom

• Free (CC subscription needed to sync)
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